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Preface

Audience and Use

The User Moves, Adds, and Changes Guide for Cisco Unity Connection contains information and
instructions for setting up Cisco Unity Connection user accounts. It discusses settings relevant to the
behavior of both end user and administrator accounts, and includes procedures for creating, modifying,
and deleting accounts.

Documentation Conventions

Note

Table 1 Conventions in the User Moves, Adds, and Changes Guide for Cisco Unity
Connection

Convention Description

boldfaced text Boldfaced text is used for:

e Key and button names. (Example: Click OK.)

e Information that you enter. (Example: Enter Administrator
in the User Name box.)

<> Angle brackets are used around parameters for which you supply
a value. (Example: In your browser, go to https://<Cisco Unity

(angle brackets) N N
Connection server IP address>/cuadmin.)

- Hyphens separate keys that must be pressed simultaneously.
(hyphen) (Example: Press Ctrl-Alt-Delete.)

> A right angle bracket is used to separate selections that you make
in the navigation bar of Cisco Unity Connection Administration.
(Example: In Cisco Unity Connection Administration, expand
Contacts > System Contacts.)

(right angle bracket)

The User Moves, Adds, and Changes Guide for Cisco Unity Connection also uses the following
conventions:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

[ oL-17018-01
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e

ﬁ Means the following information may help you solve a problem.

A

Caution = Means reader be careful. In this situation, you might do something that could result in equipment damage
or loss of data.

Cisco Unity Connection Documentation

For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection. The document is shipped with Connection, and is
available at http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/roadmap/7xcucdg.html.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors
and users are responsible for compliance with U.S. and local country laws. By using this product you
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local
laws, return this product immediately.

Further information regarding U.S. export regulations can be found at
http://www.access.gpo.gov/bis/ear/ear_data.html.
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CHAPTER

Introduction to Cisco Unity Connection Users and
Contacts

See the following sections:
e Understanding User Accounts, page 1-1

e Understanding Contacts, page 1-2

Understanding User Accounts

In Cisco Unity Connection there are two types of users:

Users With Voice Mailboxes For users who need to send and receive voice messages, and who may
be able to use other Connection features such as personal call transfer
rules and the Cisco Unity Inbox, depending on the class of service to
which they are assigned.

A user account that is set up with a voice mailbox has a phone extension
and is counted as a voice mail licensed user.

Users Without Voice Mailboxes |For users who do not need to send or receive voice messages, but need
to administer the system. You determine which tasks administrators can
do by assigning their accounts to any of the predefined roles.

An account that is set up without a voice mailbox does not have a phone
extension and is not counted as a voice mail licensed user.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x
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I Understanding Contacts

Cisco Unity Connection Default User Accounts

Cisco Unity Connection creates the following four default user accounts, which you use when setting up
the system. These accounts are not included in your user license count.

Administrator The Administrator user account has the highest level of administrative privileges
(System Administrator role) and is used to access Cisco Unity Connection
Administration. The alias and password for this account are specified during
installation. This account is configured as a user without a voice mailbox.

A

Caution  The default Administrator account can be deleted. However, be sure that
you have assigned the System Administrator role to at least one other user
before you delete this account.

Operator The Operator user account is the message recipient for the Operator call handler.
When calls to the operator go unanswered, callers can leave a message, depending
on the call transfer settings for the Operator call handler. We recommend that you
assign someone to monitor the mailbox for the Operator user account, or
reconfigure the Operator call handler to send messages to a different user or to a
distribution list.

This account cannot be deleted.

Undeliverable By default, the Undeliverable Messages Mailbox user account is the only member
Messages Mailbox |of the Undeliverable Messages distribution list, which receives notification of
undeliverable messages. We recommend that you assign someone to monitor this
mailbox, or add a user to the Undeliverable Messages distribution list, to monitor
and reroute (as appropriate) any messages that are delivered to the list.

This account cannot be deleted.

Unity Connection | The Unity Connection Messaging System user account is configured as a user
Messaging System | without a voice mailbox. It acts as a surrogate sender for messages from outside
callers. Thus, messages from outside callers are identified as coming from the Unity
Connection Messaging System mailbox.

This account cannot be deleted.

Understanding Contacts

In Cisco Unity Connection there are two types of contacts:

System Contacts A system contact does not have access to any Connection features such as voice
messaging. A system contact may represent a person in your company who has
a voice mail account on another system. A system contact might also represent
a customer or vendor who does not need a voice mailbox, but who frequently
communicates with Connection users.

Personal Contacts Personal contacts are similar to system contacts, but are created by individual
users and are only accessible by the user who created them.
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Understanding Contacts

How Contacts Are Used

If you have staff, vendors, or partners who do not have mailboxes on the system, but need to
communicate with users, we recommend that you create system contacts for them. System contacts are
available to all users, unlike personal contacts that would need to be set up individually for each user. In
addition, users are able to add the system contacts to their personal call routing rules and caller groups,
and can use voice commands to call the system contacts. Also, if the contact information changes, you
update it in only one place. Note the following details:

e VPIM Messaging—System contacts can be configured for VPIM messaging. These system contacts
represent users on other VPIM-compatible voice messaging systems. When system contacts have
been set up to represent the VPIM users, Connection users can send and receive messages to and
from the VPIM users on the other voice messaging systems.

¢ Directory Access—When you create system contacts in Cisco Unity Connection Administration
and enable them to be listed in the directory, they can then be accessed by users from the Connection
directory. This allows callers to transfer to the extension of the system contact.

e Name Dialing Access—Users have the ability to quickly and easily place phone calls to system
contacts when using the user speech recognition conversation—as long as the contact has transfers
enabled.

e Personal Call Transfer Rules—Users can add other users, system contacts, and personal contacts
to their personal call transfer rules and caller groups.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x
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CHAPTER

Preparing to Add User Accounts

Revised May 2009

Before you add user accounts individually or in bulk, you need to select and define a template and class
of service (COS) for each type of account that you plan to add. Templates and classes of service contain
settings that determine which features are available to Cisco Unity Connection users and their callers,
and define limits and permissions for using Connection. It is also important to consider system partitions
and search spaces, schedules, and mailbox stores before adding user accounts.

For administrator accounts, you need to select and define only a template. Administrator accounts are
not assigned to a COS, schedule, partition, or search space. Instead, to determine which tasks
administrators can do, you need to select the roles that are assigned to each account.

The following sections provide further information on templates, classes of service, partitions and search
spaces, mailbox stores, schedules, and roles:

e Templates, page 2-1

e C(lass of Service, page 2-2

e Partitions and Search Spaces, page 2-2
e Mailbox Stores, page 2-3

e Schedules, page 2-3

e Roles, page 2-4

Each user and administrator account that you add in Cisco Unity Connection is based on a user template.
Settings from the template are applied to the accounts as the accounts are created. Connection includes
predefined templates, which you can modify. You can also create new templates.

Before you create the accounts, review the settings in the templates that you plan to use and determine
whether you need to make changes or create new templates. For each template, consider which features
you want to enable, specify a class of service, and set a schedule and time zone for the accounts that you
create. When creating accounts on a standalone system, you also need to select the authentication rule
that dictates the password and account lockout policy for the accounts that you create. (Changes to
template settings do not affect existing user accounts.)

To minimize the number of modifications that you need to make to individual accounts later, use a
separate template to specify settings that are applicable for each group of users that you plan to create.
For example, if you plan to create accounts for the members of a sales department, create or modify an

[ oL-17018-01

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



Chapter2 Preparing to Add User Accounts

Class of Service

existing template to set up message notifications, specify that messages left for the sales employees will
be encrypted for extra security, increase the length of messages that callers can leave, and make similar
appropriate changes to settings that control the Connection conversation that the sales employees hear.

If a particular setting must be unique for each user account, leave that setting blank on the user template,
and then you can modify the setting for each account after the accounts are created.

For instructions on creating or modifying user templates, see the “Adding, Modifying, or Deleting a User
Template” chapter. Review the “Setting Up Features and Functionality That Are Controlled by User
Account Settings” chapter to learn about the settings that affect how users interact with Connection.

Class of Service

Before you add user accounts, review the class of service (COS) specified for the template that you plan
to use to determine whether you need to modify it, specify a different COS, or create a new one. Because
a COS defines limits and permissions for using Cisco Unity Connection, its settings should be
appropriate for the group of users that you are adding. For example, a COS:

¢ Controls access to features, such as Text to Speech email or live reply.

e Controls how users interact with Connection. For example, a COS dictates the maximum length of
user messages and greetings, whether users can choose to be listed in directory assistance, and
whether users can send messages to a system distribution list.

e Specifies the restriction table used to control the phone numbers that users can use for message
notification, call transfer, and other tasks.

Keep in mind that if you change the COS that is specified on a user template page, any user accounts
that have already been created based on that template are not reassigned to the new COS. In contrast,
when you modify the settings in a COS, the changes affect both new and existing members, so you can
update COS settings before and after you create user accounts. You can also reassign a user to a different
COS at any time.

For instructions on creating or modifying classes of service, see the “Adding, Modifying, or Deleting a
Class of Service” chapter. You can learn about the settings that make up each COS by reviewing the
“Setting Up Features and Functionality That Are Controlled by Class of Service” chapter.

Partitions and Search Spaces

Added May 2009

In Cisco Unity Connection, you create partitions as a way to group objects to which callers and users
can address messages or place calls while interacting with Connection. Each user is a member of one or
more partitions (for example, a user can have a primary extension in one partition and an alternate
extension in a different partition). Extensions must be unique within a partition, but the names of objects
do not have to be unique within a partition.

Search spaces are used to define the search scope of objects (users, distribution lists, and so on) that a
user or outside caller can reach while interacting with Connection. For example, the search scope that is
applied to a user identifies which users, distribution lists, or VPIM contacts the user can address
messages to. It also identifies which users and system contacts the user can dial by name when using the
voice-recognition conversation.
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Mailbox Stores W

A search space is comprised of one or more ordered partitions. When Connection searches for an object
on behalf of a caller, it searches the partitions in the order in which they are arranged in the search space.
While extensions must be unique within a partition, they do not need to be unique within a search space,
so you can use search spaces to handle dial plans that have overlapping extensions.

Before you add user accounts, review the partition and search scope that are specified in the user
template that you plan to use. You may need to modify the template or create a new one.

Keep in mind that if you change the partition or search space that is specified on a user template page,
any already-created user accounts that were based on that template are not reassigned to the new partition
or search space. In contrast, when you modify the partition membership of a search space, the changes
affect both new and existing users of that search space. This means that you can update search space
settings before and after you create user accounts. You can also reassign a user to a different partition or
search space at any time.

For instructions on creating or modifying partitions and search spaces, see the “Managing Partitions and
Search Spaces” chapter of the System Administration Guide for Cisco Unity Connection.

Mailbox Stores

Schedules

Added May 2009
Cisco Unity Connection allows you to create multiple mailbox stores, which can be useful for customers
with large installations, where the time required to complete a backup is an issue.

Before you add user accounts, review the mailbox store that is specified in the user template that you
plan to use. You may need to modify the template to specify a different mail store, or create a new
template.

Keep in mind that if you change the mailbox store that is specified on a user template page, any
already-created user accounts that were based on that template are not reassigned to the new mailbox
store. However, you can reassign a user to a different mailbox store at any time.

For instructions on creating or modifying mailbox stores, see the “Managing Mailbox Stores” chapter of
the System Administration Guide for Cisco Unity Connection.

Added May 2009
Cisco Unity Connection uses schedules to help determine which user transfer rule to apply and which
user greeting to play.

Before you add user accounts, review the active schedule that is specified for the template that you plan
to use. You may need to modify the template to specify a different schedule, or create a new template.

Keep in mind that if you change the active schedule that is specified on a user template page, any
already-created user accounts that were based on that template are not reassigned to the new schedule.
In contrast, when you modify a schedule, the changes affect both new and existing users of that schedule.
This means that you can update schedule settings before and after you create user accounts. You can also
reassign a user to a different schedule at any time.

For instructions on managing schedules, see the “Managing Schedules and Holidays” chapter of the
System Administration Guide for Cisco Unity Connection.

[ oL-17018-01
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H  Roles

Roles

Revised May 2009

Cisco Unity Connection offers levels of privileges for administrator accounts, set according to a list of
predefined roles. Roles specify which tasks administrators can do. Before you add administrator
accounts, select the roles that are assigned to each account. You can change which roles are assigned to
the accounts at any time.

Connection comes with the following predefined roles. To see the specific privileges for each
administrator role, in Cisco Unity Connection Administration, expand System Settings > Roles and click
the name of each role. You cannot make changes to the permissions that are associated with each
predefined role.

Audio Text Administrator This role allows an administrator to manage call handlers, directory
handlers, and interview handlers.

Greeting Administrator This role allows an administrator to access the Cisco Unity Greetings
Administrator, a Connection phone conversation that allows users to
manage the recorded greetings for call handlers by phone.

Note  You need to assign this role to a User with Voice Mailbox account
because the administrator must be able to access Connection by
phone.

Help Desk Administrator This role allows an administrator to reset user passwords and unlock user
accounts, and view user setting pages.

Remote Administrator This role allows an administrator to administer the database by using
remote tools.

System Administrator This is the top-level Connection administration role. This role allows
access to all Connection administrative functions, including all user and
system settings, all reports, and all administration and diagnostic tools.

The default administrator account that the installer specified during initial
setup of Connection is set to this role.

A System Administrator is the only role that has permission to create
administrative accounts.

Technician This role allows an administrator access to all functions that enable
management of the Connection server and phone system integration
settings; administrators with this role can also run all reports, use
diagnostic tools, and view all system and user settings pages.

User Administrator This role allows an administrator to manage user accounts, access all user
administration functions, run user-related reports, and use user
administration tools.

While you can assign roles to users with voice mailboxes, we do not recommend it except when allowing
access to the Cisco Unity Greetings Administrator. As a best practice, make sure that administrators
have two accounts: one without a voice mailbox for administering Connection and another with a voice
mailbox that they can use to access their personal mailbox.
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CHAPTER

Finding Users and Contacts in Cisco Unity
Connection Administration

Revised May 2009
Cisco Unity Connection Administration lets you find users and contacts based on search criteria that you
enter. You can enter all or part of a name, extension, and/or user alias (ID) to find a user or contact.

As a best practice, do not use wildcards such as * in search strings. When you want to find a user or
contact, use Begins With, Contains, or Ends With to match part of a string, or leave the search string
blank to return all results. Cisco Unity Connection attempts to match wildcard characters within the field
you are searching; if no objects contain such characters in that field, no results are returned.

You can use the Search Limits fields on the search page to limit the results that are displayed to a
particular partition in which user extensions are configured, or to a particular location if the directory
contains users from other digitally-networked Connection locations. When you search for users and limit
the results by partition, you can also choose whether to display only users whose primary extension is
in the partition, or users whose primary extension and any alternate extensions appear in the partition. If
you choose to display the primary extension and any alternate extensions, multiple records may display
for a single user in the search results.

You can use the navigation buttons at the bottom of the search results table to move between pages, and
use the Rows Per Page setting to display 25, 50, 100, 150, 200, or 250 rows per page. Connection saves
your Rows Per Page setting so that on subsequent logons you receive the same number of results per
page for this search page.

To Find a User Account

In Cisco Unity Connection Administration, click Users.
On the Search Users page, in the Search Results table, click the user alias to display the user account.
If you do not see the user alias listed in the Search Results table, continue with Step 3.

In the Find Users Where search fields, indicate whether to search by Alias, extension, First Name, Last
Name, or Display Name. You can further refine your search by setting additional parameters such as
Begins With or Ends With. Enter the applicable characters to search for, and click Find.

To limit the search results by partition or location, do the following:
a. In the Limit Search To list, click Partition or Location.
b. In the Where Name Is list, click the name of the partition or location in which to find the user.

When limiting the search to a partition, choose whether to display only primary extensions in the
partition or both primary and alternate extensions in the partition.
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Note If you choose to display both the primary extension and any alternate extensions, multiple
records may display for a single user in the search results.

In the Search Results table, click the user alias to display the user account.

To Find a Contact

In Cisco Unity Connection Administration, click Contacts.

If the applicable record is listed in the Search Results table, click the Alias to display the contact record.

If you do not see the record listed in the Search Results table, continue with Step 3.

In the search fields, set the search parameters, and enter the applicable characters to search for. Click
Find.

To limit the search results by partition or location, do the following:
a. In the Limit Search To list, click Partition or Location.
b. In the Where Name Is list, click the name of the partition or location in which to find the contact

In the Search Results table, click the Alias to display the contact record.
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CHAPTER I

Setting Up Features and Functionality That Are
Controlled by User Account Settings

Much of the functionality that affects how users interact with Cisco Unity Connection is controlled on
user account pages. This chapter contains information on how to set up the features and functionality
found on the account pages for individual users and user templates. As applicable, this chapter also
offers information on using the Bulk Edit utility to change user accounts for multiple users at once.

See the following sections:
e Passwords, page 4-2
e Message Waiting Indicators, page 4-4
e (Call Transfer, Call Screening, and Call Holding, page 4-6
e Personal Call Transfer Rules, page 4-8
e OQutside Caller Options, page 4-9
e Mailbox-Size Quotas, page 4-9
e Message Aging, page 4-10
e Message Locator, page 4-11
e Conversation and Phone Menu Options, page 4-11
e Phone View, page 4-22
e Message Playback Options, page 4-24
e Message Addressing and Sending Options, page 4-32
e Message Actions, page 4-37
e Greetings, page 4-40
¢ Notification Devices, page 4-48
e Alternate Extensions, page 4-56
e Alternate Names, page 4-60
e Private Distribution Lists, page 4-61
e Access to Exchange Calendars and Contacts, page 4-61
e Cisco Unified MeetingPlace or Cisco Unified MeetingPlace Express, page 4-62
e User Access to Email in an External Message Store, page 4-62

e SMTP Proxy Addresses, page 4-63
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Note

Note

e Voice Recognition, page 4-65

For information on functionality that is controlled by class of service settings, see the “Setting Up
Features and Functionality That Are Controlled by Class of Service” chapter.

The System Administration Guide for Cisco Unity Connection provides information on features and
functionality that are available to users systemwide, including many conversation features and
customizations. The guide is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsagx.htm
L.

Revised February 23, 2011

In Cisco Unified Communications Manager Business Edition (CMBE), you can change user voice mail
PINs and web application passwords either from the User Management pages in Cisco Unified CM
Administration or from the Edit > Change Password page in Cisco Unity Connection Administration.
However, you must use the User Management pages in Cisco Unified CM Administration to change
password settings (the authentication rule, lockout and expiration settings, and so on). The Edit >
Password Settings page is not available in Connection Administration on Cisco Unified CMBE.

If Cisco Unity Connection is integrated with an LDAP directory, the web application password and
password settings (for example, password-complexity settings and whether the password expires) are
controlled by the LDAP server.

For each user account, you can change user passwords and specify password settings from Cisco Unity
Connection Administration. Password settings for individual users determine:

e Which authentication rule governs the account (authentication rules specify the password, lockout,
and logon policies for Connection)

e Whether the user password was locked by an administrator, and if so, the time of the lockout

e Whether the user is allowed to change the password, or must change the password the next time he
or she logs on

e  Whether the password ever expires
e The last time a password was changed

e The number of failed logon attempts, the time of the last failed logon attempt, and the time period
that the lockout is enforced

You can change password settings on the Edit > Password Settings page for the applicable user or
template.

To change a phone or web password for a user, see the following sections:

e Securing and Changing User Phone Passwords, page 4-3

e Securing and Changing the Web Application (Cisco PCA) Password, page 4-3
Users can also use the Cisco Unity Assistant to change their passwords.

To learn about security implications when using default password settings, see the “Password Security
Considerations for Template Defaults” section on page 7-1.
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Securing and Changing User Phone Passwords
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Step 2
Step 3
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To help protect Cisco Unity Connection from unauthorized access and toll fraud, every user should be
assigned a unique phone password. Additionally, each password should be eight or more characters long
and non-trivial.

Do the following procedure for user accounts, or for a template that you can use to create user accounts.

To Change a Phone Password (PIN) for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Change Password.

On the Change Password page, in the Choose Password list, click Voice Mail.

In the Password field, enter the new password.

In the Confirm Password field, reenter the password to confirm.

Click Save.

Securing and Changing the Web Application (Cisco PCA) Password

Users must enter a password to log on to the Cisco PCA. The Cisco PCA password is referred to as the
“Web Application Password” in Cisco Unity Connection Administration.

Each user should be assigned a unique password. Connection requires that you specify a long—eight or
more characters—and nontrivial password. For the Cisco PCA, a nontrivial password has the following
attributes:

e The password must contain at least three of the following four characters: an uppercase character, a
lowercase character, a number, or a symbol.

e The password cannot contain the user name or its reverse.
e The password cannot contain the primary extension or its reverse.
e A character cannot be used more than three times consecutively (for example, !Cooool).

e The characters cannot all be consecutive, in ascending or descending order (for example, abcdef or
fedcba).

Depending on how you set up user accounts, you can require users to change their Cisco PCA passwords
the first time that they log on. Encourage users to enter secure passwords whenever they change their
Cisco PCA passwords, or set your secure password policy for the Cisco PCA to require them to do so.
Logon, password, and lockout policies are defined on the Edit Authentication Rules page in
Connection Administration.

Finally, when instructing users to secure their Cisco PCA passwords, convey the following:

e Users can change the Cisco PCA password only in the Cisco Unity Assistant; they cannot change it
by using the Connection conversation.

e The Cisco PCA password is not related to the Cisco Unity Connection phone password, and the two
are not synchronized. Users may assume that their phone and Cisco PCA passwords are the same.
As aresult, they may think that they are changing both passwords when the Connection conversation
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prompts them to change their phone password during first-time enrollment. For this reason, you may
find that many users do not consider securing their Cisco PCA passwords, even though you request
that they do so.

e For users who are able to access voice messages in an IMAP client, make sure that they understand
that whenever they change their Cisco PCA password in the Cisco Unity Assistant, they also must
update the password in their IMAP client. Passwords are not synchronized between IMAP clients
and the Cisco PCA. If users have trouble receiving voice messages in an IMAP client after having
updated their Cisco PCA password in both applications, see the “Troubleshooting IMAP Client
Logon Problems” section in the “Configuring an Email Account to Access Cisco Unity Connection
Voice Messages” chapter of the User Workstation Setup Guide for Cisco Unity Connection.

To Change a Web Application (Cisco PCA) Password for an Individual User or Template

Step1  In Cisco Unity Connection Administration, find the user account or template that you want to edit.
Step2  On the Edit menu, click Change Password.

Step3  On the Change Password page, in the Choose Password list, click Web Application.

Step 4 In the Password field, enter the new password.

Step 5 In the Confirm Password field, reenter the password to confirm.

Step6  Click Save.

Message Waiting Indicators

Revised May 2009
Cisco Unity Connection can set message waiting indicators (MWIs) at up to 10 extensions for a user
when new voice messages arrive.

When a user account is added, Connection automatically enables the MWTI at the primary extension for
the user.

You can change MWI settings, and add or delete MWI extensions in Cisco Unity Connection
Administration on the Message Waiting Indicators page for a user.

Note  Depending on the phones and phone systems, some additional phone system programming may be
necessary. Refer to the manufacturer documentation for the phone system.

For Cisco Unity Connection 7.1 and later, Connection can also send message counts to supported Cisco
IP phones in a SCCP integration with Cisco Unified Communications Manager 8.0 and later, or in a SIP
trunk integration with Cisco Unified CM 7.1 and later.

Do the applicable procedure to change MWI settings, or add or delete MWIs:
e To Add MWIs for Other Extensions, page 4-5
e To Change MWI Settings, page 4-5
e To Delete an MWI, page 4-6
e To Enable Message Counts (Cisco Unity Connection 7.1 and Later Only), page 4-6
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Message Waiting Indicators

To Add MWIs for Other Extensions

In Cisco Unity Connection Administration, find the user for whom you want to add another MWIL.
On the Edit menu, click Message Waiting Indicators.

On the Message Waiting Indicators page, click Add New.

On the New Message Waiting Indicator page, check the Enabled check box.

In the Display Name field, enter a description for the MWI.

Optionally, check the Inherit User’s Extension check box to use the primary extension for the user as
the extension on which the message waiting indicator (MWI) appears.

In the Extension field, enter the extension for the MWI. When entering characters, consider the
following:

e Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

e Enter, (comma) to insert a one-second pause.

e Enter # and * to correspond to the # and * keys on the phone.
In the Phone System field, click the name of the phone system that the extension is assigned to.
Click Save.
Repeat Step 2 through Step 9 as necessary.

To Change MWI Settings

In Cisco Unity Connection Administration, find the user for whom you want to change the MWI settings.
On the Edit menu, click Message Waiting Indicators.

On the Message Waiting Indicators page, click the MWI for which you want to change the settings.
On the Edit Message Waiting Indicator page, check or uncheck the Enabled check box, as applicable.
In the Display Name field, revise the description for the MWI.

Optionally, check the Inherit User’s Extension check box to use the primary extension for the user as
the extension on which the message waiting indicator (MWI) appears.

In the Extension field, revise the extension for the MWI. When entering characters, consider the
following:

e Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

e Enter, (comma) to insert a one-second pause.

e Enter # and * to correspond to the # and * keys on the phone.
In the Phone System field, click the name of the phone system that the extension is assigned to.
Click Save.
Repeat Step 2 through Step 9 as necessary.

[ oL-17018-01

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



Chapter4  Setting Up Features and Functionality That Are Controlled by User Account Settings |

I call Transfer, Call Screening, and Call Holding

To Delete an MWI

Step1  In Cisco Unity Connection Administration, find the user for whom you want to delete an MWI.
Step2  On the Edit menu, click Message Waiting Indicators.

Step3  On the Message Waiting Indicators page, check the check boxes next to the MWIs that you want to
delete.

Step4  Click Delete Selected.

To Enable Message Counts (Cisco Unity Connection 7.1 and Later Only)
Added May 2009

Step 1 In Cisco Unity Connection Administration, find the user for whom you want to enable message counts.
Step2  On the Edit menu, click Message Waiting Indicators.

Step3  On the Message Waiting Indicators page, click the applicable MWI.

Step4  On the Edit Message Waiting Indicator page, check the Send Message Counts check box.

Step5  Click Save.

Call Transfer, Call Screening, and Call Holding

Revised May 2009

Call Transfer settings specify how Cisco Unity Connection handles calls that are transferred from the
automated attendant or a directory handler to user phones. These settings also specify the mechanism
that Connection uses to transfer the call: Connection can either release the call to the phone system, or
it can supervise the transfer.

When Connection is set to supervise transfers, it can provide additional call control with call holding
and call screening for indirect calls:

e With call holding, when the phone is busy, Connection can ask callers to hold. Each caller on hold
uses a Connection port and a phone system port, so the total number of callers that can be holding
in the queue at one time is limited by the number of available ports.

The wait time in the call holding queue for the first caller in the queue defaults to 25 seconds. If the
caller is still on hold after this amount of time, Connection asks if the caller wants to continue
holding, leave a message, or try another extension. If the caller does not press 1 to continue holding,
or press 2 to leave a message, the caller is transferred back to the Opening Greeting. Subsequent
callers in the holding queue are told how many other callers are in the queue ahead of them, in
addition to these options.

If call holding is not selected, callers are sent to whichever user greeting is enabled—the busy,
standard, closed, or alternate greeting.

e With call screening, Connection can ask for the name of the caller before connecting to a user. The
user can then hear who is calling and, when a phone is shared by more than one user, who the call
is for. The user can then accept or refuse the call.
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Call Transfer, Call Screening, and Call Holding

If the call is accepted, it is transferred to the user phone. If the call is refused, Connection plays the
applicable user greeting.

Transfer, screening, and holding settings do not apply when an outside caller or another user dials a user
extension directly. Refer to your phone system documentation for information on how it handles direct
calls to user extensions. User desk phones may also offer similar features.

To control how Connection handles indirect calls at different times of the day or for specified periods
of time, you can define Standard, Closed, and Alternate transfer rules. The Standard transfer rule is
always enabled and cannot be turned off; you determine when the Closed and Alternate transfer rules
are enabled and for how long.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts.

e To Edit Standard, Closed, or Alternate Call Transfer Rules for an Individual User or Template,
page 4-7

e To Edit Standard, Closed, or Alternate Call Transfer Rules for Multiple User Accounts at Once,
page 4-8

If they are assigned to a class of service that allows them to do so, users can change their call screening
and holding options in the Cisco Unity Assistant web tool. To learn more, see the “Call Screening and
Call Holding” section on page 5-3.

To Edit Standard, Closed, or Alternate Call Transfer Rules for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Transfer Rules.

On the Transfer Rules page, click the applicable link to change Standard, Closed, or Alternate transfer
rules.

If the When This Basic Rule Is Active field is displayed at the top of page, choose the applicable option:

Apply Basic Settings on | Connection applies the settings on this page when this transfer rule is active.
This Page

Apply Personal Call Connection ignores the settings on this page and applies personal call
Transfer Rules transfer rules when this transfer rule is active.

Note  This option is available only if the user has access to the Personal
Call Transfer Rules web tool.

When using this option, you must also configure personal call transfer rule
sets in the Personal Call Transfer Rules web tool. If no rule sets are
configured, all calls are transferred to the primary extension of the user.

If you selected Apply Basic Settings on This Page, or if the When This Basic Rule Is Active field was
not displayed at the top of page, change the remaining settings on the page, as applicable.

~

Note  You can specify how you want Closed and Alternate transfer rules to work without enabling
them.
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Click Save.

Repeat Step 3 through Step 6 for the remaining transfer rules, as needed.

To Edit Standard, Closed, or Alternate Call Transfer Rules for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Transfer tab.

Click the applicable transfer tab, and update the settings.

Repeat Step 5 for the remaining transfer tabs, as needed.

Click Next, and then click Finish.

Personal Call Transfer Rules

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

Personal call transfer rules are available only to users who are assigned to a class of service for which
the feature is enabled. Personal call transfer rules are used only if the active basic rule—the standard,

alternate or closed transfer rule—is set to apply personal call transfer rules instead of the basic settings.

To activate and modify personal call transfer rules for a user, do the following procedure.

To Activate and Modify Personal Call Transfer Rules for an Individual User

In Cisco Unity Connection Administration, find the user account that you want to edit.
On the Edit menu, click Transfer Rules.

On the Transfer Rules page, in the Transfer Rule table, choose the basic transfer rule that you want to
use with personal call transfer rules.

Click Apply Personal Call Transfer Rules.
Click Save.

Repeat Step 2 through Step 5 for each additional basic transfer rule that you want to use with personal
call transfer rules.

On the Edit Transfer Rule page, click the link to the Cisco Unity Personal Call Transfer Rules web tool.

This launches the Personal Call Transfer Rules web tool for the user.

Change the applicable settings.

~

Note  For detailed information about the available settings, see the User Guide for the Cisco Unity
Connection Personal Call Transfer Rules Web Tool (Release 7.x), available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/pctr/7xcucugpctr
x.html.
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Step 9

Outside Caller Options

Click Save.

Outside Caller Options

The options on the Edit Message Settings page control the experience that outside (unidentified) callers
have when leaving messages for a user. For example, you can specify:

¢ The maximum recording length for messages left for a user by outside callers. (Note that for some
integrations, you can set Cisco Unity Connection so that when a caller records a message, a warning
tone is played before the caller reaches the maximum allowable message length.)

e What outside callers can do when leaving messages for a user—including whether they can mark
messages urgent and rerecord their messages.

e Whether messages left by outside callers are secure. (See the “Securing User Messages: Controlling
Access and Distribution” chapter of the System Administration Guide for Cisco Unity Connection
to learn how Connection handles secure messages.)

¢ The language of the Connection prompts that callers hear when leaving messages for a user.

You specify message settings for a specific user on the Edit Message Settings page for the user or for a
template that you can use to create user accounts.

Mailbox-Size Quotas

A

Revised May 2009
Cisco Unity Connection lets you specify the maximum size, or quota, for every mailbox in a Connection
system. You can configure quotas so that Connection:

e Issues a warning when a mailbox reaches a specified size.
e Prevents a user from sending messages when the mailbox reaches a larger size.

e Prevents a user from sending or receiving messages when the mailbox reaches the largest size that
you want to allow.

To handle the varying needs of users in your organization, you can override the systemwide quotas for
individual mailboxes and for user templates. For example, you may want to allow employees in the sales
department to have larger mailboxes than other employees. If you create user accounts for all sales
employees by using the same template, you can specify higher quotas for the template. Or you can
specify higher quotas for individual user accounts.

Caution

Quotas are not enforced for messages left by outside callers if the “Full Mailbox Check for Outside
Caller Messages” check box is not checked. This check box appears on the System Settings >
Advanced > Conversations page. For more information, see the Help for that page.

Do the following procedure for user accounts or for a template that you can use to create user accounts.
For details on how each quota works, and on how to change quotas for the entire system, see the
“Specifying Mailbox Size Quotas” section in the “Controlling the Size of Mailboxes” chapter of the
System Administration Guide for Cisco Unity Connection.
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To Specify Custom Mailbox Size Quotas for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Mailbox.

On the Edit Mailbox page, set values for the applicable settings by clicking Custom and then entering a
value (in megabytes) in the adjacent field:

e Warning Quota
e Send Quota
e Send/Receive Quota

Note that the value for Warning Quota must be smaller than or equal to the value for Send Quota, and
the value for Send Quota must be smaller than or equal to the value for Send/Receive Quota.

Click Save.

Message Aging

Step 1
Step 2
Step 3

Step 4

To help ensure that the hard disk where voice messages are stored does not fill up, you can configure
Cisco Unity Connection message aging rules to automatically move read messages to the Deleted Items
folder after a specified number of days and to permanently delete messages in the Deleted Items folder
after a specified number of days.

To help enforce a message retention policy, you can configure Connection message aging rules to
permanently delete secure messages that are older than a specified number of days based on whether or
not users have touched the messages in some way.

For more information on how the message aging policy works, how to change policy settings, and how
to turn the policy on or off for the entire system, see the “Changing the Message Aging Policy” section
in the “Controlling the Size of Mailboxes” chapter of the System Administration Guide for Cisco Unity
Connection.

Do the following procedure to enable or disable the message aging policy for user accounts, or for a
template that you can use to create user accounts.

To Enable or Disable the Message Aging Policy for Users or Templates

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Mailbox.

On the Edit Mailbox page, check or uncheck the Enable Message Aging Policy check box, as
applicable.

Click Save.
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The Message Locator feature allows users to find voice messages from other users and outside callers
when they check messages by phone. When the feature is enabled, Connection users can search their new
and saved messages for messages from a particular user, extension, or phone number (ANI or caller ID
information).

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. When you enable Message Locator for an individual user account or a template,
you can also specify playback order for messages found by Message Locator.

e To Enable Message Locator and Specify Playback Order for an Individual User or Template,
page 4-11

e To Enable Message Locator for Multiple User Accounts at Once, page 4-11

To Enable Message Locator and Specify Playback Order for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.
On the Phone Menu page, under Finding Messages with Message Locator, check the Enable check box.

In the Message Locator Sort Order list, click Last In, First Out or First In, Last Out to specify the
playback order.

Click Save.

To Enable Message Locator for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

On the General Conversation tab, check the Enable Message Locator check box, and then click Yes in
the adjacent list.

Click Next, and then click Finish.

Conversation and Phone Menu Options

In addition to the basics of specifying how loudly or quickly Connection plays prompts, there are several
other ways that you can customize the Cisco Unity Connection conversation and its menus.

See the following topics for details and procedures:

e Allowing Users to Access Cisco Unity Connection by Phone Without Entering a Password,
page 4-12

e Touchtone and Voice-Recognition Conversations, page 4-12
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e Full or Brief Menu Style for Touchtone Conversations, page 4-14

e How Long Cisco Unity Connection Waits for User Responses, page 4-15

e Phone Language That Users and Callers Hear, page 4-17

e Selecting a Destination When Cisco Unity Connection Exits the Conversation, page 4-18
¢ Speed and Volume for the Conversation, page 4-19

e Greeting Users By Name Upon Logon, page 4-21

e Playing New Messages Automatically, page 4-22

Users can also use the Cisco Unity Assistant to change many conversation and phone menu options for
themselves.

Allowing Users to Access Cisco Unity Connection by Phone Without Entering a
Password

By default, users are prompted for a password before they can log on to Cisco Unity Connection to check
messages or change their personal settings. As a convenience to users who often access Connection from
a mobile phone, home phone, or phone in a secured office within your organization, you may consider
specifying that Connection should not prompt them to enter a password when they call Connection to
access their mailbox from their primary extension or alternate devices. (When they call Connection from
an unknown extension, Connection prompts them for their passwords as usual.)

For security reasons, it may not be appropriate to allow users who work in shared workspaces, cubicles,
or other public areas in your organization (such as a lobby or reception area) to access Connection by
phone without first entering a password.

Users who do not have to enter a password to log on to Connection are still prompted to renew their
phone passwords when they expire.

To Allow Users to Access Cisco Unity Connection By Phone Without Entering a Password

Step 1 In Cisco Unity Connection Administration, find the user account or template that you want to edit.

Step2  On the Edit User Basics or User Template Basics page (as applicable), check the Skip Password When
Calling From a Known Extension check box.

Step3  Click Save.

Touchtone and Voice-Recognition Conversations

Cisco Unity Connection offers several versions of the phone conversation that users hear and use. The
version you select determines whether Connection responds only to phone keypad input or also uses
voice recognition to interpret spoken commands:
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Touchtone Users press keys to tell Connection what they want to do. There are several touchtone
Conversations | conversations to choose from. Each one offers a unique keypad mapping for the
message retrieval menus. For some, the keys assigned to options in the Main menu are
also unique.

Voice- Users say voice commands and/or press keys on the phone to interact with
Recognition Connection. You cannot choose the keypad mapping offered in the voice-recognition
Conversation conversation.

Note Inorder to assign users to the voice-recognition conversation, the user account
or template must be assigned to a class of service that enables a license and
the voice-recognition feature. See the “Voice Recognition” section on
page 5-13.

For those in your organization who use a touchtone conversation, you can provide an easier transition
from a former voice messaging system by choosing the version that offers the keypad mapping and menu
options that they are already familiar with. Alternatively, choosing an unfamiliar touchtone conversation
may offer an improved user experience and an opportunity to increase user productivity after a short
transition period. If you choose the latter approach, provide users with a list of the phone menu
differences between Connection and the former voice messaging system.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. When you modify multiple accounts at once, you can select a touchtone
conversation, but you cannot specify whether users hear the voice-recognition conversation.

e To Specify the Conversation Version for an Individual User or Template, page 4-13
e To Specify a Touchtone Conversation for Multiple User Accounts at Once, page 4-14

In the Cisco Unity Assistant, users can specify whether they hear a voice-recognition conversation or the
touchtone conversation that you specify. (They cannot choose the touchtone conversation that they hear.)

To Specify the Conversation Version for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Phone Menu.

On the Phone Menu page, do the following to enable the voice-recognition conversation (when allowed
by class of service):

a. Check the Use Voice Recognition Input Style check box.

b. In the Touchtone Conversation list, click the touchtone conversation that Connection offers in the
event that voice-recognition sessions are not available. (The selection here does not affect the
keypad mapping offered by the voice-recognition conversation.)

To enable the touchtone conversation, do the following:
a. Confirm that the Use Voice Recognition Input Style check box is not checked.

b. In the Touchtone Conversation list, click the touchtone conversation with the keypad mapping that
you want users to hear.

Click Save.
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To Specify a Touchtone Conversation for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab, and then click the Message Review tab.

Check the Touchtone Conversation Style check box, and then select the touchtone conversation with
the keypad mapping that you want users to hear.

Click Next, and then click Finish.

Full or Brief Menu Style for Touchtone Conversations

Step 1
Step 2
Step 3
Step 4

Step 1
Step 2
Step 3
Step 4
Step 5

You can specify that users hear either full or brief menus when they use a touchtone conversation:

Full Users hear comprehensive instructions. Consider selecting for a new user. This is the
default selection.

Brief Users hear abbreviated versions of the full menus. Select for a more experienced user.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts.

e To Specify the Touchtone Conversation Menu Style for an Individual User or Template, page 4-14
e To Specify the Touchtone Conversation Menu Style for Multiple User Accounts at Once, page 4-14

Users can also use the Cisco Unity Assistant to change the menu style for touchtone conversations.

To Specify the Touchtone Conversation Menu Style for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, in the Touchtone Conversation Menu Style list, click Full or Brief.
Click Save.

To Specify the Touchtone Conversation Menu Style for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

On the General Conversation tab, check the Prompt Style check box, and then click Full or Brief in the
adjacent list.
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Step 6 Click Next, and then click Finish.

How Long Cisco Unity Connection Waits for User Responses

For each user, you can specify the amount of time that Cisco Unity Connection waits after a user
response (or non-response) before taking an action:

Times to Repeat Menu When
User Does Not Respond

Specify how many times Connection repeats a menu if a user has not
responded to a menu.

Note  This setting is not available for the voice-recognition conversation.

Wait for First Touchtone or
Voice Command

Specify how long Connection waits for a user to press a first key or say a
voice command after playing a menu.

Wait for Additional Key
Presses When Entering
Names, Extensions, and
Passwords

Specify how long Connection waits for additional key presses after the
user has pressed a key when entering user names or extensions to address
a message, update passwords, change call transfer or message notification
numbers, and so on.

Wait for Additional Key
Presses When Entering
Multiple Digit Menu Options

Specify how long Connection waits for additional key presses after the
user has pressed a key that represents the first digit of more than one
possible key combination in a particular phone menu. (For example, in the
After Message menu, users can press 4 to reply to a message, 42 to reply
to all, or 44 to call the user.) This also applies when using ## to switch
addressing modes.

If there is no input within the time that you specify, Connection performs
the action assigned to the single key.

Wait Between Words in
Voice Commands (Phrase
Incomplete Timeout)

Specify how long Connection waits for a user to say additional words
before acting on the words already spoken. For example, a user might say
“Play new messages,” pause for a moment, and then add, “from Harriet
Smith.” In such cases, the value you enter here determines how long
Connection waits for the user to finish speaking before playing new
messages.
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Voice Recognition Specify the likelihood that Connection will prompt the voice-recognition
Confirmation Confidence user to confirm their intentions. For example, if users complain that the
Threshold system mistakenly hears them say “cancel” or “hang up,” you may want to

try increasing this setting to prevent users from accidentally committing
actions they did not intend. Alternatively, if users complain that the system
prompts for confirmation too frequently, try adjusting this setting to a
lower value.

The default value for this setting should reliably filter out most errors and
provide confirmation when necessary for most systems. If you decide to
change the value for this setting, consider that:

e A realistic range of values for this setting is 30 to 90, as setting this
value to 0 always disables confirmation and setting it to 100 always
enables it.

e If the value is set too low, the system may improperly recognize and
act on commands, resulting in the accidental deletion of messages or
exiting users from the system before they are ready to hang up.

Voice Recognition Speech Use this setting to compensate for potential background noise. A value of
Sensitivity 0 indicates that the speech engine is not very sensitive and the user has to
yell to be understood. A value of 100 means that the speech engine is very
sensitive and any noise at all is considered a speech event.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. Note that you cannot use Bulk Edit to change the Time to Wait Between Spoken
Words and the Voice Recognition Confirmation Confidence Threshold settings. However, users can
adjust both voice-recognition settings in the Cisco Unity Assistant.

e To Set Conversation Response Times for an Individual User or a Template, page 4-16
e To Set Conversation Response Times for Multiple User Accounts at Once, page 4-17

Users can also use the Cisco Unity Assistant to change the response times for the voice-recognition
conversation.

To Set Conversation Response Times for an Individual User or a Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Phone Menu.
On the Phone Menu page, under When Responding to Menus, update the applicable settings:
e In the Times to Repeat Menu When User Does Not Respond field, enter a value between 0 and 10.

e In the Wait for First Touchtone or Voice Command field, enter a value between 500 and 10,000
milliseconds.

¢ In the Wait for Additional Key Presses When Entering Names, Extensions, and Passwords field,
enter a value between 1,000 and 10,000 milliseconds. We recommend a value of 3,000 (three
seconds).

¢ In the Wait for Additional Key Presses When Entering Multiple Digit Menu Options field, enter a
value between 250 and 5,000 milliseconds. We recommend a value of 1,500 (one and a half
seconds).

e In the Wait Between Words in Voice Commands (Phrase Incomplete Timeout) field, enter a value
between 300 and 10,000 milliseconds.
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¢ In the Voice Recognition Confirmation Confidence Threshold field, enter a value between 0 and 100
percent. A value of 0 always disables confirmation and 100 always enables it.

¢ In the Voice Recognition Speech Sensitivity field, enter a value between 0 and 100. A value of 0
indicates that the speech engine is not very sensitive and the user has to yell to be understood. A
value of 100 means that the speech engine is very sensitive and any noise at all is considered a
speech event. We recommend a value of 50.

Click Save.

To Set Conversation Response Times for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

On the General Conversation tab, check the applicable check boxes, and then enter the appropriate values
in the adjacent fields:

e In the Milliseconds to Wait for User Input After a Menu Plays field, enter a value between 500 and
10,000 milliseconds.

e In the Milliseconds to Wait for More Input After a User Presses a Key field, enter a value between
1,000 and 10,000 milliseconds. We recommend a value of 3,000 (three seconds).

¢ Inthe Times to Repeat the Menu If the User Does Not Respond field, enter a value between 0 and 10.
Click Next, and then click Finish.

Phone Language That Users and Callers Hear

Note

Phone languages are the languages in which Cisco Unity Connection can play system prompts to users
and callers. For each user account, you can specify the language in which system prompts are played to
callers (this affects prompts such as “Record your message at the tone”), and you can change the
language that users hear when listening to the user conversation.

Consider that if the class of service for a user offers Text to Speech (TTS), the language you select also
controls the language that the TTS email reader uses. Before changing the phone and TTS language for
a user, verify that you have the applicable languages installed.

Depending on your license settings, U.S. English may not be available.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. Users can also use the Cisco Unity Assistant to select the language that they hear
when they log on to Connection by phone.

e To Change the Phone Language Settings for an Individual User or Template, page 4-18
e To Change the Phone Language Settings for Multiple User Accounts at Once, page 4-18
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Customizing the phone language setting for Connection users and their callers does not change the
default language settings for the rest of the system. The System Default Language is specified on the
System Settings > General Configuration page.

To Change the Phone Language Settings for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.

To change the phone language that users hear, on the Edit User Basics or User Template Basics page (as
applicable), in the Language field, click either the Use System Default Language option, or click a
language in the list of language options.

Click Save.
To change the phone language that callers hear, on the Edit menu, click Message Settings.

On the Edit Message Settings page, in the Language That Callers Hear field, click Use System Default
Language or Inherit Language from Caller, or click the language list and select one of the listed
languages.

Click Save.

If applicable, ask the user to rerecord the greeting in the new language.

To Change the Phone Language Settings for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Profile tab.

To change the phone language that users hear, check the Language Users Hear check box, and then
select either the Use System Default Language option, or click a language in the adjacent list of
language options.

To change the phone language that callers hear, check the Language Callers Hear check box, and then
select either the Use System Default Language option, or click a language in the adjacent list of
language options.

Click Next, and then click Finish.

Selecting a Destination When Cisco Unity Connection Exits the Conversation

You can select the destination to which Cisco Unity Connection sends the user when exiting the
conversation. For example, you can tell Connection to hang up, or send the user to another call handler
or to another Connection user.
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As applicable, do the procedures in this section for user accounts, or for the template that you can use
to create user accounts.

e To Specify Where Cisco Unity Connection Sends an Exiting User for an Individual User or
Template, page 4-19

e To Specify Where Cisco Unity Connection Sends an Exiting User for Multiple User Accounts at
Once, page 4-19

To Specify Where Cisco Unity Connection Sends an Exiting User for an Individual User or Template
Step 1 In Cisco Unity Connection Administration, find the user account or template that you want to edit.

Step 2 On Edit menu, click Phone Menu.

Step3  On the Phone Menu page, under When Exiting the Conversation, select one of the following:

Call Action Select the applicable action from the list. When Hang Up is selected,
Cisco Unity Connection immediately terminates the call when the user exits
the conversation.

Call Handler Sends the call to the system call handler that you specify. Specify whether
the call should transfer to the call handler extension or go directly to the
handler greeting.

Interview Handler Sends the call to the interview handler that you specify.

Directory Handler Sends the call to the directory handler that you specify.

Conversation Sends the call to the conversation that you specify.

User with Mailbox Sends the call to the user that you specify. Specify whether the call should

transfer to the user extension or go directly to the user greeting.

Step4  Click Save.

To Specify Where Cisco Unity Connection Sends an Exiting User for Multiple User Accounts at Once

Step 1 In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
Step2 In the Bulk Edit utility, find the user accounts that you want to edit.

Step3  Click Next.

Step 4 Click the Conversation tab, and then click the Exit Destination tab.

Step5  Check the Make Changes to Conversation Exit Destination check box.

Step6  Follow the onscreen instructions to change the settings as applicable.

Step 7 Click Next, and then click Finish.

Speed and Volume for the Conversation

Revised May 2009
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You can specify the speed and volume at which Cisco Unity Connection plays prompts, recorded voice
names, receipts, and user greetings.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts.

e To Change Conversation Speed or Volume Settings for an Individual User or Template, page 4-20
e To Change Conversation Speed or Volume Settings for Multiple User Accounts at Once, page 4-20

Users can also use the Cisco Unity Assistant to specify speed and volume levels, and they can use voice
commands to change the speed and volume of the Connection conversation at any point while
Connection is playing prompts. (Users cannot use the phone keypad to adjust the conversation speed.)

In Cisco Unity Connection version 7.1(1) and later, changes that users make by phone are saved as the
default conversation speed or volume. To disable this behavior, see the “Saving Speed and Volume
Changes Made by Users” section in the “Changing Conversation Settings for All Users” chapter of the
System Administration Guide for Cisco Unity Connection. (The voice-recognition conversation is the
only conversation that allows users to change the Connection conversation speed or volume by phone.)

In Cisco Unity Connection version 7.0, changes that users make by phone are in effect only until they
hang up the phone. The next time that they call Connection, the speed and volume are reset to the default
setting. (The voice-recognition conversation is the only conversation that allows users to change the
Connection conversation speed or volume by phone.)

To Change Conversation Speed or Volume Settings for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, in the Conversation Volume list, click the volume level at which users hear
the Connection conversation:

e Low

e Medium

¢ High

In the Conversation Speed list, click the speed at which Connection plays prompts to users:

e Fastest

e Fast

e Normal

e Slow

Click Save.

To Change Conversation Speed or Volume Settings for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.
Click Next.

Click the Conversation tab.
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On the General Conversation tab, check the Conversation Volume check box, and then click the volume
level in the adjacent list.

Check the Conversation Speed check box, and then click the speed level in the adjacent list.
Click Next, and then click Finish.

Greeting Users By Name Upon Logon

Step 1
Step 2
Step 3
Step 4

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

You can choose whether Cisco Unity Connection plays the recorded name of the user after a user logs
on by phone. By default, Connection does not play the recorded name.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts.

e To Specify That Cisco Unity Connection Greets User by Name for an Individual User or Template,
page 4-21

e To Specify That Cisco Unity Connection Greets Users by Name for Multiple User Accounts at Once,
page 4-21

Users can also use the Cisco Unity Assistant to choose whether they want to hear their recorded name
upon logon.

To Specify That Cisco Unity Connection Greets User by Name for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, under After Logon Play, check the User’s Recorded Name check box.
Click Save.

To Specify That Cisco Unity Connection Greets Users by Name for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

On the General Conversation tab, check the Greet User by Name check box, and then click Yes in the
adjacent list.

Click Next, and then click Finish.
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Playing New Messages Automatically

Step 1
Step 2
Step 3

Step 4

By default, users hear the Main Menu after they log on to Cisco Unity Connection. You can customize
the conversation so that Connection plays new messages instead. When you do, users no longer have to
press a key to play new messages because Cisco Unity Connection begins playing them automatically.

Otherwise, the conversation that users hear sounds and acts as usual:

e Connection plays the recorded name of the user, alternate greeting notification, new message counts,
and the Message Type menu as specified.

e System broadcast messages, full mailbox warnings, reminders to reset passwords, and other such
prompts are likewise played before Connection begins playing new messages.

e Users must indicate whether they want to save or delete a message before Connection plays the next
new message.

e Users can exit message playback to hear the Main menu at any time. If users have no new messages,
the Main menu is played as usual.

To specify that Connection plays new messages automatically in a template or for an individual user, do
the following procedure.

To Specify That Cisco Unity Connection Plays New Messages Automatically

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, under After Logon Play, check the User’s New Messages Automatically
check box.

Click Save.

Phone View

Revised May 2009

The Phone View feature allows users to see search results on the LCD screens of their Cisco IP phones
when they use the Find Message or the Display Message menu. When it is enabled, Cisco Unity
Connection users can search for the following types of messages:

e All new voice messages

e All voice messages

e Messages from a particular user

e Messages from all outside callers

e Messages from a particular outside caller

Phone View can be used with either the touchtone or the voice-recognition conversation. For use with
voice recognition, the voice-recognition feature must be enabled, and users must be assigned to a class
of service that allows them to use it. For details on setting up voice recognition for users, see the “Voice
Recognition” section on page 5-13.
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Phone View W

Use the following Task List to enable Phone View for users:

1. First create an application CTI user in Cisco Unified Communications Manager and associate the
applicable subscriber devices with this user. Then enable Phone View for the phone system. For
details, see the “Setting Up Phone View” chapter of the System Administration Guide for
Cisco Unity Connection.

2. Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. When you enable Phone View for users who use the touchtone conversation version, you
can also specify playback order for messages found by Message Locator searches.

— To Enable Phone View and Specify Playback Order for an Individual User or Template
(Touchtone Conversation), page 4-23

— To Enable Phone View for an Individual User or Template (Voice-Recognition Conversation),
page 4-23

— To Enable Phone View for Multiple User Accounts at Once, page 4-23

To Enable Phone View and Specify Playback Order for an Individual User or Template (Touchtone Conversation)

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.
On the Phone Menu page, under Finding Messages with Message Locator, check the Enable check box.

In the Message Locator Sort Order list, click Last In, First Out or First In, Last Out to specify the
playback order.

Check the Enable Phone View check box.

~

Note  The Enable Phone View check box will not appear unless the CTI application user for Phone
View has been created in Cisco Unified CM Administration.

Click Save.

To Enable Phone View for an Individual User or Template (Voice-Recognition Conversation)

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, under Conversation Style, check the Use Voice Recognition Input Style
check box.

Under Finding Messages with Message Locator, check the Enable check box.
Click Save.

To Enable Phone View for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.
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Click Next.
Click the Conversation tab.

On the General Conversation tab, check the Enable Phone View check box, and then click Yes in the
adjacent list.

~

Note  For this setting to be saved, the applicable feature—Message Locator or Voice
Recognition—must already be enabled for the users.

Click Next, and then click Finish.

Message Playback Options

You can dictate how messages are presented to users by phone. For example, you can specify whether
users hear the Message Type menu, message counts, and time stamps when they check messages, and
you can specify the order in which Connection plays messages.

See the following sections:
e Time Format Used for Message Time Stamps, page 4-24
e Message Playback Speed and Volume, page 4-25
e Message Counts, page 4-26
e Message Playback Order, page 4-27
¢ What Cisco Unity Connection Plays Before and After Each Message, page 4-29
e Mark Messages Saved When Users Hang Up or Are Disconnected, page 4-31
e Amount of Time to Skip Back or Ahead When Rewinding or Fast-Forwarding Messages, page 4-31
e Confirm Deletions of New and Saved Messages, page 4-32

Time Format Used for Message Time Stamps

By default, users hear message time stamps in a 12-hour clock format when they listen to their messages
by phone. For example, they hear “1:00 p.m.” when listening to the time stamp for a message left at 1:00
p-m.

Alternatively, you can change the time format setting so that users hear message time stamps in a 24-hour
clock format. For example, they hear “13:00” when listening to the time stamp for a message left at
1:00 p.m.

Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. Users can also use the Cisco Unity Assistant to set their own time format preferences.

e To Specify a 12- or 24-Hour Clock Time Stamp Format for an Individual User Account or Template,
page 4-25

e To Specify a 12- or 24-Hour Clock Time Stamp Format for Multiple User Accounts at Once,
page 4-25
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To Specify a 12- or 24-Hour Clock Time Stamp Format for an Individual User Account or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Phone Menu.

On the Phone Menu page, under Time Format, click either 12-Hour Clock or 24-Hour Clock.
Click Save.

To Specify a 12- or 24-Hour Clock Time Stamp Format for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab, and then click the Message Review tab.

Check the Time Format check box, and then click either 12-Hour Clock or 24-Hour Clock in the
adjacent list.

Click Next, and then click Finish.

Message Playback Speed and Volume

Step 1

Revised May 2009
You can specify the speed and volume at which Cisco Unity Connection plays messages.

Users can also use the Cisco Unity Assistant to specify speed and volume levels, and they can adjust the
volume from their phones.

In Cisco Unity Connection version 7.1(1) and later, changes in playback speed or volume that a user
makes by phone while playing messages are saved as the new default playback settings for the user. To
disable this behavior, see the “Saving Speed and Volume Changes Made by Users” section in the
“Changing Conversation Settings for All Users” chapter of the System Administration Guide for

Cisco Unity Connection.

In Cisco Unity Connection version 7.0, changes in playback speed or volume that a user makes for
individual messages do not affect the playback of other messages heard during the same phone session.
In addition, the next time the user calls Connection, playback settings are reset to the defaults.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. When you update an individual user account or template, you can also adjust
conversation speed and volume.

e To Change Message Playback Speed or Volume for an Individual User Account or Template,
page 4-25

e To Change Message Playback Speed or Volume for Multiple User Accounts at Once, page 4-26

To Change Message Playback Speed or Volume for an Individual User Account or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
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On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, in the Message Volume list, click the volume level at which
users hear the Connection conversation:

e Low

e Medium

¢ High

In the Message Speed list, click the speed at which Connection plays prompts to users:

e Fastest

e Fast

e Normal

e Slow

Click Save.

To Change Message Playback Speed or Volume for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab, and then click the Message Review tab.

Check the Message Volume check box, and then click the applicable option in the adjacent list.
Check the Message Speed check box, and then click the applicable option in the adjacent list.
Click Next, and then click Finish.

Message Counts

Step 1
Step 2

You can specify the types of messages for which Cisco Unity Connection announces count totals when
users check messages by phone.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. Users can also use the Cisco Unity Assistant to specify the message counts that
they want to hear.

e To Specify Which Message Counts Cisco Unity Connection Plays for an Individual User or
Template, page 4-26

e To Specify Which Message Counts Cisco Unity Connection Plays for Multiple User Accounts at
Once, page 4-27

To Specify Which Message Counts Cisco Unity Connection Plays for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.

On the Edit Menu, click Playback Message Settings.
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On the Playback Message Settings page, under For New Messages Play, check or uncheck any or all of
the following check boxes to specify which message counts Connection plays before each new message:

Message Count Totals Connection announces the total number of all messages (voice,
email, and receipt messages).

Voice Message Counts Connection announces the number of voice messages.

Email Message Counts Connection announces the number of email messages.

Fax Message Counts Connection announces the number of fax messages.

Receipt Message Counts Connection announces the number of receipts.

In the For Saved Messages Play section, check the Saved Message Count check box to have Connection
announce the total number of all saved messages (voice, email, and receipt messages).

Click Save.

To Specify Which Message Counts Cisco Unity Connection Plays for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

On the General Conversation tab, check any or all of the following check boxes, and then click Yes in
the adjacent list:

e Announce Total Number of New Messages

e Announce Total Number of Saved Messages

e Announce Total Number of New Voice Messages
¢ Announce Total Number of New Fax Messages

¢ Announce Total Number of New Email Messages

Click Next, and then click Finish.

Message Playback Order

You can customize the order in which messages are played for new, saved, and deleted messages. For
new and saved messages, you use the playback settings to sort messages in order by message type (for
example, voice or email) and by message urgency. In this way, you can specify that Cisco Unity
Connection plays urgent voice messages first, followed by normal voice messages.

By default, new and saved messages are sorted by type in the following order:
e Urgent voice messages

e Normal voice messages
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e Urgent emails
e Normal emails
e Receipts and notices

Note that except for receipts, messages are sorted so that Connection plays urgent messages for each
message type first. (Receipts are sorted only by the time that they were sent.)

For each message type, Connection plays the messages according to the time a message was sent, so that
either the newest or oldest messages are presented first. Because deleted messages are not sorted by type,
you can indicate only whether Connection plays newest or oldest messages first.

Table 4-1 lists the default order for new, saved, and deleted messages, regardless of message type.

Table 4-1 Message Playback Order
Message State | Default Order

New Oldest message first
Saved Newest message first
Deleted Newest message first

Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. Users can also use the Cisco Unity Assistant to customize message playback order.

¢ To Change Message Playback Order for an Individual User Account or Template, page 4-28
e To Change Message Playback Order for Multiple User Accounts at Once, page 4-28

To Change Message Playback Order for an Individual User Account or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, under New Message Play Order, use the Move Up and Move
Down arrows to put the Sort by Message Type list in the order in which you want the messages played.

In the Then By list, click Newest First or Oldest First to specify the message order for all new
messages. (Note that this does not allow you to have a particular message type played.)

Under Saved Message Play Order, use the Move Up and Move Down arrows to put the Sort by Message
Type list in the order in which you want the messages played.

In the Then By list, click Newest First or Oldest First to specify the message order for all saved
messages.

In the Deleted Message Play Order list, click Newest First or Oldest First to specify the message order
for deleted messages.

Click Save.

To Change Message Playback Order for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.
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Click Next.
Click the Conversation tab, and then click the Flex Stack tab.
Check the Make Changes to Message Play Order Options check box.

Under New Message Play Order, use the Move Up and Move Down buttons to put the list of message
types in the order in which you want them played.

In the Then By list, click Newest First or Oldest First to specify the message order for all new
messages. (Note that this does not allow you to have a particular message type played.)

In the Saved Message Play Order section, use the Move Up and Move Down buttons to put the list of
message types in the order in which you want them played.

In the Then By list, click Newest First or Oldest First to specify the message order for all saved
messages.

In the Deleted Message Play Order list, click Newest First or Oldest First to specify the message order
for deleted messages.

Click Next, and then click Finish.

What Cisco Unity Connection Plays Before and After Each Message

Step 1

Before playing each message, you can specify whether you want Cisco Unity Connection to play
information about the message and the message sender, including the recorded name and/or extension
of a user, the phone number (ANI or caller ID) of an outside caller, a time stamp, and the message
number. After playing each message, you can specify whether Connection plays the time stamp.
Connection can play all, none, or a combination of the available information about a message and its
sender before and after each message.

For receipts, you cannot modify what Connection plays, and the information that Connection plays
differs slightly. Whether Connection plays the time stamp and reason for a receipt before or after the list
of recipients depends on how many recipients are associated with the receipt, as follows:

One recipient Time stamp and reason are played after the recipient name.

More than one recipient Time stamp and reason are played before the recipient list.

Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. When you update an individual user account or a template, you can also specify what
Connection plays after a message.

e To Change What Cisco Unity Connection Plays Before and After a Message for an Individual User
or Template, page 4-29

e To Change What Cisco Unity Connection Plays Before a Message for Multiple User Accounts at
Once, page 4-30

Users can also use the Cisco Unity Assistant to specify what Connection plays before and after a
message.

To Change What Cisco Unity Connection Plays Before and After a Message for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
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On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, under Before Playing Each Message Play, check or uncheck
any or all of the following check boxes:

Sender’s Information

For messages left by an identified user, check this check box to have
Connection play the recorded name of the user. If the user does not have a
recorded name, Connection plays the primary extension that is associated with
the user instead.

Include Extension

Check this check box to have Connection include the extension of the
identified user who left the message, in addition to the recorded name.

Message Number

Check this check box to have Connection announce the sequential number of
a message. (For example, “Message 1, a voice message... Message 2, a voice
message....”)

Time the Message Was
Sent

Check this check box to have Connection announce the time that the message
was sent by the caller.

Sender’s ANI

For messages left by an outside caller, check this check box to have Connection
provide the phone number (ANI or caller ID) information before playing the
message.

Under After Playing Each Message Play, check or uncheck the Time the Message Was Sent check box
to specify whether Connection plays the message time stamp after playing each message.

Click Save.

To Change What Cisco Unity Connection Plays Before a Message for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab, and then click the Message Review tab.

On the Message Review tab, check or uncheck any or all of the following check boxes and click Yes or
No (as applicable) in the adjacent list:

Announce Sender
Information

For messages left by an identified user, check this check box to have
Connection play the recorded name of the user. If the user does not have a
recorded name, Connection plays the primary extension associated with the
user instead.

Announce Time Before
Playing Each Message

Check this check box to have Connection announce the time that the message
was sent by the caller.

Announce Sender
Extension for Messages
from Users

Check this check box to have Connection include the extension of the user who
left the message, in addition to the recorded name.
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Announce ANI for For messages left by an outside (unidentified) caller, check this check box to
Me_ssag_e§ from have Connection provide the phone number (ANI or caller ID) information
Unidentified Callers before playing the message.

Say Message Number Check this check box to have Connection announce the sequential number of
a message. (For example, “Message 1, a voice message... Message 2, a voice
message...”)

Click Next, and then click Finish.

Mark Messages Saved When Users Hang Up or Are Disconnected

Step 1
Step 2
Step 3

Step 4

By default, when users listen to a message by phone, Cisco Unity Connection retains the message
as-is—either as a new or saved message—unless users indicate otherwise before hanging up or being
disconnected. However, some users may prefer that Connection marks all messages saved as soon as they
access the message.

To Specify That Messages Are Marked Saved When Users Hang Up or Are Disconnected

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, under While Playing Each Message, change the value of the
When a Call Is Disconnected or the User Hangs Up field to Save Message.

Click Save.

Amount of Time to Skip Back or Ahead When Rewinding or Fast-Forwarding
Messages

Step 1
Step 2
Step 3

By default, when users are listening to messages and they rewind or fast-forward a message, Cisco Unity
Connection skips back or ahead in the message by five seconds. To change the number of seconds that
Connection skips back or ahead in a message, do the following procedure.

Users can also use the Phone Menu Preferences page in the Cisco Unity Assistant to enable and adjust
the settings themselves.

To Change the Amount of Time to Skip Back or Ahead When Rewinding or Fast-Forwarding Messages

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, under While Playing Each Message, change the value of the
Fast Forward Message By and the Rewind Message By fields, depending on the desired behavior.
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Click Save.

Confirm Deletions of New and Saved Messages
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Step 4

By default, when users delete new and saved messages by phone, Cisco Unity Connection does not ask
them to confirm the deletion. Some users may prefer that Connection ask them to confirm the choice
before deleting the messages. Confirming the deletion of messages is particularly useful to those users
who do not have access to deleted messages.

Do the following procedure to specify that Cisco Unity Connection asks users to confirm their deletions.

To Specify That Cisco Unity Connection Asks Users to Confirm Deletions of New and Saved Messages

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Playback Message Settings.

On the Playback Message Settings page, under When Deleting a Message, check the Confirm Deletions
of New and Saved Messages check box.

Click Save.

Message Addressing and Sending Options

There are several settings that customize how users address and send messages to other users. See the
following sections:

e Broadcast Messages, page 4-32

e Addressing by Spelling Name or Entering Extension With Touchtone Conversations, page 4-34
e Prompting Users to Confirm Recipients by Name, page 4-34

e Prompting Users to Continue Addressing, page 4-35

e Specifying Whether Messages Are Sent Upon Hang-Up, page 4-36

e Adding Recipients to the Message Addressing Priority List, page 4-36

Broadcast Messages

System broadcast messages are recorded announcements that are sent to everyone in an organization.
You specify whether users can send system broadcast messages to all users on the local Cisco Unity
Connection server, and whether users can update system broadcast messages stored on the local
Connection server. (By default, Connection users are not enabled to send or update broadcast messages.)

To determine which Connection users can send and/or update system broadcast messages, consider how
users in your organization might use system broadcast messaging. For example, you may want to enable
Connection administrators to send a welcome message to users on a new system or to remind all
Connection users to change their phone passwords. Administrators may also want to use system
broadcast messages as a way to train users on how to use Connection features or to summarize changes
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to Connection after an upgrade. Other Connection users—such as network administrators, managers,
Human Resources personnel, and facilities managers—may need to send system broadcast messages to
announce planned network outages, organization-wide goals and personnel changes, branch office
closures for holidays, security alerts, and the like.

After you have set up a way for users to access the Broadcast Message Administrator, you can enable
users to use it to send or update system broadcast messages by doing the applicable procedure in this
section:

e To Enable Sending and Updating of Broadcast Messages for an Individual User or Template,
page 4-33

¢ To Enable Sending and Updating of Broadcast Messages for Multiple User Accounts at Once,
page 4-33

For more information on broadcast messages, and to learn how to enable users to access the Broadcast
Administrator, see the “Setting Up Broadcast Messaging” chapter of the System Administration Guide
for Cisco Unity Connection.

To Enable Sending and Updating of Broadcast Messages for an Individual User or Template
In Cisco Unity Connection Administration, find the user account or template that you want to edit.

On the Edit menu, click Send Message Settings.
On the Send Message Settings page, under Broadcast Messages, check the applicable check boxes:

User Can Send Broadcast Messagesto | Check this check box to allow users to send system broadcast
Users on This Server messages to all users on the local Connection server.

User Can Update Broadcast Messages | Check this check box to allow users to edit system broadcast
Stored on This Server messages stored on the local Connection server.

We recommend that you check both check boxes so that the sender of a broadcast message is also able
to update the message.

Click Save.

To Enable Sending and Updating of Broadcast Messages for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Message Send tab.

Check the applicable check boxes, and then click Yes in the adjacent lists:

User Can Send Broadcast Messagesto  |Check this check box to allow users to send system broadcast
Users on This Server messages to all users on the local Connection server.

User Can Update Broadcast Messages | Check this check box to allow users to edit system broadcast
Stored on This Server messages stored on the local Connection server.
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We recommend that you check both check boxes so that the sender of a broadcast message is also able
to update the message.

Step 6 Click Next, and then click Finish.

Addressing by Spelling Name or Entering Extension With Touchtone
Conversations

Cisco Unity Connection provides two ways for users to address messages to other users when they are
using phone keypad keys:

e Spell a user name.
e Enter a user extension.

As they address messages by phone, users can always switch between addressing by name and
addressing by extension by pressing the # key twice, unless spelled name searches are disabled for the
system. When the Disable Spelled Name Searches check box is checked on the System Settings >
Advanced > Conversations page, users can address messages by phone only by entering user extensions.

Do the following procedure for user accounts, or for a template that you can use to create user accounts.
Users can also use the Cisco Unity Assistant to change message addressing settings.

To Change Message Addressing Settings

Step 1 In Cisco Unity Connection Administration, find the user account or template that you want to edit.
Step2  On the Edit Menu, click Send Message Settings.

Step3  On the Send Message Settings page, under Message Addressing and Sending, click a setting in the Enter
a Recipient By list to select how the conversation prompts users to address messages to other users:

¢ Spelling the Last Name Then First Name

¢ Entering the Extension

e Spelling the First Name Then Last Name
Step4  Click Save.

Prompting Users to Confirm Recipients by Name

By default, when users send, forward, or reply to messages by phone, Cisco Unity Connection does not
ask them to confirm each recipient that they add—even when they address a message by entering user
extensions. For users who prefer that Connection confirm each recipient by name (regardless of how they
add the recipient), you can specify that Connection announces “<user name> added” after each recipient
is added.

Do the following procedure for user accounts, or for a template that you can use to create user accounts.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



| Chapter4

Setting Up Features and Functionality That Are Controlled by User Account Settings

Step 1
Step 2
Step 3
Step 4

Message Addressing and Sending Options ||

To Specify That Cisco Unity Connection Prompts Users to Confirm Recipients by Name

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Send Message Settings.

On the Send Message Settings page, check the Confirm Recipient by Name check box.

Click Save.

Prompting Users to Continue Addressing

Step 1
Step 2
Step 3

Step 4

By default, when users address messages by phone (or when forwarding a message), Cisco Unity
Connection allows them to add a single recipient and then prompts them to indicate what they want to
do next (“To add another recipient, press 1. For message options, press 3. To record, press #.”). Users
who send and forward messages to multiple recipients may find pressing 1 to continue addressing after
each recipient tedious and time-consuming. If this is an issue for users in your organization, you can
specify that Connection instead allows users to continue adding names after each recipient. In this way,
you can streamline the addressing process when users send and forward messages to multiple recipients,
which may be a welcome change for those who routinely send messages to more than one recipient.

However, if you make the change, consider that when users address messages to single recipients, they
are now required to press an additional key to send a message in the following situations:

e When users forward messages to single recipients rather than multiple recipients, they are required
to press one additional key.

e When users send messages to single recipients and Connection is set up to prompt them to record
messages before addressing them, they are required to press one additional key.

To specify that Connection prompts users to continue addressing, do the following procedure for user
accounts, or for a template that you can use to create user accounts.

To Specify That Cisco Unity Connection Prompts Users to Continue Addressing

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Send Message Settings.

On the Send Message Settings page, check or uncheck the Continue Adding Names After Each
Recipient check box, depending on how you want to change the setting, as shown in the following table.

Check Box Not When addressing messages, Connection prompts users to indicate with a key press
Checked what they want to do next after adding a recipient.

This is the default setting.

Check Box Streamlined message addressing is enabled. Users are able to enter recipient names
Checked or extensions (as applicable) until they indicate that they have completed addressing.
Click Save.
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Specifying Whether Messages Are Sent Upon Hang-Up

You can change how Cisco Unity Connection handles messages that are interrupted by disconnected
calls while users are in the process of sending, replying to, or forwarding messages.

By default, Connection sends a message when the call is disconnected in the following circumstances:

When auserisreplyingto |As long as the message has at least one recipient and the recording is more

or sending a message than one second (1,000 milliseconds) in length. This means that Connection
sends the message even though the user may not have finished recording or

addressing the message.

When a user is As long as the message has at least one recipient. This means that Connection
forwarding a message sends the message even though the user may not have recorded an
introduction or completely addressed the message.

By adjusting the default value of the setting, you can alter Connection behavior so that Connection does
not send messages unless users have pressed # to confirm that they are ready to send the message. Thus,
if the call is disconnected before a user has a chance to confirm, Connection deletes the message rather
than sending it.

Note  This setting does not apply to messages left by outside callers.

To Specify Whether Messages Are Sent Upon Hang-Up

Step 1 In Cisco Unity Connection Administration, find the user account or template that you want to edit.
Step2  On the Edit Menu, click Send Message Settings.

Step3  On the Send Message Settings page, in the When a Call Is Disconnected or the User Hangs Up field,
click Send Message or Discard Message depending on the desired behavior.

Step4  Click Save.

Adding Recipients to the Message Addressing Priority List

When a user attempts to address a message to a recipient by saying a name or spelling part of a name,
Cisco Unity Connection may find multiple matching names. You can configure two mechanisms that
direct Connection to prioritize certain recipients, sorting the results and offering the names with higher
weights first in the search results. Both mechanisms—a user-configurable “buddy list,” and an automatic
weighting of names based on usage—contribute to a single addressing priority list for the user. A user
may have one or both mechanisms enabled at the same time. If neither mechanism is enabled for a user,
or if the matches do not appear in the addressing priority list, Connection sorts spelled name matches by
last name (for users) or display name (for distribution lists) and presents them in alphabetical order; or
Connection sorts spoken name matches by the voice-recognition confidence level of the match.

Note that there are systemwide settings that determine how many names are stored in the addressing
priority list for each user (the default value is 100 names) and how many days before a name is
automatically removed from the list if the user has not recently addressed a message to the user (the
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default value is 90 days). For instructions, see the “Addressing Priority Lists” section in the “Changing
Conversation Settings for All Users” chapter of the System Administration Guide for Cisco Unity
Connection.

To enable users to access a setup conversation that allows them to review their addressing priority list
and add or remove names, the users must be assigned to a custom conversation, and you must use the
Custom Keypad Mapping tool to map the Addressing Priority List conversation to a key in the Message
Settings menu for that conversation. For instructions on assigning users to a custom conversation, see
the “Touchtone and Voice-Recognition Conversations” section on page 4-12. For more information on
using the Custom Keypad Mapping tool, see the “Custom Keypad Mapping Tool” chapter of the System
Administration Guide for Cisco Unity Connection.

To enable automatic usage-based weighting of names, do the applicable procedure in this section for user
accounts, or for a template that you can use to create user accounts.

e To Enable Automatically Adding Recipients to the Message Addressing Priority List for an
Individual User or Template, page 4-37

e To Enable Automatically Adding Recipients to the Message Addressing Priority List for Multiple
User Accounts at Once, page 4-37

To Enable Automatically Adding Recipients to the Message Addressing Priority List for an Individual User or
Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit Menu, click Send Message Settings.

On the Send Message Settings page, check the Automatically Add Recipients to Addressing Priority
List check box.

Click Save.

To Enable Automatically Adding Recipients to the Message Addressing Priority List for Multiple User Accounts at
Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Conversation tab.

Click the Message Send tab.

Check the Automatically Add Recipients to Addressing Priority List check box, and then click Yes
in the adjacent list.

Click Next, and then click Finish.

Message Actions

Revised May 2009
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Message actions determine how Cisco Unity Connection handles different types of messages that it
receives for a user. Connection applies the configured action for all messages of a given type that are
addressed to the user. For example, if the message action for voice messages is set to relay these types
of messages to a user at an alternate SMTP address, Connection relays all voice messages including
VPIM messages, messages that are sent from an IMAP client, and messages that are recorded and sent
by phone. By default, Connection is configured to accept each type of message, meaning that it delivers
the message to the user mailbox.

If you choose to relay voice messages to another address, you should consider the following:

¢ When messages are set to be relayed, users are no longer able to access relayed messages from the
Connection phone interface, from the Cisco Unity Inbox, or from other clients such as Phone View
or Cisco Unified Personal Communicator. However, in Connection 7.1 and later, you can use the
Accept and Relay the Message action to have Connection save a copy of the message in the local
user mailbox (where it is accessible by Connection user interfaces) and also relay a copy to another
address.

e Connection relays dispatch messages as regular messages.
e Connection does not relay broadcast messages.

e In Connection 7.1 and later, you can configure whether Connection relays private messages and
secure messages on the System Settings > Advanced > Messaging page. Private messages, if
allowed, are relayed as regular messages with the private flag; secure messages, if allowed, are
relayed as regular messages.

To configure message actions, do the applicable procedure in this section for user accounts, or for a
template that you can use to create user accounts.

e To Configure Message Actions for an Individual User or Template, page 4-38

e To Configure Message Actions for Multiple User Accounts at Once, page 4-39

To Configure Message Actions for an Individual User or Template

Step1  In Cisco Unity Connection Administration, find the user account or template that you want to edit.
Step2  On the Edit menu, click Message Actions.
Step3  On the Edit Message Actions page, select an action for each message type:

e Accept the Message—Connection delivers the message to the user mailbox.

¢ Reject the Message—Connection rejects the message. If possible, Connection sends a non-delivery
receipt to the sender.

¢ Relay the Message—Connection forwards the message to the address you specify in the Relay
Address field.

¢ Accept and Relay the Message (Connection 7.1 and later)—Connection delivers the message to
the user mailbox, and forwards a copy of the message to the address you specify in the Relay
Address field. Note that any actions the user takes on the relayed copy are not reflected on the
message in the Connection message store. If the user does not regularly manage new messages in
the Connection message store, the user mailbox may quickly exceed the mailbox quota because new
messages are not subject to message-aging policies.
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Note  Connection does not allow you to save the page with a relay option (either Relay the Message
or Accept and Relay the Message) selected for any message type unless you have already
configured an SMTP smart host on the System Settings > SMTP Configuration > Smart Host

page.

If you chose a relay option for any message type in Step 3, in the Relay Address field, enter an SMTP
address (for an individual user) or an SMTP address pattern (for a user template).

If you are configuring a user template, you can enter a combination of text and tokens that Connection
replaces with a value entered for the user profile when creating a user from the template. To add a token
to the Relay Address field, click the name of the token in the Replaceable Tokens list, then click the
arrow next to the Replaceable Tokens field.

Click Save.

To Configure Message Actions for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, click Users with Voice Mail, then find and select the user accounts that you want
to edit.

Click Next.
Click the Message Actions tab.
For each message type, select an action:
e Accept the Message—Connection delivers the message to the user mailbox.

¢ Reject the Message—Connection rejects the message. If possible, Connection sends a non-delivery
receipt to the sender.

¢ Relay the Message—Connection forwards the message to the address you specify in the Relay
Address field.

¢ Accept and Relay the Message (Connection 7.1 Only)—Connection delivers the message to the
user mailbox, and forwards a copy of the message to the address you specify in the Relay Address
field. Note that any actions the user takes on the relayed copy are not reflected on the message in
the Connection message store. If the user does not regularly manage new messages in the
Connection message store, the user mailbox may quickly exceed the mailbox quota because new
messages are not subject to message-aging policies.

Note  Connection will log an error and the update will fail if you choose a relay option (either Relay
the Message or Accept and Relay the Message) for any message type unless you have already
configured an SMTP smart host on the System Settings > SMTP Configuration > Smart Host

page.

If you chose a relay option for any message type in Step 5, enter an SMTP address pattern. You can enter
a combination of text and tokens that Connection replaces with a value from the user profile. (For
example, Connection replaces %Alias% with the alias from each user profile when editing the
corresponding user.) To add a token to the Relay Address field, click the name of the token in the
Replaceable Tokens list, then click the arrow next to the Replaceable Tokens field.
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Step 7 Click Next, and then click Finish.

Greetings

Users can have up to seven greetings, which they can enable and record in the Cisco Unity Assistant and
by phone. The greeting settings in Cisco Unity Connection Administration for the user account allow
you to specify which greetings are enabled, how long they are enabled, the greeting source, and the
actions that Cisco Unity Connection takes during and after each greeting.

When a greeting is enabled, Connection plays the greeting in the applicable situation until the specified
date and time arrives, and then the greeting is automatically disabled. A greeting can also be enabled to
play indefinitely, which is useful for busy or closed greetings, or when an alternate greeting is enabled
by a user during a leave of absence. Note that schedules affect when some greetings play and some
greetings override other greetings when they are enabled.

To learn more about user greetings and options you can specify, see the following sections:

Types of User Greetings, page 4-40

Allowing Caller Input During Greetings, page 4-41

Enabling Callers to Transfer From User Greetings to an Alternate Contact Number, page 4-44
Alternate Greeting Notification Prompt, page 4-46

Enabling a User Greeting, page 4-46

Managing Calls to Users Who Have the Alternate Greeting Enabled, page 4-47

Recording Greetings in Multiple Languages, page 4-48

Class of service settings allow you to specify the maximum recording length for user greetings. See the
“Greeting Length” section on page 5-5 for details.

Types of User Greetings

Cisco Unity Connection offers the following greetings:

Standard Plays at all times unless overridden by another greeting. You cannot disable the

standard greeting.

Standard greetings play according to the days and times that you specify for the
standard schedule.

Closed Plays during the closed (nonbusiness) hours defined for the active schedule. A closed

greeting overrides the standard greeting, and thus limits the standard greeting to the
open hours defined for the active schedule.

Closed user greetings play according to the days and times that you specify for the
closed schedule.
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Holiday Plays during the dates and times specified in the schedule of holidays that is associated
with the active schedule. A holiday greeting overrides the standard and closed
greetings.

Holiday greetings play according to the dates and times you specify for holiday
schedules.

Internal Plays to internal callers only. It can provide information that only coworkers need to
know. (For example, “I will be in the lab all afternoon.”) An internal greeting overrides
the standard, closed, and holiday greetings.

Not all phone system integrations provide the support necessary for an internal

greeting.

Busy Plays when the extension is busy. (For example, “All of our operators are with other
customers.”) A busy greeting overrides the standard, closed, internal, and holiday
greetings.

Not all phone system integrations provide the support necessary for a busy greeting.

Alternate Can be used for a variety of special situations, such as vacations or a leave of absence.
(For example, “I will be out of the office until....”) An alternate greeting overrides all
other greetings.

Error Plays if the caller enters invalid digits. You cannot disable the error greeting.

The system default error recording is, “I did not recognize that as a valid entry.” By
default, after the error greeting plays, Connection replays the greeting that was
playing when the caller entered the invalid digits.

Allowing Caller Input During Greetings

Caller input settings define actions that Cisco Unity Connection takes in response to phone keypad keys
pressed by callers during a user greeting. For each greeting that allows caller input, you can specify
whether callers can skip the greeting, record a message, exit the greeting, transfer to numbers that are
not associated with users or call handlers, or transfer to an alternate contact number, call handler,
directory handler, or interview handler of your choice. You also use caller input settings to specify which
keys users can press to interrupt a user greeting so that they can log on to Connection.

Only administrators can change caller input settings; users cannot change caller input for a greeting, nor
can they specify what Connection does when callers press specific keys; however, the greeting that
mentions the key presses that are available to callers can be recorded either by the user or the
administrator. (For example, “I am unable to take your call right now. To speak to my assistant, press 3.
To leave a message, press 4. To speak to a sales representative, press 5.”)

By default, for each user greeting, Connection acts on certain keys and ignores others. Table 4-2 lists the
default actions assigned to phone keypad keys.

Table 4-2 Default Actions Assigned to Phone Keypad Keys

When Callers Press This Key Cisco Unity Connection Does This

# Skips the greeting.

* Prompts the caller to log on.

0 Sends the caller to the Operator call handler.
1 through 9 Ignores the caller.
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Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts.

e To Specify What Cisco Unity Connection Does When Callers Press Keys During a Greeting for an
Individual User or Template, page 4-42

e To Specify What Cisco Unity Connection Does When Callers Press Keys During a Greeting for
Multiple User Accounts at Once, page 4-43

Assigning a key to transfer to an alternate contact number involves additional considerations. For
instructions on setting user greetings to allow callers to transfer to an alternate contact number, see the
“Enabling Callers to Transfer From User Greetings to an Alternate Contact Number” section on

page 4-44.

To Specify What Cisco Unity Connection Does When Callers Press Keys During a Greeting for an Individual User
or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Caller Input.
On the Caller Input page, click the applicable phone keypad key in the Caller Input Keys table.

On the Edit Caller Input page for the key that you have selected, check the Ignore Additional Input
(Locked) check box to instruct Connection to immediately process the key without waiting for the caller
to enter additional digits.

N

Note  Verify that the phone keypad key you select to lock is not the first digit of any of the extensions
in your system. If it is, locking the key prevents callers from dialing an extension.

Choose the action that Connection takes when the caller presses the applicable key:

Call Action Select the applicable action from the list. When Hang Up is selected,
Cisco Unity Connection immediately terminates the call when the caller
presses the applicable key.

Call Handler Sends the call to the system call handler that you specify. Specify whether
the call should transfer to the call handler extension or go directly to the
greeting of the handler.

Interview Handler Sends the call to the interview handler that you specify.

Directory Handler Sends the call to the directory handler that you specify.

Conversation Sends the call to the conversation that you specify.

User with Mailbox Sends the call to the user that you specify. Specify whether the call should

transfer to the user extension or go directly to the greeting of the user.

Repeat Step 3 through Step 5 for additional keys, as needed.
Click Save.
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On each applicable Greetings page for the user or template, confirm that the Ignore Caller Input check
box is not checked. (By default, the Ignore Caller Input check box is not checked.)

To Specify What Cisco Unity Connection Does When Callers Press Keys During a Greeting for Multiple User
Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Caller Input tab.

Click the applicable phone keypad key tab.

To instruct Connection to immediately process the key without waiting for the caller to enter additional
digits, check the Ignore Additional Input (Locked) check box, and then click Yes in the adjacent list.

~

Note  Verify that the phone keypad key you select to lock is not the first digit of any of the extensions
in your system. If it is, locking the key prevents callers from dialing an extension.

Check the Make Changes to Menu Entry Action check box.

Choose the action that Connection takes when the caller presses the applicable key:

Call Action Select the applicable action from the list. When Hang Up is selected,
Cisco Unity Connection immediately terminates the call when the caller
presses the applicable key.

Call Handler Sends the call to the system call handler that you specify. Specify whether
the call should transfer to the call handler extension or go directly to the
greeting of the handler.

Interview Handler Sends the call to the interview handler that you specify.

Directory Handler Sends the call to the directory handler that you specify.

Conversation Sends the call to the conversation that you specify.

User with Mailbox Sends the call to the user that you specify. Specify whether the call should

transfer to the user extension or go directly to the greeting of the user.

Repeat Step 5 through Step 8 for additional keys, as needed.

On each applicable Greetings tab, check the Ignore Caller Input check box, and then click No in the
adjacent list.

Click Next, and then click Finish.
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Enabling Callers to Transfer From User Greetings to an Alternate Contact
Number

As a convenience to callers, you can set up Cisco Unity Connection so that callers can transfer to an
alternate contact number by pressing a key during the greetings for a particular user or a group of users.
An alternate contact number can be the extension for an operator or another user (such as a supervisor
or coworker), or any other number where the user or another person can be reached. For each user, you
can configure up to 12 alternate contact numbers (one for each key on the phone keypad). When
transferring a caller to an alternate contact number, Connection releases the call to the phone system.

You can use Cisco Unity Connection Administration or the Bulk Edit utility to specify the keys that
callers press to transfer and the numbers that they transfer to. Users can review and specify the alternate
contact numbers by using the Connection setup options conversation. (Note that Connection presents the
option to review alternate contact numbers only if you have configured at least one key with the Transfer
to Alternate Contact Number option.) The alternate contact number is limited to the numbers allowed by
the restriction table for transfers that is associated with the user who specifies the number.

When you enable the feature, you may want to specify the keys that can be used to make the transfer and
leave the alternate contact number unspecified, so that users can specify the number themselves. Until
an alternate contact number is specified, Connection ignores the key set to transfer the call if callers
happen to press it during a user greeting. Let users know if there are trunk access codes or special number
formatting that they should use when configuring alternate contact numbers.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts:

e To Enable Callers to Transfer From User Greetings to an Alternate Contact Number for an
Individual User or Template, page 4-44

¢ To Enable Callers to Transfer From User Greetings to an Alternate Contact Number for an Multiple
User Accounts at Once, page 4-45

To Enable Callers to Transfer From User Greetings to an Alternate Contact Number for an Individual User or
Template

Step 1 In Cisco Unity Connection Administration, find the user account or template that you want to edit.
Step2  On the Edit menu, click Caller Input.
Step3  On the Caller Input page, click the applicable phone keypad key in the Caller Input Keys table.

Step4  On the Edit Caller Input page for the key that you have selected, check the Ignore Additional Input
(Locked) check box to instruct Connection to immediately process the key without waiting for the caller
to enter additional digits.

N

Note Verify that the phone keypad key you select to lock is not the first digit of any of the extensions
in your system. If it is, locking the key prevents callers from dialing an extension.

Step 5 In the action section, click Call Action and then select Transfer to Alternate Contact Number.

Step6 In the Extension field, enter digits O through 9 to specify an alternate contact number up to 30 digits in
length. You can also enter:

e , (comma) to insert a one-second pause.

e #and * to correspond to the # and * keys on the phone.
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Do not use spaces, dashes, or parentheses between digits. Begin with an access code if one is needed to
make an external call (for example, 9). For long-distance numbers, also include 1 and the area code.

Enter a description for the alternate contact number, if applicable.
Repeat Step 3 through Step 5 for additional keys, as needed.
Click Save.

On each applicable Greetings page for the user or template, confirm that the Ignore Caller Input check
box is not checked. (By default, the Ignore Caller Input check box is not checked.)

To Enable Callers to Transfer From User Greetings to an Alternate Contact Number for an Multiple User Accounts
at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Caller Input tab.

Click the applicable phone keypad key tab.

To instruct Connection to immediately process the key without waiting for the caller to enter additional
digits, check the Ignore Additional Input (Locked) check box, and then click Yes in the adjacent list.

N,

Note Verify that the phone keypad key you select to lock is not the first digit of any of the extensions
in your system. If it is, locking the key prevents callers from dialing an extension.

Check the Make Changes to Menu Entry Action check box.
Click Call Action, then select Transfer to Alternate Contact Number.

In the Extension field, enter digits O through 9 to specify an alternate contact number up to 30 digits in
length. You can also enter:

e , (comma) to insert a one-second pause.
e #and * to correspond to the # and * keys on the phone.

Do not use spaces, dashes, or parentheses between digits. Begin with an access code if one is needed to
make an external call (for example, 9). For long-distance numbers, also include 1 and the area code.

Enter a description for the alternate contact number, if applicable.
Repeat Step 5 through Step 8 for additional keys, as needed.

On each applicable Greetings tab, check the Ignore Caller Input check box, and then click No in the
adjacent list.

Click Next, and then click Finish.
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Alternate Greeting Notification Prompt

Note

Step 1
Step 2
Step 3

Step 4

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

You can enable Cisco Unity Connection to play a prompt to remind the user when an alternate greeting
is enabled. The prompt plays immediately after the user logs on by phone. After playing the reminder,
Connection then plays a menu from which users can choose to leave their alternate greeting on, turn it
off, or play it.

The Cisco Personal Communications Assistant automatically displays a reminder when users have their
alternate greeting turned on, and indicates which caller options you enabled for them.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. Note that the alternate greeting does not have to be enabled to do the procedures.

e To Enable the Alternate Greeting Notification Prompt for an Individual User or Template, page 4-46
e To Enable the Alternate Greeting Notification Prompt for Multiple User Accounts at Once,
page 4-46

To Enable the Alternate Greeting Notification Prompt for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Phone Menu.

On the Edit Phone Menu page, under After Logon Play, check the Alternate Greeting Notification
check box.

Click Save.

To Enable the Alternate Greeting Notification Prompt for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Profile tab.

On the Profile tab, check the Warn User That Alternate Greeting Is Enabled check box, and then click
Yes in the adjacent list.

Click Next, and then click Finish.

Enabling a User Greeting

You enable user greetings by checking the applicable check box on the Greetings page for the user
account or template. Alternatively, in the Bulk Edit utility, you can enable greetings for multiple users
at once on the applicable Greeting tab.

Note that you can record a greeting and set up greeting options without enabling the greeting.
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Managing Calls to Users Who Have the Alternate Greeting Enabled

Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1
Step 2
Step 3
Step 4
Step 5

You can customize how Cisco Unity Connection handles calls to a user who has enabled the alternate
greeting. For example, you can specify that for as long as the alternate greeting is enabled, Connection:

e Transfers callers to the greeting without ringing the user extension when calls are transferred from
the automated attendant or a directory handler to the user extension. (The phone rings if an outside
caller or another Connection user dials a user extension directly.) This option is particularly
well-received by users who share a phone.

e Prevents all callers from skipping the greeting. In this way, you can increase caller awareness of a
user absence.

e Prevents all callers from leaving messages. By specifying that Connection prevents all callers from
leaving messages, you can help reduce mailbox size when a user is out of the office and does not
plan to check messages regularly.

None of the above options apply when other Connection users use the Connection conversation (“Press 2
to send a message”) or another Connection client application to send a message to a user.

As applicable, do the procedures in this section for user accounts, or for a template that you can use to
create user accounts. Note that the alternate greeting does not have to be enabled to set caller options.

e To Specify Alternate Greeting Caller Options for an Individual User or Template, page 4-47
e To Specify Alternate Greeting Caller Options for Multiple User Accounts at Once, page 4-47

To Specify Alternate Greeting Caller Options for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Greetings.
On the Greetings page, click Alternate.

On the Edit Alternate Greetings page, under Caller Options, check or uncheck any or all of the following
check boxes to specify how Connection handles calls to a user who has enabled the alternate greeting:

e Transfer Callers to Greeting Without Ringing User’s Phone
e Prevent Callers From Skipping the User’s Greeting
e Prevent Callers From Leaving Messages

Click Save.

To Specify Alternate Greeting Caller Options for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Greetings tab.

On the Alternate tab, check or uncheck any or all of the following check boxes and click Yes or No (as
applicable) in the adjacent lists:
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e Transfer Callers to Greeting Without Ringing User’s Phone
e Prevent Callers From Skipping the User’s Greeting
e Prevent Callers From Leaving Messages

Step 6 Click Next, and then click Finish.

Recording Greetings in Multiple Languages

With a Cisco Unity Connection multilingual system, you can give users the option of providing greetings
in multiple languages when the greeting language for the primary call handler of the user is inherited.
For example, if Connection is set up to provide prompts in French and Spanish, it is possible to record
the standard greeting in both languages so that Spanish- and French-speaking callers can hear the
greeting in their own language.

To enable this option for an individual user or a template, select the Language Callers Hear: Inherit
Language From Caller setting on the Edit Message Settings page.

If a greeting is not recorded in a language that the system provides, Connection plays the system default
greeting for calls that are associated with that greeting. Note that this feature is not available with the
voice-recognition conversation.

Notification Devices

Cisco Unity Connection can be configured to call a phone or pager or send text or SMS messages to
notify users of new messages and calendar events. You configure the parameters for the call or
notification message, the events that trigger the notification, and the schedule on which the notification
occurs by setting up notification devices.

Connection includes a number of default notification devices. Administrators can add, configure, or
delete notification devices by using Cisco Unity Connection Administration. Users can enable or disable
notification devices and configure some of the device settings, the events that trigger the notification,
and the schedule for the notification in Cisco Unity Assistant. Administrators and users can also
configure multiple notification devices to work together to either cascade or chain message notifications.

See the following topics for details and procedures:
e Phone and Pager Notification Devices, page 4-48
e SMS-Compatible Notification Devices, page 4-50
e SMTP-Compatible Notification Devices, page 4-52
e Cascading Message Notification, page 4-54
e Chaining Message Notification, page 4-55

Phone and Pager Notification Devices

Cisco Unity Connection can notify a user of new messages by calling a phone or pager. Message
notification settings for each user account allow you to control how and when Connection notifies a user
of new messages.
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By default, users and user templates include notification devices for a home phone, mobile phone, work
phone, and one pager. You can modify the default devices and enable or disable them, but you cannot
delete them. You can also add, modify, or delete additional notification devices.

Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. You must set up notification devices to receive notifications individually for a user or template;
later, you can use Bulk Edit to enable or disable a device and/or to change some settings for multiple
users.

e To Set Up a Phone and/or Pager to Receive Message Notifications for an Individual User or
Template, page 4-49

e To Change Phone or Pager Notification Devices for Multiple User Accounts at Once, page 4-50

Users can also use the Cisco Unity Assistant to set up phones and pagers to receive message
notifications.

To Set Up a Phone and/or Pager to Receive Message Notifications for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Notification Devices.

On the Notification Devices page, click the applicable device in the Display Name list.

On the Edit Notification Device page, check the Enabled check box.

Under Notification Rule Events, check the applicable check boxes for each type of message that should
trigger the notification:

All Messages Connection calls this device when any new message is received, including
dispatch and other voice messages, and fax messages.

Dispatch Messages Connection calls this device when any new voice message is received that is
marked as a dispatch message.

All Voice Messages Connection calls this device when any new voice message is received
(including dispatch messages).

Fax Messages Connection calls this device when any new fax message is received.

For each event type that you chose in Step 5, check the Urgent Only check box to have Connection send
the notification only when the new message of that type is marked urgent.

In the Phone Number field, enter the phone number of the phone or pager, beginning with any access
code needed to make an external call (for example, 9). Use digits 0 through 9. Do not use spaces, dashes,
or parentheses between digits. For long-distance numbers, also include 1 and the area code. You can also
enter:

e , (comma) to insert a one-second pause.
e #and * to correspond to the # and * keys on the phone.

Depending on how Connection is set up, you may not be able to enter certain phone numbers or your
phone system may require additional characters.

In the Extra Digits field, enter any extra digits that Connection dials after the phone number. The digits
could be a password or an access number that you enter to hear messages, or an ID required by a pager.
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In the Duration to Wait Before Dialing Extra Digits field, enter the number of seconds that Connection
waits after dialing the phone or pager number before it dials the extra digits. (You may need to
experiment with this setting. Try six seconds, then increase or decrease the time as needed.)

Enter other settings, as applicable.
Click Save.

Optionally, to configure additional settings for the device for an individual user, use the Related Links
field to navigate to Edit Notification Device Details. The Cisco Unity Assistant opens in another
browser window, allowing you to change the notification schedule or limit the notification to messages
sent by specific callers or phone numbers. The user can also change these settings by logging on to the
Cisco Unity Assistant.

~

Note  The Related Links field appears in the upper right corner of the Administration window. Click
the applicable link name, and then click Go.

To Change Phone or Pager Notification Devices for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, click Users with Voice Mailboxes, then find the user accounts that you want to
edit.

Click Next.
Click the Notification tab.
Click the applicable tab for the device you want to change.

~

Note Only the default notification devices can be edited in Bulk Edit. The default phone or pager
devices are Home Phone, Work Phone, Pager, and Mobile Phone.

Check or uncheck the Disable Device check box, as applicable.
Check the Phone System check box, and then click the phone system in the adjacent list.

Check the Notification Event check box, and then click the applicable options in the adjacent Voice
Messages and Fax Messages lists.

Repeat Step 5 through Step 8 for any additional devices.
Click Next, and then click Finish.

SMS-Compatible Notification Devices

Revised May 2009

When you have enabled Cisco Unity Connection to use SMPP for message notifications, you can enable
users to receive the notifications on their mobile phones and other SMS-compatible devices when they
receive a new voice, email, or fax message. Message notification settings for each user account allow
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you to control how and when Connection notifies a user of new messages. When a message arrives that
matches the criteria selected in the message notification settings, the Connection Messaging System
sends a text message entered by you or the user, such as “Urgent message for Technical Support.”

To enable users to receive SMS message notifications, first do the “To Set Up an SMS (SMPP) Message
Notification Device” procedure on page 4-51. After you set up an SMS device to communicate with
Connection, you can enable the device to receive notifications by doing the “To Enable an
SMS-Compatible Device to Receive Message Notifications” procedure on page 4-51, or you can tell
users to do so in the Cisco Unity Assistant.

To learn how to enable Connection to use SMPP for message notification, see the “Setting Up SMTP and
SMS (SMPP) Message Notifications” chapter of the System Administration Guide for Cisco Unity
Connection.

To Set Up an SMS (SMPP) Message Notification Device

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Notification Devices.

On the Notification Devices page, if an SMS device exists, click the name of the device and skip to
Step 5.

If an SMS device is not listed, click Add New, then continue with Step 4.

On the New Notification Device page, in the Notification Device Type list, click SMS. Note that SMS
is not listed as a device type until at least one SMPP provider has been configured.

Enter or modify the display name for the device, as applicable.
In the SMPP Provider field, click the name of the service provider.
In the To field, enter the phone number of the SMS-compatible device.

~

Note  Most SMSCs require that the phone number be entered in international format, which means
omitting the + and 00, but including the country code and area code. For example, in the United
States, 1 206 555 1234 would be formatted correctly.

Enter additional settings, as applicable.
Click Save.

Continue with the following “To Enable an SMS-Compatible Device to Receive Message Notifications”
procedure to enable SMS (SMPP) notifications for the user.

Alternatively, users can set up devices themselves in the Cisco Unity Assistant.

To Enable an SMS-Compatible Device to Receive Message Notifications

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Notification Devices.

On the Notification Devices page, click the display name of the SMS Device you set up in the preceding
“To Set Up an SMS (SMPP) Message Notification Device” procedure.

On the Edit Notification Device page, check the Enabled check box.
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Step5  Under Notification Rule Events, check the applicable check boxes for each type of message or event that
should trigger the notification:

All Messages Connection sends a notification to this device when any new message is
received, including dispatch and other voice messages, and fax messages.

Dispatch Messages Connection sends a notification to this device when any new voice
message is received that is marked as a dispatch message.

All Voice Messages Connection sends a notification to this device when any new voice
message is received (including dispatch messages).

Fax Messages Connection sends a notification to this device when any new fax message
is received.

Calendar Appointments Connection sends a notification to this device for an upcoming Outlook
appointment.

Calendar Meetings Connection sends a notification to this device for an upcoming Cisco

Unified MeetingPlace or Cisco Unified MeetingPlace Express meeting.

Step6  For each message type that you chose in Step 5, check the Urgent Only check box to have Connection
send the notification only when the new message of that type is marked urgent.

Step7  Change other settings on the page, as applicable. For example, you may want to set parameters to control
whether and how often a notification is repeated.

Step8  Click Save.

Step9  Optionally, to configure additional settings for the device for an individual user, use the Related Links
field to navigate to Edit Notification Device Details. The Cisco Unity Assistant opens in another
browser window, allowing you to change the notification schedule or limit the notification to messages
sent by specific callers or phone numbers. The user can also change these settings by logging on to the
Cisco Unity Assistant.

~

Note  The Related Links field appears in the upper right corner of the Administration window. Click
the applicable link name, and then click Go.

SMTP-Compatible Notification Devices

Revised May 2009

When you have enabled Cisco Unity Connection to use SMTP for message notifications, you can enable
users to receive message notifications at an email address, on their text pagers and on text-compatible
mobile phones by using SMTP. Message notification settings for each user account allow you to control
how and when Connection notifies a user of new messages. When a message arrives that matches the
criteria set in the message notification settings, the Connection Messaging System sends a text message
entered by you or the user, such as “Urgent message for Technical Support.”

To learn how to enable Connection to use SMTP for message notification, see the “Setting Up SMTP
and SMS (SMPP) Message Notifications” chapter of the System Administration Guide for Cisco Unity
Connection.
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If the Connection server has not been properly enabled to use SMTP for message notification,
Connection places SMTP notification messages in the Connection SMTP server badmail folder.

By default, users and user templates include a single SMTP notification device. You can modify the
default device, including enabling or disabling it, but you cannot delete it. You can also add, modify, or
delete additional SMTP notification devices.

Do the procedures in this section for user accounts, or for a template that you can use to create user
accounts. You must set up notification devices to receive notifications individually for a user or template.
After setting up the default SMTP notification device, you can use Bulk Edit to enable or disable this
device or to change some settings on this device for multiple users.

¢ To Enable an SMTP-Compatible Device to Receive Message Notifications for an Individual User or
Template, page 4-53

e To Change the Default SMTP Notification Device for Multiple User Accounts at Once, page 4-54

Users can also use the Cisco Unity Assistant to set up SMTP devices to receive message notifications.

To Enable an SMTP-Compatible Device to Receive Message Notifications for an Individual User or Template

In Cisco Unity Connection Administration, find the user account or template that you want to edit.
On the Edit menu, click Notification Devices.

On the Notification Devices page, in the Display Name list, click SMTP.

On the Edit Notification Device (SMTP) page, check the Enabled check box.

Under Notification Rule Events, check the applicable check boxes for each type of message or event that
should trigger the notification:

All Messages Connection sends a notification to this device when any new message is
received, including dispatch and other voice messages, and fax messages.

Dispatch Messages Connection sends a notification to this device when any new voice
message is received that is marked as a dispatch message.

All Voice Messages Connection sends a notification to this device when any new voice
message is received (including dispatch messages).

Fax Messages Connection sends a notification to this device when any new fax message
is received.

Calendar Appointments Connection sends a notification to this device for an upcoming Outlook
appointment.

Calendar Meetings Connection sends a notification to this device for an upcoming Cisco

Unified MeetingPlace or Cisco Unified MeetingPlace Express meeting.

For each message type that you chose in Step 5, check the Urgent Only check box to have Connection
send the notification only when the new message of that type is marked urgent.

In the To field, enter the email address of the user text pager, mobile device, or other email address.

In the From field, enter the phone number that the user calls to check messages.
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If the notifications will be delivered to a device that supports web browsing, check the Include a Link
to Cisco PCA in Message Text check box so that the user can click the link to open the Cisco PCA and
listen to the message.

Enter other settings, as applicable.
Click Save.

Optionally, to configure additional settings for the device for an individual user, use the Related Links
field to navigate to Edit Notification Device Details. The Cisco Unity Assistant opens in another
browser window, allowing you to change the notification schedule or limit the notification to messages
sent by specific callers or phone numbers. The user can also change these settings by logging on to the
Cisco Unity Assistant.

~

Note  The Related Links field appears in the upper right corner of the Administration window. Click
the applicable link name, and then click Go.

To Change the Default SMTP Notification Device for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, click Users with Voice Mailboxes, then find the user accounts that you want to
edit.

Click Next.
Click the Notification tab.
Click the SMTP tab.

~

Note  Only the default SMTP notification device can be edited in Bulk Edit.

Check or uncheck the Disable Device check box as applicable.
Check the Phone System check box, and then click the phone system in the adjacent list.

Check the Notification Event check box, and then click the applicable options in the adjacent Voice
Messages, Fax Messages, Calendar Appointments, and Calendar Meetings lists.

Repeat Step 5 through Step 8 for any additional devices.
Click Next, and then click Finish.

Cascading Message Notification

Cascading message notification allows you to send notifications to a widening circle of recipients.
Cisco Unity Connection continues to send notifications according to the devices you selected until the
message has been saved or deleted by a recipient.

For example, to create a cascade of message notifications for your Technical Support department, set the
first message notification to be sent immediately to the pager of the front-line technical support
representative. If the message that triggered the first notification has not been saved or deleted after a
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delay of 15 minutes, the next notification can be sent to the pager of the department manager. A third
notification can be set up to call an employee in the Problem Resolution Group if the message is not
saved or deleted after 30 minutes, and so on.

Note that when a user receives a notification as part of the cascade, the notification prompts the user to
log on to the mailbox that is being monitored by the cascade.

An alternative to cascading message notification is to use dispatch messaging. For details, see the
“Dispatch Messages” section in the “Messaging” chapter of the System Administration Guide for
Cisco Unity Connection.

To Set Up Cascading Message Notification

In Cisco Unity Connection Administration, find the user account whose mailbox you want to monitor
with a cascading notification.

On the Edit menu, click Notification Devices.

On the Notification Devices page, select a notification device and enter the applicable settings so that it
notifies a person in the recipient list for the cascading notification. For example, for the first recipient,
you would enter the phone number for the pager that belongs to the front-line technical support
representative.

In the Delay Before First Notification Attempt field, enter the desired delay for the device, in minutes.

Space notifications between each device at regular intervals, such as every 15 minutes. For the first
device you set up, consider specifying 0 as the delay so that the first recipient receives the notification
immediately. For the device of the second recipient, specify 15 minutes. Specify 30 minutes for the
device of the next recipient, and so on.

If the notification device is a pager or phone, choose a value for the Phone System field such that
Connection can dial out to the phone number of the user who receives the notification; this is not
necessarily the same phone system used by the user whose mailbox is being monitored as part of the
cascade.

Click Save.

Repeat Step 2 through Step 6 to set up another device for the next person on the recipient list for the
cascading notification. Note that in order for the cascading notification to work properly, the same
Notification Rule Events check boxes must be checked on all of the devices in the cascade.

Chaining Message Notification

Step 1
Step 2

Message notification can be set to “chain” to a series of notification devices if an attempt to send
notification to the first selected device fails. The definition of failure to a notification device is based on
the options you select for retrying a device that is not answered or is busy.

Do not configure SMTP devices for chaining message notification, except as the last device in the chain;
Connection does not detect notification failure for SMTP devices.

To Set Up Chaining Message Notification

In Cisco Unity Connection Administration, find the user account or template that you want to edit.

On the Edit menu, click Notification Devices.
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Step3  On the Notification Devices page, click the notification device that you want Connection to contact first.

Step 4 Enter settings for this device, as applicable. For On Notification Failure, click Send To, and click the
device that you want Connection to notify next if notification to this device fails.

Step 5 On the Edit menu, click Notification Devices again.
Step6  Click the device that you specified for Send To in Step 4.
Step7  Enter settings for this device, as applicable. Note the following:

e Uncheck all Notification Rule Events check boxes. If you enable any notification events, message
notification for this device starts immediately and does not wait for the notification failure of the
previous device. Your notifications will not chain, they will all trigger at once.

e If you want to chain to a third device if notification to this device fails, click Send To, and click the
device that you want Connection to notify next if notification to this device fails. If not, click Do
Nothing.

Step8  If you want to chain additional devices:
a. On the Edit menu, click Notification Devices again.
b. Click the device that you specified for Send To for the previous device.
c. Enter settings for that device as described in Step 7.

Step9  Click Save.

Alternate Extensions

In addition to the primary extension for each user, you can set up alternate extensions. Alternate
extensions can be used for various reasons, such as handling multiple line appearances on user phones.
Alternate extensions can also make calling Cisco Unity Connection from an alternate device—such as a
mobile phone, a home phone, or a phone at another work site—more convenient.

When you specify the phone number for an alternative extension, Connection handles all calls from that
number in the same way that it handles calls from a primary extension (assuming that ANT or caller ID
is passed along to Connection from the phone system). This means that Connection associates the
alternate phone number with the user account, and when a call comes from that number, Connection
prompts the user to enter a password and log on.

If users set an alternate device to forward to Connection, callers can hear the user greeting and leave
messages for the user, just as they would when dialing the primary extension of the user. (Callers can
also be transferred to the alternate extension for a user from the automated attendant.) Users need to set
forwarding from the device itself, not in Connection. Note that the phone number must be passed to
Connection for the system to recognize the device.

Users can also address messages to an alternate extension that is associated with another user.

Alternate extensions are grouped into two categories: administrator-defined alternate extensions and
user-defined alternate extensions. Administrators can add up to 9 alternate extensions. Users can add up
to 10 alternate extensions if they belong to a class of service that allows them to manage user-defined
alternate extensions. Administrators can view and edit both administrator-defined and user-defined
alternate extensions. Users can view administrator-defined alternate extensions if they belong to a class
of service that allows them to.

Note that you cannot specify alternate extensions on a user template.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



| Chapter4

Setting Up Features and Functionality That Are Controlled by User Account Settings

Alternate Extensions

See the following sections:
e Adding Alternate Extensions, page 4-57
e Editing Alternate Extensions, page 4-58
e Deleting Alternate Extensions, page 4-58
e Alternate Extension Custom Settings, page 4-59

Class of service settings allow you to determine whether users can view or manage alternate extensions
and whether they can use the Cisco Unity Assistant to manage a set of their own alternate extensions.
See the “Alternate Extensions” section on page 5-2 for details.

Adding Alternate Extensions
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You can add alternate extensions by updating user accounts one at a time, or you can update multiple
user accounts at once. As applicable, do the procedures in this section. Note that you cannot add alternate
extensions on a user template.

e To Add an Alternate Extension to an Individual User Account, page 4-57
e To Add Alternate Extensions to Multiple User Accounts at Once, page 4-57

To Add an Alternate Extension to an Individual User Account

In Cisco Unity Connection Administration, find the user account for which you want to add an alternate
extension.

On the Edit menu, click Alternate Extensions.

On the Alternate Extensions page, click Add New.

On the New Alternate Extension page, in the Phone Type list, click the applicable phone.
In the Display Name field, enter a description of the alternate extension.

In the Phone Number field, enter the phone number of the alternate extension.

Click Save.

To Add Alternate Extensions to Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Alternate Extensions tab.

In the Select an Alternate Extension to Modify list, click the device for which you want to add an
alternate extension.

Follow the onscreen instructions to change the settings, as applicable.

Click Next, and then click Finish.
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You can edit existing alternate extensions by updating user accounts one at a time, or you can update
multiple user accounts at once. As applicable, do the procedures in this section. Note that you cannot
edit alternate extensions on a user template.

e To Edit an Alternate Extension for an Individual User Account, page 4-58

e To Edit Alternate Extensions for Multiple User Accounts at Once, page 4-58

To Edit an Alternate Extension for an Individual User Account

In Cisco Unity Connection Administration, find the user account for which you want to edit an alternate
extension.

On the Edit menu, click Alternate Extensions.

On the Alternate Extensions page, click the alternate extension that you want to edit.
On the Edit Alternate Extensions page, change the applicable settings.

Click Save.

To Edit Alternate Extensions for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Alternate Extensions tab.

In the Select An Alternate Extension to Modify list, click the device for which you want to change the
alternate extension.

Follow the onscreen instructions to change the applicable settings.

Click Next, and then click Finish.

Deleting Alternate Extensions

Step 1

Step 2

You can delete alternate extensions by updating user accounts one at a time. Or you can update multiple
user accounts at once. As applicable, do the procedures in this section.

e To Delete an Alternate Extension for an Individual User Account, page 4-58

e To Delete Alternate Extensions for Multiple User Accounts at Once, page 4-59

To Delete an Alternate Extension for an Individual User Account

In Cisco Unity Connection Administration, find the user account for which you want to delete an
alternate extension.

On the Edit menu, click Alternate Extensions.
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On the Alternate Extensions page, check the check boxes next to the alternate extensions that you want
to delete.

Click Delete Selected.

To Delete Alternate Extensions for Multiple User Accounts at Once

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.
In the Bulk Edit utility, find the user accounts that you want to edit.

Click Next.

Click the Alternate Extensions tab.

In the Select An Alternate Extension to Modify list, click the device for which you want to delete the
alternate extension.

For each Remove field, click 0 in the Digits list.
Confirm that the remaining fields are blank.

Click Next, and then click Finish.

Alternate Extension Custom Settings

Step 1
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There are several conversation settings that can be customized for alternate extensions. By default, each
alternate extension uses the same settings that have been configured for the primary extension of the user.
You can use custom settings for alternate extensions to base conversation settings on the phone number
that the user is calling from. For example, a user calling from a mobile phone may want to use the
voice-recognition input style and not be asked for a password. But a user calling from a work phone may
want to use the touchtone input style and be required to enter a password.

To Customize Conversation Settings for an Alternate Extension

In Cisco Unity Connection Administration, find the user account for which you want to edit an alternate
extension.

On the Edit menu, click Alternate Extensions.

On the Alternate Extensions page, click the alternate extension that you want to edit.

On the Edit Alternate Extensions page, click Show Advanced Settings.

In the Setting column, check the check boxes to the left of the settings that you want to customize.

In the Alternate Extension Value column, modify the value of the settings to the desired behavior for this
alternate extension. Click Help > This Page to see descriptions of each setting.

Click Save.
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Alternate names are different versions of a name than what is listed in the corporate directory.

Cisco Unity Connection considers these names when a caller uses voice recognition to place a call. For
example, if a caller asks Connection to dial “Mary Jameson,” which was the maiden name of Mary
Brown, Connection can reference this information and connect the caller to the correct user.

In addition to recognizing alternate names when users and outside callers use voice recognition to place
a call, Connection recognizes alternate names when callers and users use voice recognition to address
voice messages. Alternate names can be created for users, VPIM contacts, system contacts, system
distribution lists, private lists, and personal contacts.

While Connection already recognizes hundreds of common shortened names (Bill in place of William,
for example), you might want to add another version of an uncommon name, unusual nicknames, or
maiden names. You could also use alternate names to add phonetic spellings of hard-to-pronounce
names. For example, you could add “Goolay” as an alternate name for the last name “Goulet.”

From the Cisco PCA, Connection users can edit or change their alternate names, and can also create
alternate names for customers, suppliers, family members, and friends who are not included in the
Connection directory, or for private lists. Doing so makes it easier for them to dial these contacts or
address to these lists when using voice commands.

See the following procedures:
e To Add Alternate Names a User, page 4-60
e To Edit Alternate Names for a User, page 4-60

Note that you cannot add or edit alternate names on a user template, nor can you use the Bulk Edit utility
to add or edit alternate names for multiple user accounts.

To Add Alternate Names a User

Step 1 In Cisco Unity Connection Administration, find the user account that you want to edit.
Step 2 On the Edit menu, click Alternate Names.

Step 3 In the First Name and Last Name fields, enter the alternate names.

Step4  Click Add New.

Step5 Repeat Step 3 and Step 4 until all alternate names have been added.

Step6  Click Save.

To Edit Alternate Names for a User

Step 1 In Cisco Unity Connection Administration, find the user account that you want to edit.
Step 2 On the Edit menu, click Alternate Names.
Step3 Do any of the following:
e In the Edit Alternate Names fields, enter changes to the already-existing alternate names.

e If you want to delete an alternate name, check the check box next to the name, and click Delete
Selected.

e If you want to add another alternate name, in the Add New Alternate Names fields, enter an alternate
name for the user and click Add New.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



| Chapter4

Setting Up Features and Functionality That Are Controlled by User Account Settings

Step 4

Private Distribution Lists

Click Save.

Private Distribution Lists

Step 1

Step 2

Step 3

Step 4

Users can use the private distribution lists that are associated with their accounts to send voice messages
to more than one user at a time. They can set up and manage their private lists by using the Cisco Unity
Assistant or the phone. While you can also set up, manage, and delete private lists for users, the user who
owns a private list is the only person who can send voice messages to it.

Class of service settings allow you to specify the maximum number of lists available to users and the
maximum number of members that users can add to each list. See the “Private Distribution Lists” section
on page 5-9 for details.

Do the procedure in this section to manage a private list for a user. Note that you cannot specify private
lists on a user template, or for multiple user accounts at once.

To Manage a Private Distribution List for an Individual User Account

In Cisco Unity Connection Administration, find the user account for which you want to change private
distribution list settings.

On the Edit menu, click Private Distribution List. (This launches the Cisco Unity Assistant web tool
for the user.)

On the Private List page, click the applicable icon to create a new list or to change an existing one. See
Help for detailed procedures for creating a private list, changing the name of a private list, changing
members of a private list, and deleting a private list.

Click Save.

Access to Exchange Calendars and Contacts

You can integrate Cisco Unity Connection with Exchange 2007 or Exchange 2003 so that users can
review upcoming meetings and join active meetings while on the phone or while using the

Cisco Personal Communications Assistant (PCA). Users can also use the Cisco Unity Assistant web tool
to import their Exchange contacts. The contact information can then be used in rules that users create in
the Cisco Unity Personal Call Transfer Rules web tool and when users place outgoing calls by using
voice commands.

To learn how to set up both Connection and user accounts for the feature, see the “Creating Calendar
Integrations” chapter of the System Administration Guide for Cisco Unity Connection.

To learn how to assign the user account or the template to a class of service that enables them to use the
personal call transfer rules feature, see the “Personal Call Transfer Rules” section on page 5-8.

To teach users how to review upcoming meetings and join active meetings while on the phone or while
using the Cisco PCA, refer them to the User Guide for the Cisco Unity Connection Phone Interface
(Release 7.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/phone/7xcucugphonex.ht
ml.
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To teach users how to access their Exchange calendars and contacts for personal call transfer rules, refer
them to the following documents:

e User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web Tool (Release 7.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/pctr/7xcucugpctrx.ht
ml.

e The “Managing Your Personal Contacts” chapter of the User Guide for the Cisco Unity Connection
Assistant Web Tool (Release 7.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/assistant/7xcucugasst
x.html.

Cisco Unified MeetingPlace or Cisco Unified MeetingPlace

Express

If you have Cisco Unified MeetingPlace or Cisco Unified MeetingPlace Express installed, you can
integrate Cisco Unity Connection with MeetingPlace or MeetingPlace Express so that users can review
upcoming meetings and join active meetings while on the phone or while using the Cisco Personal
Communications Assistant (PCA).

To learn how to set up both Connection and user accounts for the feature, see the “Creating Calendar
Integrations” chapter of the System Administration Guide for Cisco Unity Connection.

User Access to Email in an External Message Store

Step 1
Step 2

When integrated with an external message store, Cisco Unity Connection allows touchtone and
voice-recognition conversation users to hear their emails read to them when they log on to Cisco Unity
Connection by phone. Text to Speech (TTS) playback is available provided that the text portion of the
message does not exceed 1 MB in size and the text format of the message is supported by Connection.
Supported formats include plain text, quoted-printable text, HTML, and XML.

Connection does not offer users the ability to send, reply to, or forward email messages.

To enable users to access email in an external message store, complete the following tasks in the order
presented:

1. Configure the Connection server to access email messages that are stored on the external message
store, as described in the “Configuring Access to Emails in an External Message Store” chapter of
the System Administration Guide for Cisco Unity Connection.

2. For each user, create an external service account in Connection that specifies the external message
store on which the mailbox for the user is stored. This enables the user to access their email when
they log on to Connection by phone. Do the following “To Add an External Service Account for an
Individual User to Access Email in an External Message Store” procedure.

Note that when there is no recorded name for a user, Connection uses TTS to say the user name. This is
default functionality, and does not need to be set up or enabled.

To Add an External Service Account for an Individual User to Access Email in an External Message Store

In Cisco Unity Connection Administration, find the user account or template that you want to edit.

On the Edit menu, click External Service Accounts.
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Step 3
Step 4

Step 5
Step 6

Step 7

Step 8

Step 9
Step 10
Step 11

Step 12

SMTP Proxy Addresses I

On the External Service Accounts page, click Add New.

On the New External Service Accounts page, in the External Service list, click the display name of the
external service that you set up for accessing email in an external message store.

In the Email Address field, enter the email address for the user.
In Login Type field, click the applicable option:

e Use Connection Alias—This option is useful when the User ID setting in Exchange is the same as
the Connection user alias. Connection logs on the user with the Connection user alias.

e Use User ID Provided Below—Enter the User ID setting from Exchange (useful when the User ID
setting is different from the Connection user alias). Connection logs on the user with the setting in
this field.

(Only when the Use User ID Provided Below option is selected) In the User ID field, enter the User ID
of the Exchange alias (often the same as the Active Directory user logon name) for the Exchange mailbox
that you want this Connection user to be able to access.

Enter only the Exchange alias; do not prefix the alias with the Windows domain name.

(Only for Exchange 2007) In the Password field, enter the password from Exchange. Connection logs on
the user with the setting in this field.

Under Service Capabilities, check the User Access to Email in Third-Party Message Store check box.
Click Save.

To check the Exchange configuration for the user, click Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Exchange, Connection, and the user.

Repeat Step 2 through Step 11 for each user for whom you want to enable access to email in an external
message store.

SMTP Proxy Addresses

Note

Revised May 2009

Cisco Unity Connection uses SMTP proxy addresses to map the sender of an SMTP message sent from
an IMAP client to the appropriate user, and to map each recipient to the appropriate user or VPIM
contact. For example, when Robin Smith, whose email client is configured to access Connection with
the email address robin.smith@example.com, records a voice message in ViewMail for Outlook and
sends it to chris.jones @example.com, Connection searches the list of SMTP proxy addresses for
robin.smith@example.com and chris.jones @example.com. If these addresses are defined as SMTP
proxy addresses for the user profiles of Robin Smith and Chris Jones respectively, Connection delivers
the message as a voice message from Robin Smith to Chris Jones.

See the “Configuring IMAP Settings” chapter of the System Administration Guide for Cisco Unity
Connection for instructions on configuring the Connection server, user accounts, and user workstations
for IMAP client access.

At a minimum, we recommend that you configure each user with an SMTP proxy address for the
corporate email account of the user.
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Il SMTP Proxy Addresses

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

You can add proxy addresses for a small number of users one at a time by using Cisco Unity Connection
Administration. To add proxy addresses for a larger number of users, you have two options. If all user
addresses follow a consistent pattern (for example, firstname.lastname @server) you can use Bulk Edit
to generate the address for each user by using rules that you define with text and tokens that Connection
replaces with values from the user profile. Or, if user addresses do not follow a consistent format, you
can use the Cisco Unity Connection Bulk Administration Tool to create proxy addresses from a comma
separated value (CSV) file. Do one or more of the following procedures, depending on whether you want
to configure users individually or in bulk.

e To Configure SMTP Proxy Addresses For an Individual User, page 4-64
e To Configure SMTP Proxy Addresses for Multiple Users at Once with Bulk Edit, page 4-64

For information on using the Bulk Administration Tool to update multiple user accounts, see
Appendix A, “Using the Cisco Unity Connection Bulk Administration Tool.”

You cannot configure proxy addresses for user templates.

To Configure SMTP Proxy Addresses For an Individual User

In Cisco Unity Connection Administration, find the user account that you want to edit.
On the Edit menu, click SMTP Proxy Addresses.

On the SMTP Proxy Addresses page, click Add New.

Enter an address in the SMTP Proxy Address field.

Repeat Step 3 and Step 4 for each address that you want to add.

N

W’(e If the user has a relay address configured on the Message Actions page, you should add that relay
address as an SMTP proxy address for the user.

When you are done adding addresses, click Save.

To Configure SMTP Proxy Addresses for Multiple Users at Once with Bulk Edit

In Cisco Unity Connection Administration, expand Tools, and then click Bulk Edit Utility.

In the Bulk Edit utility, click Users with Voice Mail, then find and select the user accounts that you want
to edit.

Click Next.
Click the SMTP Proxy Addresses tab.

To add one or more SMTP proxy addresses to the addresses that are already configured for the users you
are editing, click Append SMTP Proxy Addresses; to delete all existing proxy addresses and replace
them with one or more new addresses, click Override SMTP Proxy Addresses.

Click Add New.

In the new field, enter a pattern for the SMTP proxy address. You can enter a combination of text and
tokens that Connection replaces with a value from the user profile. (For example, Connection replaces
%Alias% with the alias from each user profile when editing the corresponding user.) The available
tokens are:

o  %FirstName%
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e 9%LastName%

e P%Alias%

e  %Extension%
Step8  Repeat Step 6 and Step 7 for each SMTP proxy address pattern you want to add.
Step9  When you are done adding address patterns, click Next, then click Finish.

Voice Recognition

Access to the voice-recognition conversation allows users to interact with Cisco Unity Connection by
speaking commands rather than by using keys on the phone.

To enable users to use the voice-recognition conversation, complete the following tasks in the order
presented:

1. Assign users or the template to a class of service that offers a license to access the voice-recognition
feature, and enables users to use it. See the “Voice Recognition” section on page 5-13.

2. Specify that each user account or template is assigned to the voice-recognition conversation. See the
“Touchtone and Voice-Recognition Conversations” section on page 4-12.

Once enabled to use voice-recognition conversation, users can use the Cisco Unity Assistant to turn the
feature on and off.
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CHAPTER

Setting Up Features and Functionality That Are
Controlled by Class of Service

In Cisco Unity Connection, some of the features that are available to users with voice mailboxes are
controlled by class of service (COS), including features for which you need user licenses. You can update
the settings in a COS to enable or disable features and functionality at any time. The changes that you
make affect all COS members.

Note  When a COS includes access to a feature that requires individual licenses, you can offer the feature to
the members of the COS only if enough licenses are available.

See the following sections for information and procedures for setting up features and functionality that
are controlled by COS:

e Access to Voice Messages from the Cisco Unified Personal Communicator, page 5-2
e Alternate Extensions, page 5-2

e Call Screening and Call Holding, page 5-3

e Cisco Unity Assistant, page 5-3

e Cisco Unity Inbox and RSS Feeds, page 5-4

e Deleted Message Access, page 5-4

e Directory Listing, page 5-5

e Greeting Length, page 5-5

e IMAP Client Access to Voice Messages, page 5-5

e Live Reply, page 5-6

e Message Recording Length, page 5-7

e Personal Call Transfer Rules, page 5-8

e Private Distribution Lists, page 5-9

e Recorded Name and Length, page 5-11

e Restriction Tables, page 5-11

e Secure Messages, page 5-12

e Sending Messages to System Distribution Lists, page 5-13

e Voice Recognition, page 5-13
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I Access to Voice Messages from the Cisco Unified Personal Communicator

Access to Voice Messages from the Cisco Unified Personal
Communicator

To enable Cisco Unity Connection users to play, sort, and delete voice messages from within the Cisco
Unified Personal Communicator application, complete the following tasks in the order presented:

1. Configure the applicable servers, assign Connection users to a COS in Cisco Unity Connection
Administration that offers the feature, and set up the client applications, as described in the
Installation Guide for Cisco Unified Personal Communicator, available at
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html.

2. Optional but recommended: Configure the Connection server to provide a secure IMAP connection,
as described in the “Securing Cisco PCA and IMAP Email Client Access to Cisco Unity
Connection” chapter of the System Administration Guide for Cisco Unity Connection.

3. For information on configuring the Cisco Unified Personal Communicator to access Connection
voice messages, refer users to the User Guide for Cisco Unified Personal Communicator at
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html, or the
Cisco Unified Personal Communicator Help.

Alternate Extensions

Step 1
Step 2

Step 3

Revised May 2009

While you specify alternate extensions for individual users on their account pages, COS settings allow
you to determine whether users can view and/or manage alternate extensions, and whether they can use
the Cisco Unity Assistant to manage a set of their own alternate extensions. Consider allowing users to
specify their own set, so that you can reduce the number of requests to enter extensions for user mobile
phones, home phones, and other phones. When you enable users to manage their own alternate
extensions, they can specify up to five alternate extensions in addition to those already specified for them
by you.

Do the following procedure to specify whether users can view and manage administrator-defined
alternate extensions, or manage their own set of alternate extensions. To learn how alternate extensions
work and why you use them, see the “Alternate Extensions” section on page 4-56.

To Specify Whether COS Members Can View and/or Manage Alternate Extensions in the Cisco Unity Assistant

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Alternate Extensions, check either or both of the following
check boxes:

¢ Allow Users to View Administrator-Defined Alternate Extensions
¢ Allow Users to Manage Their User-Defined Alternate Extensions

Click Save.
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Call Screening and Call Holding

Call Screening and Call Holding

Step 1
Step 2

Step 3

The Call Transfer settings in a COS specify whether users can use the Cisco Unity Assistant or the
Cisco Unity Personal Call Transfer Rules web tool (as applicable) to change call screening and call
holding options. (If users are enabled to use personal call transfer rules, they find screening and holding
options in the Cisco Unity Personal Call Transfer Rules web tool, not the Cisco Unity Assistant.)

Screening and holding options allow users to specify how Cisco Unity Connection handles calls that are
transferred from the automated attendant or a directory handler to user phones. The options that are
potentially available to users differ depending on how you set up call transfers to work for each user
account. (See the “Call Transfer, Call Screening, and Call Holding” section on page 4-6 for information
on how call transfers work.)

Do the following procedure to specify whether users can manage their call screening and holding
options.

To Specify Whether COS Members Can Manage Call Screening and Call Holding Options

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.
On the Edit Class of Service page, under Call Transfer, check one or both of the following check boxes:
e Allow Users to Change Call Screening Options
e Allow Users to Change Call Holding Options
Click Save.

Cisco Unity Assistant

Step 1
Step 2

Step 3

The Cisco Unity Assistant is a web tool available on the Cisco Personal Communications Assistant
(PCA) website. The Cisco Unity Assistant allows users to personalize their Connection
settings—including their greetings and message-delivery options—and to set up message-notification
devices and to create private lists.

Do the following procedure to enable users to access the Cisco Unity Assistant. For steps on configuring
the browsers on user workstations to access any of the Cisco PCA web tools, see the “Configuring an
Internet Browser to Access the Cisco PCA” section in the “Setting Up Access to the Cisco Personal
Communications Assistant” chapter of the User Workstation Setup Guide for Cisco Unity Connection.

To Enable COS Members to Access the Cisco Unity Assistant

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Features, check the Allow Users to Use the Cisco Unity
Assistant check box.

Click Save.
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Cisco Unity Inbox and RSS Feeds

Note

Step 1
Step 2

Step 3

Revised May 2009
As a convenience to users who are not always able to check messages by phone, you can enable users to
access the Cisco Unity Inbox or RSS Feeds on their computers.

The Cisco Unity Inbox is a web tool available on the Cisco Personal Communications Assistant (PCA)
website. For steps on configuring the browsers on user workstations to access any of the Cisco PCA web
tools, see the “Configuring an Internet Browser to Access the Cisco PCA” section in the “Setting Up
Access to the Cisco Personal Communications Assistant” chapter of the User Workstation Setup Guide
for Cisco Unity Connection.

RSS Feeds allow users to retrieve voice messages by using an RSS reader. For details on configuring the
Connection server for RSS Feeds, see the “Configuring Access to RSS Feeds of Voice Messages” section
in the “Messaging” chapter of the System Administration Guide for Cisco Unity Connection.

Do the following procedure to enable users to access the Cisco Unity Inbox and RSS Feeds.

You can offer the Cisco Unity Inbox and RSS Feeds to members of the COS only if enough licenses are
available.

To Enable COS Members to Access the Cisco Unity Inbox and RSS Feeds

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Licensed Features, check the Allow Users to Use the
Cisco Unity Inbox and RSS Feeds check box.

Click Save.

Deleted Message Access

Step 1
Step 2

Step 3

You specify whether users can access the messages that they delete, or whether messages are
permanently deleted at the time that users delete them. If you have concerns about storing deleted
messages on the server, you may want to consider preventing users from accessing deleted messages.

Do the following procedure to specify whether users can access deleted messages.

To Enable or Disable Access to Deleted Messages

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Message Options, check or uncheck the Delete Messages
Without Saving to Deleted Items Folder check box, as follows:

e To allow users to access deleted messages, uncheck the check box.
e If you want messages permanently deleted when users delete them, check the check box.

Click Save.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x


http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user_setup/guide/7xcucus010.html#Configuring_an_Internet_Browser_to_Access_the_Cisco_PCA
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsag170.html#Configuring_Access_to_RSS_Feeds_of_Voice_Messages

| Chapter5

Setting Up Features and Functionality That Are Controlled by Class of Service

Directory Listing

Directory Listing

Step 1
Step 2

Step 3

You specify whether users in a COS can choose to be listed in directory assistance. Directory assistance
is the audio listing that users and outside callers use to reach users and to leave messages for them.

Do the following procedure to allow users to choose (by using the Cisco Unity Assistant) whether to be
listed in directory assistance.

To Allow COS Members to Choose Whether to Be Listed in Directory Assistance

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Directory Listing, check the Allow Users to Choose to Be
Listed in the Directory check box.

Click Save.

Greeting Length

Step 1
Step 2
Step 3

Do the following procedure to specify how long the recorded greeting of a user can be.
To Specify Maximum Length of User Greetings
In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Greetings, enter the maximum length for greetings (in seconds).
Click Save.

IMAP Client Access to Voice Messages

Revised May 2009

As a convenience to users who are not always able to check messages by phone or from the Cisco Unity
Inbox, you can enable users to use an IMAP client application on their computers to access their voice
messages. Access to messages is limited according to the option you select:

Allow Users to Access Users can access the entire voice message.

Message Bodies

Allow Users to Access Users can access the entire voice message, unless the message is marked
Message Bodies Excepton |private. For private messages, they can access only the message header.
Private Messages (Secure messages can never be accessed in an IMAP client.)

This option also ensures that private messages are never saved as WAV files
to locations outside of the Cisco Unity Connection server.

Allow Users to Access Users can access message headers only.
Message Headers Only
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Do the following procedure to enable IMAP client access to voice messages for members of a particular
class of service. See the “Configuring IMAP Settings” chapter of the System Administration Guide for
Cisco Unity Connection for instructions on configuring the Connection server, user accounts, and user
workstations for IMAP client access.
Note that you can offer IMAP client access to voice messages to members of the COS only if enough
licenses are available.
To Enable IMAP Client Access to Voice Messages for COS Members
Step1  In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.
Step 2 On the Edit Class of Service page, under Licensed Features, check the Allow Users to Access Voice
Mail Using an IMAP Client check box.
Step3  Choose one of the following options:
e Allow Users to Access Message Bodies
e Allow Users to Access Message Bodies Except on Private Messages
e Allow Users to Access Message Headers Only
Step4  Click Save.

Live Reply

Revised May 2009

When live reply is enabled, users who are listening to messages by phone can reply to a message by
having Cisco Unity Connection call the sender. You can use COS settings to specify whether users can
live reply only to messages from other users, or to messages from both users and unidentified callers
(unidentified callers are outside callers or users who are forwarded to Connection but who cannot be
identified by the calling extension).

Users can live reply to a message by using the touchtone conversation or the voice-recognition
conversation. Consider informing users when you enable this feature, because even when it is enabled,
the live reply option is not mentioned in the main Connection phone menus for some phone conversation
types. (It is, however, mentioned in the User Guide for the Cisco Unity Connection Phone Interface.)

Note the following considerations for live reply to users:

e Connection dials the extension of the user who left the message only when the Transfer Incoming
Calls to User’s Phone setting for the user who left the message is set to ring an extension or another
number.

N

Note  The Transfer Incoming Calls to User’s Phone field is on the Call Transfer page.

e The call transfer settings for the user who left the message dictate what Connection does when the
user phone is busy, and whether Connection screens the call.
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Step 1
Step 2

Step 3

Message Recording Length

e If a user attempts to live reply to a message but the sender is unavailable to take the call, a reply
message left for the sender is only correctly identified as having been sent by the user if the user
called from his or her own extension or an alternate extension. This is because Connection releases
the live reply call to the phone system, and the user is no longer logged on to Connection when
leaving the reply message.

Note the following considerations for live reply to unidentified callers:

e Connection uses the calling number provided by the phone system in the Automatic Number
Identification (ANI) string. To initiate the live reply, Connection checks the ANI digits against the
transfer restriction table associated with the class of service of the user. If the number is allowed,
Connection returns the call by performing a release transfer to the phone system.

* You can configure a prefix that Connection prepends to the ANI string, and the minimum length of
the ANI string before the prefix is applied; you can use this, for example, to prepend a trunk access
code to all numbers of a sufficient length, or to provide additional information that the phone system
may need to process the number. Any other formatting that must be done to generate a proper dial
string must be performed by the phone system. For instructions, see the “Dial Prefix Settings for
Live Reply to Unidentified Callers” section in the “Changing Conversation Settings for All Users”
chapter of the System Administration Guide for Cisco Unity Connection.

Do the following procedure to enable live reply for users in a COS.

To Enable Live Reply for COS Members

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Message Options, check either or both of the following check
boxes:

e Users Can Reply to Messages from Other Users by Calling Them
¢ Users Can Reply to Messages from Unidentified Callers by Calling Them
Click Save.

Message Recording Length

~

Note

Step 1
Step 2

Do the following procedure to specify the maximum recording length for messages that users who are
assigned to a COS can leave for other users. The default setting is 300 (5 minutes).

The maximum length for messages that are left by outside callers is set on the Message Settings page for
each user account. See the “Outside Caller Options” section on page 4-9 for details.

To Specify Maximum Recording Length for User Messages

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Message Length, enter the maximum recording length in
seconds.
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Step3  Click Save.

Personal Call Transfer Rules

By using the Personal Call Transfer Rules web tool, Cisco Unity Connection users can create call
transfer rules that forward and screen direct and indirect calls according to any or all of the following
criteria:

e Identity of caller
e Time of day
® Meeting schedule

Connection users can specify that calls are forwarded to voice mail, to another phone number, or to a
series of destinations (which must include at least one phone number and which can include SMS and
SMTP notification devices).

See the following sections:
e About the Personal Call Transfer Rules Web Tool, page 5-8
e Enabling and Disabling the Personal Call Transfer Rules Feature, page 5-9

Optionally, you can configure Connection so that users can base personal call transfer rules on their
Exchange calendar and contacts. See the “Access to Exchange Calendars and Contacts” section on
page 4-61 for more information and a task list.

About the Personal Call Transfer Rules Web Tool

Personal Call Transfer Rules is a web tool available on the Cisco Personal Communications Assistant
(PCA) website. In addition to allowing users to create call transfer rules, it offers the following
additional features to Cisco Unity Connection users:

Personal contacts list Connection users can set up a directory of personal contacts that supplements
the information in the Connection directory. Connection uses the personal
contacts list to forward incoming calls, and also to place outgoing calls when
the Connection user uses the speech recognition conversation.

Note  Users manage their personal contacts list in the Cisco Unity Assistant
web tool.

Caller groups Connection users can organize callers into groups so that they can apply one
rule to multiple callers without having to recreate the rule multiple times.
Caller groups can contain other Connection users, system contacts, or
personal contacts.

Personal destinations In addition to notification devices, Connection users can create a directory of
contact phone numbers to which Connection can direct incoming calls,
according to rules that users set up.
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Destination groups Connection users can create groups of personal destinations and notification
devices. When transferring a call to a destination group, Connection forwards
the call to each destination in the group in the order listed until the phone is
answered, the caller hangs up, or the last destination in the group is reached.
Connection users can specify the ordering of destinations in the series, and the
number of rings that Connection waits for the phone to be answered at each
destination.

Call transfer rule tester | The call transfer rule tester is used by users and administrators to see how
Connection would forward an incoming call based on an actual rule.

Transfer All rule The Transfer All rule is a single rule that forwards all calls to a specific
destination for a specified time. This rule can be created and activated only by
phone.

Forward all calls to Connection users can forward all calls to Connection in order to automatically

Cisco Unity Connection | apply personal call transfer rules to incoming calls, rather than having the call
ring the primary extension.

To learn more about how users can use personal call transfer rules and the web tool, see “The Cisco Unity
Personal Call Transfer Rules Web Tool” chapter of the User Guide for the Cisco Unity Connection
Personal Call Transfer Rules Web Tool.

Enabling and Disabling the Personal Call Transfer Rules Feature

Step 1
Step 2

Step 3

Do the following procedure to enable or disable the personal call transfer rules feature for users in a
COS.

To Enable or Disable Personal Call Transfer Rules for COS Members

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.
On the Edit Class of Service page, under Features, do one of the following:

e To enable personal call transfer rules, check the Allow Users to Use Personal Call Transfer Rules
check box.

e To disable personal call transfer rules, uncheck the Allow Users to Use Personal Call Transfer
Rules check box.

Click Save.

Private Distribution Lists

COS settings allow you to specify the maximum number of lists that are available to users, and the
maximum number of members that users can add to each list when they use the Cisco Unity Connection
conversation or the Cisco Unity Assistant to manage their lists.

See the following sections:
e Maximum Number of Private Lists Available to Users, page 5-10

e Maximum Number of Members Per Private List, page 5-10

[ oL-17018-01
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Maximum Number of Private Lists Available to Users

Step 1
Step 2

Step 3

You can set the maximum number of lists—up to 99—available to each user who is assigned to the COS.

While both the Cisco Unity Connection conversation and the Cisco Unity Assistant use this COS setting
to determine when a user has reached the maximum number of lists, each application calculates
differently the number of lists that a user owns:

e When a user uses the phone to create a new list by adding members, the Cisco Unity Connection
conversation counts the number of private lists that have members, and then compares the total to
the value in this setting to determine whether the user has reached the list limit. Lists with no
members (empty lists) are not included in the total number of lists that a user owns, even if the lists
have recorded names or text names.

e When a user uses the Cisco Unity Assistant to create a new list, the Cisco Unity Assistant counts the
number of lists that have a recorded voice name, a text name, or members, and then compares the
total to the value in this setting to determine whether the user has reached the list limit. Lists with
no members are included in the total number as long as they have recorded names or text names.

This means that if a user belongs to a COS that allows 15 lists, and the user has 12 private lists with
members and two lists with recorded names but no members, the user can potentially create more lists
by phone than in the Cisco Unity Assistant before reaching the list limit:

e When the user uses the Cisco Unity Connection conversation, the user reaches the list limit either
by adding members to the two empty lists and creating one new list, or by creating three new lists.
If the user reaches the limit by creating three new lists, the user cannot add members to the two
empty lists until two lists are deleted.

e When the user uses the Cisco Unity Assistant, the user reaches the list limit by creating one new list.
Despite reaching the list limit, the user can add members to the two empty lists.

Do the following procedure to change the maximum number of private lists that are available to users in
a COS.

To Change the Maximum Number of Private Lists Available to COS Members

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Private Distribution Lists, enter a number from 1 to 99 in the
Maximum Lists Per User field.

Click Save.

Maximum Number of Members Per Private List

Step 1
Step 2

Do the following procedure to specify the maximum number of members—up to 999—that users who
are assigned to a COS can add to a private list.

To Change the Maximum Number of Members Per Private List

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Private Distribution Lists, enter a number from 1 to 999 in the
Maximum Members Per List field.

ll_ User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x

0L-17018-01



| Chapter5

Setting Up Features and Functionality That Are Controlled by Class of Service

Step 3

Recorded Name and Length 1l

Click Save.

Recorded Name and Length

Note

Step 1
Step 2

Step 3
Step 4

For each COS, you specify whether users are allowed to record their own voice names, and how long a
recorded name can be.

Hearing a name recorded in the voice of the user can help callers distinguish between users who have
similar names. When allowed to record their voice names, users can use either the Cisco Unity
Connection phone conversation or the Cisco Unity Assistant to make the recording, and they are
prompted to complete the task during first-time enrollment.

Connection does not prevent users from completing the enrollment process if they do not record a name.

When Connection users have no recorded name, Connection uses Text to Speech to play the user name
(either the display name or the concatenated first and last name, depending on which name is entered in
Connection Administration). However, recorded names can give callers an extra level of assurance that
they are reaching the person or mailbox they intended to reach. If you are considering preventing users
from recording their own names, we recommend that you have user names recorded by someone, to
assist callers in understanding names.

Do the following procedure to specify whether users can record their names, and the recorded name
length.

To Specify Whether COS Members Can Record Their Names, and the Length for a Name

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Recorded Name, check the Allow Recording of Voice Name
check box.

In the Maximum Length field, enter the maximum length in seconds.

Click Save.

Restriction Tables

For each COS, you specify the restriction table that is used for call transfers and message notifications.
The restriction table that you specify can be the same for both, or different for each.

To learn more about how restriction tables work, see the “Managing Restriction Tables” chapter of the
System Administration Guide for Cisco Unity Connection.

Do the following procedure to specify the restriction tables that control the numbers that users can use
for call transfers and message notifications.

[ oL-17018-01
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To Specify a Restriction Table for Call Transfers and Message Notifications

Step1  In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.
Step2  On the Edit Class of Service page, under Restriction Tables, do the following:

¢ In the Outcalling list, click the restriction table that you want used for message notifications.

e In the Transfer list, click the restriction table that you want used for call transfers.

Step3  Click Save.

Secure Messages

You determine how Cisco Unity Connection handles message security for messages that are sent by
members of the COS. You can specify that:

e Messages are always marked secure.

e Messages are marked secure only when users mark them secure by pressing the applicable key from
the Special Delivery Options phone menu.

e Messages are never marked secure.
e Messages are marked secure only when users mark them private (this is the default).

Note that users are always able to mark a message private when they send it—regardless of the option
you specify. See the “Securing User Messages: Controlling Access and Distribution” chapter of the
System Administration Guide for Cisco Unity Connection to learn more about the message security
options available in Connection.

Do the following procedure to specify how Connection handles message security for the messages that
are sent by members of the COS.

To Specify Message Security for COS Members

Step 1 In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

Step2  On the Edit Class of Service page, under Message Options, select from the following options in the
Require Secure Messaging list:

e Always—Messages are always marked secure.
e Never—Messages are never marked secure.

e Ask—Messages are marked secure only when users mark them secure by choosing the secure
message option from the Special Delivery Options phone menu.

e Private—Messages are marked secure only when users mark them private from the Special Delivery
Options phone menu.

Step3  Click Save.
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Sending Messages to System Distribution Lists

Sending Messages to System Distribution Lists

Step 1
Step 2

Step 3

Do the following procedure to specify whether users can send messages to system distribution lists.

To Specify Whether COS Members Can Send Messages to System Distribution Lists

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Message Options, check or uncheck the Allow Users to Send
Messages to System Distribution Lists check box.

Click Save.

Voice Recognition

Step 1
Step 2

Step 3

Revised May 2009

Access to the voice-recognition conversation allows users to interact with Cisco Unity Connection by
saying commands rather than by using keys on the phone. To enable users to use it, complete the
following tasks in the order presented:

1. Assign users or a user template to a class of service that offers a license to access the
voice-recognition feature and enables users to use it. Do the following “To Allow COS Members a
License to Access and Use the Voice-Recognition Feature” procedure.

2. Specify that each user account or template is assigned to the voice-recognition conversation. See the
“Touchtone and Voice-Recognition Conversations” section on page 4-12 for instructions.

Note that you can offer voice recognition to members of the COS only if enough licenses are available.

To Allow COS Members a License to Access and Use the Voice-Recognition Feature

In Cisco Unity Connection Administration, find the COS that you want to change, or create a new one.

On the Edit Class of Service page, under Licensed Features, check the Allow Access to Advanced
Features check box, and then check the Allow Users to Use Voice Recognition check box.

Click Save.

[ oL-17018-01
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A class of service (COS) defines limits and permissions for accounts with voice mailboxes. For example,
a COS:

Controls user access to licensed features such as the Cisco Unity Inbox. (When a COS includes
access to a feature that requires individual licenses, you can assign groups of users to the COS only
if enough licenses are available.)

Controls user access to non-licensed features such as personal call transfer rules.

Controls how users interact with Connection. For example, a COS dictates the maximum length of
user messages and greetings, and whether users can choose to be listed in directory assistance.

Controls call transfer options.

Specifies the number of private distribution lists allowed to users, and the number of members
allowed on each list.

Specifies the restriction tables used to control the phone numbers that users can use for transfers and
when placing calls.

A COS is not specified for the individual accounts or templates that are associated with users without
voice mailboxes (typically, these are administrator accounts). Permissions associated with administrator
accounts are instead controlled by roles in Connection Administration. (See the “Roles” section on
page 2-4 for more details.)

See the following sections:

Default Classes of Service, page 6-2

Adding a Class of Service, page 6-2

Modifying the Settings for a Class of Service, page 6-2
Assigning and Reassigning Users to a Class of Service, page 6-3

Deleting a Class of Service, page 6-4

[ oL-17018-01
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Default Classes of Service

Cisco Unity Connection includes the following predefined classes of service, which you can modify but
not delete:

Voice Mail User COS Contains settings that are applicable to end users. By default, this COS
is associated with the default Voice Mail User template.

System A COS that special default user accounts are members of. This COS is
read-only and cannot be modified or deleted.

Adding a Class of Service

Step 1
Step 2
Step 3

Step 4

To Create a Class of Service

In Cisco Unity Connection Administration, expand Class of Service, then click Class of Service.
On the Search Class of Service page, click Add New.
On the New Class of Service page, enter settings as applicable.

~

m Fields marked with an * (asterisk) are required.

Click Save.

Modifying the Settings for a Class of Service

Step 1
Step 2

Step 3

You can modify the settings for a COS at any time. Changes to the settings in a COS—including features
for which you need user licenses—affect new and existing members of the COS. For example, if
members of the COS currently have access to a licensed feature and you change the COS to remove
access to the feature, the next time those users log on to Cisco Unity Connection, they are unable to
access the feature.

To make changes to a COS, do the following “To Modify the Settings for a Class of Service” procedure.

To Modify the Settings for a Class of Service

In Cisco Unity Connection Administration, expand Class of Service, then click Class of Service.
On the Search Class of Service page, click the display name of the applicable class of service.

~

Note If the class of service does not appear in the search results table, set the applicable parameters
in the search fields at the top of the page, and click Find.

Change settings on the Edit Class of Service page, as applicable.
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Step 4

Assigning and Reassigning Users to a Class of Service

Click Save.

For details on the features and functionality available for classes of service, see the “Setting Up Features
and Functionality That Are Controlled by Class of Service” chapter.

Assigning and Reassigning Users to a Class of Service

Note

Step 1
Step 2

Step 3
Step 4

Step 1

Step 2

Step 3

Step 4

A COS is specified in each user template; thus, a user is assigned to the COS that is specified in the
template on which the user account is based. If you find that the settings for a particular COS are no
longer appropriate for an individual user or several users, you can reassign the users to another COS at
any time. (Changing the COS that is specified in a template does not affect user accounts that have
already been created.)

When a COS includes access to a feature that requires individual licenses, you can assign groups of users
to the COS only if enough licenses are available.

If you want to reassign users to a COS, do one of the following procedures:

e To Assign or Reassign a User to a Class of Service, page 6-3—Do this procedure to make a COS
change for a single user account.

e To Reassign Multiple Users to a Class of Service, page 6-3—Do this procedure to reassign up to 25
users at one time to another COS.

To Assign or Reassign a User to a Class of Service

In Cisco Unity Connection Administration, click Users.
On the Search Users page, in the Search Results table, click the alias of the applicable user.

N

W’(e If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and click Find.

On the Edit User Basics page, in the Class of Service list, click the applicable class of service.
Click Save.

To Reassign Multiple Users to a Class of Service

In Cisco Unity Connection Administration, expand Class of Service, then click Class of Service
Membership.

On the Search Class of Service Members page, set parameters in the Find Class of Service Members
fields according to the COS from which you want to move users, then click Find.

In the Class of Service Members Search Results table, check the check boxes to the left of the user aliases
that you want to move to another COS. You can move up to 25 users at one time.

In the To list, click the name of the COS to which you want to move the users that you selected in Step 3.

[ oL-17018-01
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Step 5

Click Move Selected User.

Deleting a Class of Service

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

Before you can delete a COS, you first must reassign any members of that COS to another COS. Do the
following “To Delete a Class of Service” procedure.

To Delete a Class of Service

In Cisco Unity Connection Administration, expand Class of Service, then click Class of Service
Membership.

On the Search Class of Service Members page, set parameters in the Find Class of Service Members
fields according to the class of service you want to delete, then click Find.

In the Class of Service Members Search Results table, check the check boxes to the left of the user aliases
that you want to move to another class of service.

In the To list, click the name of the class of service to which you want to move the users that you selected
in Step 3.

Click Move Selected User.

Repeat Step 3 through Step 5 until the Class of Service Members Search Results table shows there are
no members in the class of service that you want to delete.

~

Note  You may need to click Refresh for changes to be reflected in the Search Results table.

Expand Class of Service, then click Class of Service.

On the Search Class of Service page, check the check box to the left of the display name of the class of
service that you want to delete.

~

Note If the class of service does not appear in the search results table, set the applicable parameters
in the search fields at the top of the page, and click Find.

Click Delete Selected.
Click OK to confirm the deletion.
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Each account that you add in Cisco Unity Connection is based on a user template. Settings from the
template are applied to the accounts as the accounts are created. Connection includes predefined
templates, which you can modify. You can also create an unlimited number of additional templates.

See the following sections:
e Cisco Unity Connection Default Templates, page 7-1
e Password Security Considerations for Template Defaults, page 7-1
e Adding a User Template, page 7-2
e Modifying a User Template, page 7-4
e Deleting a User Template, page 7-4

Cisco Unity Connection Default Templates

Cisco Unity Connection comes with the following predefined user templates, which you can modify but
not delete:

Voice Mail User Template The settings on this template are suitable for most users.

Administrator Template The settings on this template are suitable for users who administer
Connection. User accounts that are based on this template do not have
voice mailboxes.

By default, the template specifies the System Administrator role, which
is the administrator role with the highest privileges.

Password Security Considerations for Template Defaults

Consider the following as you prepare your templates for creating Connection end user and administrator
accounts:

Users with Voice Mailbox Accounts

Default voice mail and web application passwords are applied to each user account that you create. These
passwords are either the defaults set for the default Voice Mail User Template during installation, or
defaults that are set on the Change Password page for the user template that you select when creating the

[ oL-17018-01

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



Chapter7  Adding, Modifying, or Deleting a User Template

Bl Adding a User Template

accounts. You need to give these passwords to users so that they can log on to the Connection
conversation and to the Cisco Personal Communications Assistant (PCA). To increase system security,
we recommend that you instruct users to change both passwords as soon as possible, and that you enforce
password complexity rules.

Users Without Voice Mailbox Accounts

A default web application password is applied to each administrative account that you create. If you base
the new account on the default Administrator Template, keep in mind that the default password
associated with the account is a randomly-generated string. Therefore, if you base new administrative
accounts on the default Administrator Template, be sure to first enter a new default password for the
template to replace the randomly-generated string, or make sure that you change the password for each
new account as you create it. To increase system security, we recommend that you instruct administrators
to change the password as soon as possible, and that you enforce password complexity rules.

Adding a User Template

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7
Step 8
Step 9

Revised May 2009
Users with voice mailboxes are end users; users without voice mailboxes are system administrators. Do
the applicable procedure to create a user template:

e To Create an End User Template (for Users with Voice Mailboxes), page 7-2
e To Create an Administrator Template (for Users Without Voice Mailboxes), page 7-3

To Create an End User Template (for Users with Voice Mailboxes)

In Cisco Unity Connection Administration, expand Templates, then click User Templates.
On the Search User Templates page, click Add New.

On the New User Template page, in the User Template Type list, click User Template with Voice
Mailbox.

In the Based on Template list, click a template on which to base the new template.

~

Note  All settings are copied from the base template to the new template, except for the settings that
you choose on the New User Template page (Alias, Display Name, and so on). System
distribution list membership is also copied from the base template. For example, all new user
templates based on the default voicemailusertemplate are automatically added to the
allvoicemailusers system distribution list and to any other lists to which voicemailusertemplate
has been manually added.

Enter an alias and display name.

In the Phone System list, click the applicable phone system.

Click Save.

On the Edit User Template Basics page, enter additional settings, as applicable.

When you have finished entering basic settings, click Save.
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Step 10

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

Step 8

Step 9

Step 10
Step 11
Step 12

Step 13
Step 14

Step 15

Adding a User Template Il

On the Edit menu, click the applicable pages to continue customizing settings for the new user template.
If you change settings on a page, click Save before leaving the page.

To Create an Administrator Template (for Users Without Voice Mailboxes)

In Cisco Unity Connection Administration, expand Templates, then click User Templates.
On the Search User Templates page, click Add New.

On the New User Template page, in the User Template Type list, click User Template Without Voice
Mailbox.

In the Based on Template list, click a template on which to base the new template.
Enter an alias for the account.
Enter additional information, as applicable, then click Save.

On the Edit User Template Basics page, enter additional information, as applicable. If you change any
settings on the page, click Save.

On the Edit menu, click Roles.

On the Edit Roles page, click a role name in the Assigned Roles or Available Roles fields, then click the
Up arrow or Down arrow to move the role to the applicable field. (Note that by default, the template
specifies the System Administrator role, which is the administrator role with the highest privileges.)

When the Assigned Roles field contains all of the applicable roles for the administrator, click Save.
On the Edit menu, click Password Settings.

On the Edit Password Settings page, enter settings for the password that the administrator use when
accessing Connection Administration:

a. Verify that the User Must Change at Next Login check box is checked. When this check box is
checked, the administrator is required to change the password when logging on for the first time.

b. In the Authentication Rule field, click an applicable rule.
Click Save.
For coresident configurations, skip to Step 17.

For standalone configurations, on the Edit Menu, click Change Password.

A

Caution Do not skip the steps for entering a password for the new template (Step 15 and Step 16). If
you do not enter a password, a randomly-generated string is entered as the default password.
You will then be unable to log on to the account, and will be forced to log on to a different
administrative account and change the password of the new account to remove the
randomly-generated string.

On the Change Password page, enter a password in the Password field. Note that the password must meet
the following requirements for password complexity:

¢ A minimum length requirement (as set on the Edit Authentication Rule page, in the Minimum
Credential Length field)

¢ Inclusion of at least one character from each of the following categories: upper-case letter,
lower-case letter, number, and symbol (~! @ #$ A& *““,.:;?2-_()[1<>{}+=/\])

e No characters repeated consecutively more than three times (for example, aaaaB1C9 is invalid)
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e No inclusion of the alias or name of the administrator
Step16  Enter the password again in the Confirm Password field.

Step17  Click Save.

Modifying a User Template

Before you create Cisco Unity Connection accounts, review the settings in the templates that you plan
to use and determine whether you need to make any changes. Changes to template settings do not affect
existing user accounts.

To Modify a User Template

Step 1 In Cisco Unity Connection Administration, expand Templates, then click User Templates.
Step2  On the Search User Templates page, click the alias of the user template that you want to modify.

~

Note  If the user template does not appear in the search results table, set the applicable parameters in
the search fields at the top of the page, and click Find.

Step3  On the Edit User Template Basics page, change settings as applicable.
Step4  When you have finished changing settings, click Save.

Step5 From the Edit menu, you may also want to change settings on any (or all) of the available pages. If you
change settings on a page, click Save before leaving the page.

Deleting a User Template

Note that you cannot delete the default templates (Voice Mail User Template and Administrator
Template).

Deleting a user template does not affect any user accounts that were based on that template when they
were created.

To Delete a User Template

Step 1 In Cisco Unity Connection Administration, expand Templates, then click User Templates.

Step2  On the Search User Templates page, check the check box to the left of the alias of the user template that
you want to delete.

~

Note If the user template does not appear in the search results table, set the applicable parameters in
the search fields at the top of the page, and click Find.

Step3  Click Delete Selected.
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Deleting a User Template

Step4  Click OK.
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Individually

See the following sections:
¢ Creating User Accounts in a Coresident Configuration, page 8-1
e Creating User Accounts in Cisco Unity Connection Administration, page 8-2
e Adding an End User Account (User with a Voice Mailbox), page 8-2
¢ Adding an Administrator Account (User Without a Voice Mailbox), page 8-3

e Adding an End User Account to Access the Cisco Unity Connection Greetings Administrator (User
with Voice Mailbox), page 8-5

Creating User Accounts in a Coresident Configuration

In Cisco Unified Communications Manager Business Edition (CMBE), you create individual users and
administrator accounts on the User Management pages in Cisco Unified CM Administration. The
accounts are based on the templates and classes of service that you create and/or modify in Cisco Unity
Connection Administration.

Users with voice mailboxes are end users; users without voice mailboxes are system administrators (or
application users). After you add an end user for Connection, you can then configure an end user voice
mailbox in Cisco Unified CM Administration. Other settings can be modified as needed from the user
account pages in Connection Administration.

For details on adding and configuring Connection accounts in Cisco Unified CM Administration, see the
online Help in Cisco Unified CM Administration, or the “End User Configuration” and “Application
User Configuration” chapters of the applicable Cisco Unified Communications Manager Administration
Guide for a task list and related topics. The guide is available at
http://www.cisco.com/en/US/products/ps7273/prod_maintenance_guides_list.html.

For details on importing multiple users from Cisco Unified Communications Manager, see the “Creating
Multiple User Accounts from Cisco Unified Communications Manager Users” chapter.

[ oL-17018-01

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x


http://www.cisco.com/en/US/products/ps7273/prod_maintenance_guides_list.html

Chapter8  Adding Cisco Unity Connection Accounts Individually |

I Creating User Accounts in Cisco Unity Connection Administration

Creating User Accounts in Cisco Unity Connection
Administration

Note

Users with voice mailboxes are end users; users without voice mailboxes are system administrators.
Before you add user accounts individually, you need to select and define a template and class of service
(COS) for each type of account you plan to add. For administrator accounts, you also need to select the
roles that are assigned to each account. To learn more about the tasks you should do before adding a
Cisco Unity Connection account, review the “Preparing to Add User Accounts” chapter.

See the applicable sections in this chapter to add individual accounts for end users and administrators:
e Adding an End User Account (User with a Voice Mailbox), page 8-2

e Adding an End User Account to Access the Cisco Unity Connection Greetings Administrator (User
with Voice Mailbox), page 8-5

e Adding an Administrator Account (User Without a Voice Mailbox), page 8-3

If system administrators in your organization require voice mailboxes, we recommend that you set up
separate accounts for each system administrator: a user without voice mailbox account to use when
logging on to Connection Administration to do administrative tasks, and a separate user account with a
voice mailbox to use when sending and receiving voice messages.

Adding an End User Account (User with a Voice Mailbox)

N

Note

Step 1
Step 2
Step 3
Step 4
Step 5

Revised May 2009

The information in this section is not applicable to adding end user accounts in Cisco Unified
Communications Manager Business Edition (CMBE). Instead, see the “Creating User Accounts in a
Coresident Configuration” section on page 8-1.

Note that default voice mail and web application passwords are applied to each user account that you
create. These passwords are either the defaults set for the default Voice Mail User Template during
installation, or defaults that are set on the Change Password page for the user template that you select
when creating the accounts. You need to give these passwords to users so that they can log on to the
Connection conversation and to the Cisco Personal Communications Assistant (PCA). To increase
system security, we recommend that you instruct users to change both passwords as soon as possible,
and that you enforce password complexity rules.

Use the following procedure to add a single user account with a voice mailbox.

To Add an End User Account (User with a Voice Mailbox)

In Cisco Unity Connection Administration, click Users.

On the Search Users page, click Add New. The New User page opens.
In the User Type list, click User With Mailbox.

In the Based on Template list, click VoiceMailUserTemplate.

Enter information in the following two required fields, which are marked with an asterisk (*):
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Step 6

Step 7
Step 8
Step 9

Adding an Administrator Account (User Without a Voice Mailbox) | |

e Alias
e Extension

Enter information in the optional fields, as applicable. (For field information, on the Help menu, click
This Page.)

Note that the SMTP Address field is optional in the sense that if you do not enter a value, Connection
uses the alias to form the SMTP address. However, the SMTP address cannot include non-ASCII
characters. Thus, if the user alias contains non-ASCII characters, you must provide an acceptable SMTP
address.

Click Save. The user account is created, and the Edit User Basics page opens.
Enter additional information, as applicable. If you change any settings on the page, click Save.

As needed, from the pages on the Edit menu, modify the account to enable features or functionality that
were not already enabled in the template or COS. If you make changes on a page, click Save before going
to another page.

For additional information on features that you can enable, see the “Setting Up Features and
Functionality That Are Controlled by User Account Settings” chapter and the “Setting Up Features and
Functionality That Are Controlled by Class of Service” chapter.

Adding an Administrator Account (User Without a Voice
Mailbox)

N

Note

Revised May 2009

The information in this section is not applicable to adding administrator accounts in Cisco Unified
Communications Manager Business Edition (CMBE). Instead, see the “Creating User Accounts in a
Coresident Configuration” section on page 8-1.

Users without voice mailboxes are system administrators. If system administrators in your organization
require voice mailboxes, we recommend that you set up separate accounts for each system administrator:
a user without voice mailbox account to use when logging on to Connection Administration to do
administrative tasks, and a separate user account with a voice mailbox to use when sending and receiving
voice messages.

As you create administrator accounts, consider the following security issues:

e By default, the user without a voice mailbox template specifies the System Administrator role,
which is the administrator role with the highest privileges.

e A default web application password is applied to each administrative account that you create. If you
base the new account on the default Administrator Template, keep in mind that the default password
associated with that account is a randomly-generated string. Therefore, if you base new
administrative accounts on the default Administrator Template, be sure to first enter a new default
password for that template to replace the randomly-generated string, or make sure that you change
the password for each new account as you create it. To increase system security, we recommend that
you instruct administrators to change the password as soon as possible, and that you enforce
password complexity rules.
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

Step 11
Step 12
Step 13

Step 14
Step 15
Step 16

Step 17
Step 18

Use the following procedure to add a single administrator account without a voice mailbox.

To Add an Administrator Account (User Without a Voice Mailbox)

In Cisco Unity Connection Administration, click Users.

On the Search Users page, click Add New. The New User page opens.
In the User Type list, click User Without Mailbox.

In the Based on Template list, click AdministratorTemplate.

In the Alias field, enter an alias for the account.

Enter information in the optional fields, as applicable. (For field information, on the Help menu, click
This Page.)

Note that the SMTP Address field is optional in the sense that if you do not enter a value, Connection
uses the alias to form the SMTP address. However, the SMTP address cannot include non-ASCII
characters. Thus, if the user alias contains non-ASCII characters, you must provide an acceptable SMTP
address.

Click Save. The administrator account is created, and the Edit User Basics page opens.

On the Edit User Basics page, enter additional information, as applicable. If you change any settings on
the page, click Save.

On the Edit menu, click Roles.

On the Edit Roles page, click a role name in the Assigned Roles or Available Roles fields, then click the
Up or Down arrow to move the role to the applicable field.

When the Assigned Roles field contains all of the applicable roles for the administrator, click Save.
On the Edit menu, click Password Settings.

On the Edit Password Settings page, enter settings for the password that the administrator uses when
accessing Connection Administration:

a. Verify that the User Must Change at Next Login check box is checked. When this check box is
checked, the administrator is required to change the password when logging on for the first time.

b. In the Authentication Rule list, click an applicable rule.
Click Save.
On the Edit Menu, click Change Password.

On the Change Password page, enter a password in the Password field. Note that the password must meet
the following requirements for password complexity:

¢ A minimum length requirement (as set on the Edit Authentication Rule page, in the Minimum
Credential Length field)

¢ Inclusion of at least one character from each of the following categories: upper-case letter,
lower-case letter, number, and symbol (~! @ #$ A& *“*,.:;?2-_()[1<>{}+=/\1])

e No characters repeated consecutively more than three times (for example, aaaaB1C9 is invalid)
¢ No inclusion of the alias or name of the administrator
Enter the password again in the Confirm Password field.

Click Save.
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Adding an End User Account to Access the Cisco Unity
Connection Greetings Administrator (User with Voice Mailbox)

)

Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Step 8
Step 9

Step 10
Step 11
Step 12
Step 13

Revised May 2009

The information in this section is not applicable to adding end user accounts in Cisco Unified
Communications Manager Business Edition (CMBE). Instead, see the “Creating User Accounts in a
Coresident Configuration” section on page 8-1.

In the following procedure, the role you assign to the user account that you add gives the user access to
the Cisco Unity Greetings Administrator. Although it is an administrative role, many of the user account
settings for administrators do not apply to these user accounts, as they do not have access to
Connection Administration.

To set up the Greetings Administrator, see the “Setting Up the Cisco Unity Greetings Administrator”
section in the “Managing Recorded Greetings and Recorded Names” chapter of the System
Administration Guide for Cisco Unity Connection.

To Add an Account for a Greetings Administrator

In Cisco Unity Connection Administration, click Users.
On the Search Users page, click Add New.
On the New User page, in the User Type list, click User With Mailbox.

In the Based on Template list, click an applicable template. You can use the default
VoiceMailUserTemplate, or you may want to create a user template specifically for this purpose.

Enter an alias, a first name and last name, and an extension.

Note that the SMTP Address field is optional in the sense that if you do not enter a value, Connection
uses the alias to form the SMTP address. However, the SMTP address cannot include non-ASCII
characters. Thus, if the user alias contains non-ASCII characters, you must provide an acceptable SMTP
address.

Click Save.

On the Edit User Basics page, enter additional information, as applicable. If you change any settings on
the page, click Save.

On the Edit menu, click Roles.

On the Edit Roles page, click Greeting Administrator in the Available Roles field, then click the Up
arrow to move it into the Assigned Roles field.

Click Save.
On the Edit menu, click Password Settings.
On the Edit Password Settings page, in the Choose Password list, verify that Voice Mail is selected.

Enter settings for the password that the Greetings Administrator uses when accessing Connection by
phone:

a. Verify that the User Must Change at Next Login check box is checked. When this check box is
checked, the Greetings Administrator is required to change the password when logging on for the
first time.

b. In the Authentication Rule list, click an applicable rule.
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Step14  Click Save.

Step15 On the Edit Menu, click Change Password.

Step 16  On the Change Password page, in the Choose Password list, verify that Voice Mail is selected.
Step17 Enter a password.

Step 18  Enter the password again in the Confirm Password field.

Step19 Click Save.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x



CHAPTER

Managing Contacts

A system contact is a type of user who does not have access to any Cisco Unity Connection features such
as voice messaging. A system contact can represent a person in your company who has a voice mail
account on another system, or a customer or vendor who does not need a voice mailbox, but who
frequently communicates with Connection users.

See the following sections for detailed information:
e How System Contacts Are Used, page 9-1
e Creating, Modifying, and Deleting Contact Templates, page 9-2
¢ Creating, Modifying, and Deleting Contacts, page 9-3
e Creating or Changing Alternate Names for Contacts, page 9-4
e SMTP Proxy Addresses, page 9-4

How System Contacts Are Used

If you have staff, vendors, or partners who do not have mailboxes on the system, but need to
communicate with users, we recommend that you create system contacts for them. System contacts are
available to all users, unlike personal contacts that would need to be set up individually for each user. In
addition, users are able to add the system contacts to their personal call routing rules and caller groups,
and can use voice commands to call the system contacts. Also, if the contact information changes, you
update it in only one place. Note the following details:

e VPIM Messaging—System contacts can be configured for VPIM messaging. These system contacts
represent users on other VPIM-compatible voice messaging systems. When system contacts have
been set up to represent the VPIM users, Connection users can send and receive messages to and
from the VPIM users on the other voice messaging systems.

¢ Directory Access—When you create system contacts in Cisco Unity Connection Administration
and enable them to be listed in the directory, they can then be accessed by users from the Connection
directory. This allows callers to transfer to the extension of the system contact.

e Name Dialing Access—Users have the ability to quickly and easily place phone calls to system
contacts when using the user speech recognition conversation—as long as the contact has transfers
enabled.

¢ Personal Call Transfer Rules—Users can add other users, system contacts, and personal contacts
to their personal call transfer rules and caller groups.
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Creating, Modifying, and Deleting Contact Templates

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1
Step 2

Step 3

Step 4

Step 1
Step 2

Step 3

Revised May 2009

Each system contact that you add in Cisco Unity Connection is based on a contact template. Settings
from the template are applied to the contacts as the contacts are created. Connection includes one
predefined contact template, which you can modify. You can also create new templates.

If Connection has more than one partition defined or is configured for VPIM Networking, you may want
to create a contact template for each partition, or for each VPIM location.

See the following procedures:
¢ To Create a Contact Template, page 9-2
e To Modify a Contact Template, page 9-2
e To Delete a Contact Template, page 9-2

To Create a Contact Template

In Cisco Unity Connection Administration, expand Templates, then click Contact Templates.
On the Search Contact Templates page, click Add New.
On the New Contact Template page, enter an alias and display name.

If the contact template will be used for VPIM contacts, in the Delivery Location list, select the applicable
delivery location.

Click Save.

To Modify a Contact Template

In Cisco Unity Connection Administration, expand Templates, then click Contact Templates.

On the Search Contact Templates page, click the display name of the contact template that you want to
modify.

N,

Note If the contact template that you want to modify does not appear in the search results table, set
the applicable parameters in the search fields at the top of the page, and click Find.

On the Edit Contact Template Basics page, change settings, as applicable. (For field information, on the
Help menu, click This Page.)

When you have finished changing settings on the Edit Contact Template Basics page, click Save.

To Delete a Contact Template

In Cisco Unity Connection Administration, expand Templates, then click Contact Templates.

On the Search Contact Templates page, check the check box next to the display name of the contact
template that you want to delete.

Click Delete Selected.
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Step 4

Creating, Modifying, and Deleting Contacts

Click OK.

Creating, Modifying, and Deleting Contacts

Note

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

Step 1
Step 2

Revised May 2009
When you have created contact templates, you are ready to create or modify contacts manually. See the
following procedures:

e To Create a Contact, page 9-3
e To Modify a Contact, page 9-3
e To Delete a Contact, page 9-4

In addition to manually creating, modifying, and deleting VPIM contacts, you can configure Cisco Unity
Connection to automatically update records in the VPIM contact directory based on information
contained in incoming VPIM messages. For details see the “Customizing VPIM Contact Directory
Update Settings” section in the “Using VPIM Networking” chapter of the System Administration Guide
for Cisco Unity Connection.

To Create a Contact

In Cisco Unity Connection Administration, click Contacts.
On the Search Contacts page, click Add New.

On the New Contact page, enter settings as applicable. (For field information, on the Help menu, click
This Page.)

N

W’(e Fields marked with * (an asterisk) are required.

Click Save.

On the Edit Contact Basics page, continue entering settings for the contact. (For field information, on
the Help menu, click This Page.)

When you have finished entering settings on the Edit Contact Basics page, click Save.

On the Edit menu, click any (or all) of the following related pages, to continue adding applicable settings
to the new contact:

e Alternate Names

e SMTP Proxy Addresses

To Modify a Contact

In Cisco Unity Connection Administration, click Contacts.

On the Search Contacts page, click the alias of the contact that you want to modify.

[ oL-17018-01
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Step 3

Step 4

Step 1
Step 2

Step 3
Step 4

~

Note If the contact that you want to modify does not appear in the search results table, set the
applicable parameters in the search fields at the top of the page, and click Find.

Change settings on the page, as applicable. When you have finished changing settings on the Edit
Contact Basics page, click Save.

On the Edit menu, click the applicable page to continue modifying settings for the contact. If you change
any of the settings on these pages, click Save before leaving the page.

To Delete a Contact

In Cisco Unity Connection Administration, click Contacts.

On the Search Contacts page, check the check box next to the alias of the contact that you want to delete.

~

Note If the contact that you want to delete does not appear in the search results table, set the applicable
parameters in the search fields at the top of the page, and click Find.

Click Delete Selected.
In the dialog box that opens, asking you to confirm the deletion, click OK.

Creating or Changing Alternate Names for Contacts

Alternate names are different versions of a name than what is listed in the corporate directory.

Cisco Unity Connection considers these names when a caller uses voice recognition to place a call. For
example, if a caller asks Connection to dial “Mary Jameson,” which was the maiden name of Mary
Brown, Connection references this information and connects the caller to this user. For details on using
alternate names for users or contacts, see the “Alternate Names” section on page 4-60.

SMTP Proxy Addresses

Note

Revised May 2009

Cisco Unity Connection uses SMTP proxy addresses to map the recipients of an incoming SMTP
message that is sent by a user from an IMAP client to the appropriate user or VPIM contact. If users use
IMAP clients to send, reply to, or forward messages to VPIM contacts on the Connection server, you
should configure each VPIM contact with any SMTP address that users might use to address to that
contact from their IMAP clients.

System contacts that are not associated with a VPIM location cannot receive SMTP messages that are
sent from IMAP clients through the Connection server; when this type of contact is included as a
message recipient, Connection handles the message to that recipient according to the option selected for
the System Settings > General Configuration > When a Recipient Cannot Be Found setting.
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SMTP Proxy Addresses I

For details on setting up Connection so that users can use IMAP clients to send, forward, or reply to
messages through the Connection server, see the “Configuring IMAP Settings” chapter of the System
Administration Guide for Cisco Unity Connection.

To Configure SMTP Proxy Addresses for Contacts

Step 1 In Cisco Unity Connection Administration, click Contacts.
Step2  On the Search Contacts page, click the alias of the applicable contact.

~

Note If the contact does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and click Find.

Step 3 On the Edit Contact Basics page, on the Edit menu, click SMTP Proxy Addresses.

Step4  On the SMTP Proxy Addresses page, click Add New.

Step5 In the SMTP Proxy Addresses table, enter an address in the SMTP Proxy Address column.
Step6  Repeat Step 4 and Step S for each address that you want to add.

Step7  When you are done adding addresses, click Save.
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Managing User Accounts in Bulk

When you need to manage multiple user accounts at once, Cisco Unity Connection offers a Bulk Edit
utility and the Bulk Administration Tool. See the following sections for more information:

e Using the Bulk Edit Utility to Manage User Accounts, page 10-1

e Using the Connection Bulk Administration Tool to Manage User Accounts and System Contacts,
page 10-1

Using the Bulk Edit Utility to Manage User Accounts

The Cisco Unity Connection Bulk Edit utility allows you to select large numbers of user accounts and
quickly make the same changes to all of them at one time. The procedure below tells you how to access
Bulk Edit from Cisco Unity Connection Administration. To learn how to use Bulk Edit to modify user
accounts for specific features and functionality, see the “Setting Up Features and Functionality That Are
Controlled by User Account Settings” chapter.

To Access the Cisco Unity Connection Bulk Edit Utility

Step 1 In Cisco Unity Connection Administration, expand Tools.

Step2  Click Bulk Edit Utility.

Using the Connection Bulk Administration Tool to Manage User
Accounts and System Contacts

Cisco Unity Connection

The Bulk Administration Tool allows you to create, update, and delete multiple user accounts or system
contacts at the same time by importing information contained in a comma separated value (CSV) file. In
addition, it allows you to export information about users or system contacts from Cisco Unity
Connection to a CSV file.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x
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Cisco Unified Communications Manager Business Edition (CMBE)

The Bulk Administration Tool allows you to create and delete multiple system contacts at the same time
by importing information contained in a comma separated value (CSV) file. In addition, it allows you to
export information about system contacts from Cisco Unity Connection to a CSV file.

To learn more about the tool, see the “Using the Cisco Unity Connection Bulk Administration Tool”
appendix.

To Access the Bulk Administration Tool

Step 1 In Cisco Unity Connection Administration, expand Tools.

Step2  Click Bulk Administration Tool.
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Creating Multiple User Accounts from Cisco
Unified Communications Manager Users

See the following sections:

¢ Adding Cisco Unity Connection Voice Mail Users (Cisco Unified CMBE Configurations Only),
page 11-1

e Importing Cisco Unified Communications Manager Users to Create Cisco Unity Connection Users
(Cisco Unified Communications Manager Version 5.x and Later), page 11-2

e Importing Cisco Unified Communications Manager Users to Create Cisco Unity Connection Users
(Cisco Unified Communications Manager Version 4.1(x) and Later 4.x Releases), page 11-2

Adding Cisco Unity Connection Voice Mail Users (Cisco Unified
CMBE Configurations Only)

Note

To add Cisco Unity Connection voice mail users to the system in a Cisco Unified Communications
Manager Business Edition configuration, import users from Cisco Unified Communications Manager.

You use the Tools > Import Users page in Cisco Unity Connection Administration to create multiple user
with voice mail accounts from Cisco Unified Communications Manager users. You can also import
application users into Connection without a voice mailbox.

Cisco Unified Communications Manager users must have a Primary Extension defined or they do not
appear on the Tools > Import Users page in Cisco Unity Connection Administration.

When user accounts are created this way, Connection takes the user Alias, Extension, First Name, and
Last Name from Cisco Unified CM, and fills in the remaining information from the user template that
you specify. Data from the fields that are taken from Cisco Unified CM cannot be modified by using
Connection Administration. Instead, the information must be changed in Cisco Unified Communications
Manager Administration.

The Synch Users page allows you to manually refresh information from Cisco Unified CM for voice mail
users who were created by using the Import Users page.

[ oL-17018-01
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Importing Cisco Unified Communications Manager Users to
Create Cisco Unity Connection Users (Cisco Unified
Communications Manager Version 5.x and Later)

Revised May 2009
N

Note  The information in this section is not applicable to importing Cisco Unified Communications Manager
users to create Cisco Unity Connection user accounts in Cisco Unified Communications Manager
Business Edition (CMBE). Instead, see the “Adding Cisco Unity Connection Voice Mail Users (Cisco
Unified CMBE Configurations Only)” section on page 11-1.

Because Connection requires an AXL server to access the Cisco Unified Communications Manager
database, an AXL server must be configured for the Cisco Unified CM server from which you are
importing users.

Prior to importing users, you must do the following on the Cisco Unity Connection server:

e Edit or add a user template. In the Phone System field for the template, select the Cisco Unified CM
server from which you are importing users.

e Configure an AXL server for the Cisco Unified CM server from which you are importing users. For
details on configuring AXL servers, see the “Managing the Phone System Integrations” chapter of
the System Administration Guide for Cisco Unity Connection.

You use the Tools > Import Users page in Cisco Unity Connection Administration to create multiple user
with voicemail accounts from Cisco Unified CM users.

Note  Cisco Unified Communications Manager users must have a Primary Extension defined or they do not
appear on the Tools > Import Users page in Cisco Unity Connection Administration.

When user accounts are created this way, Connection takes the user Alias, Extension, First Name, and
Last Name from Cisco Unified CM, and fills in the remaining information from the user template that
you specify. Data from the fields that are taken from Cisco Unified CM cannot be modified by using
Connection Administration. Instead, the information must be changed in Cisco Unified Communications
Manager Administration.

The Synch Users page allows you to manually refresh information from Cisco Unified CM for voice mail
users who were created by using the Import Users page.

Importing Cisco Unified Communications Manager Users to
Create Cisco Unity Connection Users (Cisco Unified
Communications Manager Version 4.1(x) and Later 4.x Releases)

Revised May 2009

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x


message URL http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsag240.html

| Chapter 11

Creating Multiple User Accounts from Cisco Unified Communications Manager Users

Note

Importing Cisco Unified Communications Manager Users to Create Cisco Unity Connection Users (Cisco Unified ||

The information in this section is not applicable to importing Cisco Unified Communications Manager
users to create Cisco Unity Connection user accounts in Cisco Unified Communications Manager
Business Edition (CMBE). Instead, see the “Adding Cisco Unity Connection Voice Mail Users (Cisco
Unified CMBE Configurations Only)” section on page 11-1.

When Cisco Unity Connection is integrated with Cisco Unified Communications Manager version
4.1(x) and later 4.x releases, Cisco Unified CM administrators can create regular individual Cisco Unity
Connection user accounts (referred to as voice mailboxes in Cisco Unified CM) from either the
Directory Number Configuration page or the User Configuration page of the Cisco Unified CM
Administration. Connection user accounts are then created by using browser-encrypted secure
transmission of credentials across the network.

When user accounts are created by importing users from Cisco Unified CM, the accounts contain the
minimum setup data that is provided by the Connection user template that is chosen. If any customization
of the user account is necessary beyond what this template provides, you complete the customization by
using Cisco Unity Connection Administration. Note that after the accounts are created, there is no
automatic synchronization of user data between Connection and Cisco Unified CM. Any changes to user
accounts that exist in both systems, and that must be kept synchronized, need to be made manually in
both systems.

To create Connection accounts by importing Cisco Unified CM users, do the tasks in the following
sections, in the order presented:

1. Setting Up the Cisco Unity Connection Logon Account and Environment (Cisco Unified CM
Version 4.1(x) and Later 4.x Releases), page 11-3

2. Creating a Cisco Unity Connection Voice Mailbox in Cisco Unified CM Administration (Cisco
Unified CM Version 4.1(x) and Later 4.x Releases), page 11-4

Setting Up the Cisco Unity Connection Logon Account and Environment (Cisco
Unified CM Version 4.1(x) and Later 4.x Releases)

Step 1

Step 2

Step 3

Step 4

Do the following procedure to set up the voice mailbox creation environment on Cisco Unity Connection
and on Cisco Unified Communications Manager.

To Set Up the Cisco Unity Connection Logon Account and Environment

Complete the setup and integration of Cisco Unity Connection and Cisco Unified CM version 4.1(x)
according to instructions in the Installation Guide for Cisco Unity Connection, the Cisco Unity
Connection integration guide, and other applicable Cisco documentation.

Confirm that the Connection user templates for creating a user with a voice mailbox have been set up
and are ready for use.

Confirm that the Connection voice mail ports have been configured in Cisco Unified Communications
Manager:

a. In Cisco Unified CM Administration, click Feature > Voice Mail > Cisco Voice Mail Port.

b. Enter search criteria and click Find. The Connection voice mail ports should list the Cisco
Unified CM to which they are registered and the IP address of the Connection server.

Confirm that Cisco Unified CM and Connection have been physically deployed on the same side of the
firewall.
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Step 5

Step 6

Step 7

Step 8

Step 9

Confirm that Cisco Unity Connection Administration can be accessed by IP address. From the Cisco
Unified CM server, open a web browser and browse to https://<Connection IP Address>/cuadmin.

In the Cisco Unified CM Administration application, browse to Cisco Unified CM Serviceability >
Tools > Control Center, click the Cisco Unified CM server name, and confirm that the RIS data
collector is activated and running.

Download the Voicemailbox.asp file from the Connection server. It is available from
https://<Connection server name>/concerto.

Copy the Voicemailbox.asp file from the Connection server to the C:\CiscoWebs\Admin directory on
the Cisco Unified CM server.

In Cisco Unity Connection Administration, create a new user with the User Administrator role. The
username and password for this user must be identical to the username and password of the Cisco
Unified Communications Manager account you use to log on to the Cisco Unified CM Administration
application.

Creating a Cisco Unity Connection Voice Mailbox in Cisco Unified CM
Administration (Cisco Unified CM Version 4.1(x) and Later 4.x Releases)

Step 1
Step 2

Note that Integrated Mailbox Configuration prompts you to authenticate with a user name and password
once per session. If authentication succeeds, you are not prompted to reauthenticate as long as you
remain logged in to Cisco Unified CM Administration.

To Create a Cisco Unity Connection Voice Mailbox by Using Cisco Unity Cisco Unified CM Integrated Mailbox
Configuration

Log on to the Cisco Unified CM Administration application.
Do one of the following sets of sub-steps:
To create a voice mailbox from the User Configuration page:

a. Click User > Global Directory. The User Information page opens.

b. Search for a user. To see a list of all users, leave the User Search dialog box empty, and click Search.

¢. From the list of users, click the name of the applicable user. The User Configuration page opens.

d. Click the Create Voice Mailbox link that appears next to the Primary Extension.

~

Note  The Create Voice Mailbox link does not appear unless the Voice Mail Profile for the user is
associated with the Primary Extension Directory Number.

e. Continue with Step 3.
To create a voice mailbox from the Directory Number Configuration page:
a. Click Device > Phone. The Find and List Phones page opens.

b. Search for a phone device. To see a list of all phone devices, leave the search dialog box empty, and
click Find.

¢. From the list of devices, click the name of the applicable device. The Phone Configuration page
opens.
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Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Step 9

Importing Cisco Unified Communications Manager Users to Create Cisco Unity Connection Users (Cisco Unified ||

d. From the list of Directory Numbers on the left side of the page, click the applicable Base Phone. The
Directory Number Configuration page opens.

e. Click the Create Voice Mailbox link that appears in the top right corner of the page.

~

Note  The Create Voice Mailbox link does not appear unless you have previously configured a Voice
Mail Profile setting to either include a pilot number or to specify None as the pilot number. If
the Voice Mail Profile is set to No Voice Mail, the Create Voice Mailbox link does not appear.

f. Continue with Step 3.

If the Enter Network Password screen appears, enter your Cisco Unified CM Integrated Mailbox
Configuration administrator name and password.

Confirm that the Extension, Alias, First Name, Last Name, and Display Name for the voice mailbox
are as you want them to appear in Connection. Make changes if necessary.

If no Display Name is entered, one is created based on the Connection user template settings.

From the drop-down menu, select the Voice Mailbox Template to be applied to the voice mailbox.
Integrated Mailbox Configuration allows you to select from a list of templates for creating a user with a
voice mailbox; you cannot select a template for creating a user without a voice mailbox.

Confirm the List in Directory status. By default, this check box is checked, which overrides the setting
on the user template.

Click Insert. The voice mailbox is added to Connection.

Confirm that the voice mailbox data is correct. If you made a mistake, click Delete and repeat this
procedure, beginning with Step 2.

Click Close.
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Creating User Accounts from LDAP User Data

To create Cisco Unity Connection user accounts from LDAP user data, you use one of the following
methods:

e If you are creating a small number of users (a few hundred or fewer) and if you were able to create
a regular expression to convert LDAP phone numbers into Connection extensions, you can use the
Import Users tool. This is commonly the best option when you are creating a few Connection users
at a time for new employees. See the “Creating Cisco Unity Connection Users from LDAP Data by
Using the Import Users Tool” section on page 12-1.

e If you are creating a larger number of users or if you were not able to create a regular expression to
convert LDAP phone numbers into Connection extensions, export user data to a CSV file by using
the Bulk Administration Tool, reformat the data by using a spreadsheet application (if necessary),
and import the data by using the Bulk Administration tool. See the “Creating Cisco Unity
Connection Users from LDAP Data by Using the Bulk Administration Tool” section on page 12-2.

You can also integrate existing Connection user accounts with LDAP user accounts. See the “Integrating
Existing Cisco Unity Connection User Accounts with LDAP User Accounts” section on page 12-4.

Creating Cisco Unity Connection Users from LDAP Data by Using
the Import Users Tool

A

When you configured Cisco Unity Connection to integrate with an LDAP directory by using the
procedures in the “Integrating Cisco Unity Connection with an LDAP Directory” chapter of the System
Administration Guide for Cisco Unity Connection, you synchronized Connection data with data in the
LDAP directory. That process invisibly imported the LDAP data into a hidden Cisco Unified
Communications Manager database on the Connection server. When you use the Import Users tool to
create Connection users, you import the data from the Cisco Unified CM database into the Connection
database. (Connection 7.x uses the Cisco Unified CM LDAP implementation to integrate with an LDAP
directory.)

Caution

When you entered values in the LDAP Setup page, you selected a field in the LDAP directory that would
be imported into the User ID field in the hidden Cisco Unified CM database and, from there, into
Connection. The LDAP field that you chose must have a value for every user in the LDAP directory. In
addition, every value for that field must be unique. Any LDAP user who does not have a value in the
field you choose cannot be imported into Connection.

[ oL-17018-01
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I Creating Cisco Unity Connection Users from LDAP Data by Using the Bulk Administration Tool

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

Step 7
Step 8
Step 9

When you create user accounts this way, Connection takes data from the LDAP fields that you specified
on the LDAP Directory Configuration page, and fills in the remaining information from the user template
that you specify. You cannot use Connection Administration to change data in the fields whose values
come from the LDAP directory. Instead, you must change the values in the LDAP directory.

If you have configured Connection to periodically resynchronize Connection data with LDAP data, new
values in the LDAP directory are automatically imported into the Connection database during the next
automatic resync. However, if new users have been added to the LDAP directory, this resynchronization
does not create new Connection users. You must manually create new Connection users by using either
the Import Users tool or the Bulk Administration Tool.

To Create Cisco Unity Connection Users by Importing LDAP User Data

Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.
When a cluster is configured, log on to the publisher server.

Expand Tools and click Import Users.

In the Find Unified Communications Manager End Users In list, click LDAP Directory.

If you want to import only a subset of the users in the LDAP directory with which you have integrated
Connection, enter the applicable specifications in the search fields.

Click Find.

In the Based on Template list, choose the template that you want Connection to use when creating the
selected users.

~

Note If you are importing a large number of users, you can change the number of rows (users) that are
displayed on each page.

Check the check boxes for the LDAP users for whom you want to create Connection users.
If necessary, enter extensions for the users that you want to create.

Click Import Selected.

Creating Cisco Unity Connection Users from LDAP Data by Using
the Bulk Administration Tool

Revised May 2009

When you configured Cisco Unity Connection to integrate with an LDAP directory by using the
procedures in the “Integrating Cisco Unity Connection with an LDAP Directory” chapter of the System
Administration Guide for Cisco Unity Connection, you synchronized Connection data with data in the
LDAP directory. That process invisibly imported the LDAP data into a hidden Cisco Unified
Communications Manager database on the Connection server. (Connection 7.x uses the Cisco

Unified CM LDAP implementation to integrate with an LDAP directory.)

When you use the Bulk Administration Tool to create Connection users, you:

1. Export the data from the Cisco Unified CM database into a CSV file.
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Step 2
Step 3

Step 4

Step 5

Creating Cisco Unity Connection Users from LDAP Data by Using the Bulk Administration Tool

2. Update the CSV file. For example, you may use a formula in a spreadsheet application to convert
the phone number that was exported from the LDAP directory into a Connection extension.

A

Caution  If any users in the LDAP directory were missing values in the field that you specified on the
LDAP Setup page in the LDAP Attribute for User ID list, you must add the missing values in
the LDAP directory and resynchronize the Connection database with the LDAP directory. Do
not enter the values in the CSV file and then import the CSV file; Connection is not able to
locate those users in the LDAP directory.

3. Import the updated CSV file back into the Connection database.

When you create user accounts this way, Connection takes data from the CSV file and fills in the
remaining information from the user template that you specify. You cannot use

Connection Administration to change data in the fields whose values come from the LDAP directory.
Instead, you must change the values in the LDAP directory.

If you have configured Connection to periodically resynchronize Connection data with LDAP data, new
values in the LDAP directory are automatically imported into the Connection database during the next
automatic resynchronization. However, if new users have been added to the LDAP directory, this
resynchronization does not create new Connection users. You must manually create new Connection
users by using either the Import Users tool or the Bulk Administration Tool.

To Create Cisco Unity Connection Users by Using the Bulk Administration Tool

Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.
Expand Tools and click Bulk Administration Tool.

Export the data that is currently in the hidden Cisco Unified CM database on the Connection server:
a. Under Select Operation, click Export.

b. Under Select Object Type, click Users from LDAP Directory.

c¢. In the CSV File field, enter the full path to the file in which you want to save exported data.

d. Click Submit.

Open the CSV file in a spreadsheet application or in a text editor, and update the data as applicable. For
more information, see the “Using the Cisco Unity Connection Bulk Administration Tool” section on
page A-1.

Import the data in the updated CSV file:

a. Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.
b. Expand Tools and click Bulk Administration Tool.

¢. Under Select Operation, click Create.

d. Under Select Object Type, click Users with Mailbox.

e. In the CSV File field, enter the full path to the file from which you want to import data.

f. In the Failed Objects Filename field, enter the full path of the file to which you want Connection to
write error messages about users who could not be created.

g. Click Submit.
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I Integrating Existing Cisco Unity Connection User Accounts with LDAP User Accounts

Step6  When the import is complete, review the file that you specified in the Failed Objects Filename field to
verify that all users were created successfully.

Integrating Existing Cisco Unity Connection User Accounts with
LDAP User Accounts

Added May 2009

When you configured Cisco Unity Connection to integrate with an LDAP directory by using the
procedures in the “Integrating Cisco Unity Connection with an LDAP Directory” chapter of the System
Administration Guide for Cisco Unity Connection, you synchronized Connection data with data in the
LDAP directory. That process invisibly imported the LDAP data into a cache on the Connection server.

When you use the Bulk Administration Tool to integrate existing Connection users with LDAP users,
you:

1. Export the data from the cache into a CSV file.

2. Remove from the CSV file any users who you do not want to synchronize with users in the LDAP
directory.

3. Import the updated CSV file into the Connection database, which synchronizes Connection users
with LDAP users and sets the LDAP flag in the Connection database to “yes.”

A

Caution  When you import LDAP user data into the Connection database, existing values for the fields
being imported are overwritten with values from the LDAP database.

If you have configured Connection to periodically resynchronize Connection data with LDAP data, new
values in the LDAP directory are automatically imported into the Connection database during the next
automatic resynchronization. However, if new users have been added to the LDAP directory, this
resynchronization does not create new Connection users. You must manually create new Connection
users by using either the Import Users tool or the Bulk Administration Tool.

To Integrate Existing Cisco Unity Connection Users with LDAP Users

Step1  Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.
Step2  Expand Tools and click Bulk Administration Tool.
Step3  Export the data that is currently in the cache on the Connection server:

a. Under Select Operation, click Export.

b. Under Select Object Type, click Users from LDAP Directory.

c¢. In the CSV File field, enter the full path to the file in which you want to save exported data.

d. Click Submit.

This exports LDAP user data from the cache and sets the LDAP-integrated flag in the CSV file to “yes.”

Step4  Edit the CSV file to remove any Connection users who you do not want to synchronize with users in the
LDAP directory. For more information, see the “Using the Cisco Unity Connection Bulk Administration
Tool” section on page A-1.

If you want every user in the LDAP directory to be a Connection user, you skip this step.
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Step5 Import the data that you edited in Step 4:
a. Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.
b. Expand Tools and click Bulk Administration Tool.

Under Select Operation, click Update.

Ll

Under Select Object Type, click Users with Mailbox.
e. In the CSV File field, enter the full path to the file from which you want to import data.

f. In the Failed Objects Filename field, enter the full path of the file to which you want Connection to
write error messages about users who could not be created.

g. Click Submit.

Step6  When the import is complete, review the file that you specified in the Failed Objects Filename field to
verify that all Connection users were successfully integrated with the corresponding LDAP users.

User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x
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Modifying or Deleting Individual User Accounts

After a Cisco Unity Connection user account has been created, you may need to adjust settings (for
example, to reset a user password, or to set up new notification devices for the user), or to delete the
account.

See the following sections:
e Modifying Individual User Accounts, page 13-1
e Deleting Individual User Accounts, page 13-2

Modifying Individual User Accounts

Revised May 2009
You modify settings for an individual user account from the pages available on the Edit menu in
Cisco Unity Connection Administration.

Note that if you change the alias for a user, Connection automatically creates an SMTP proxy address
for the previous alias. This allows other Connection users to reply to messages that were sent from the
previous alias and have the replies reach the user at the new alias. When Connection is integrated with
an LDAP directory, the Alias field in Connection cannot be changed for any user who is integrated with
an LDAP user. However, if you are using Active Directory as the LDAP directory, you can change the
value of the LDAP field that is mapped to the Alias field, and the change is replicated to Connection the
next time the Connection database is synchronized with the LDAP directory. This also causes
Connection to automatically create an SMTP proxy address for the previous alias.

A

Caution  If you are using an LDAP directory other than Active Directory and you change the value of
the LDAP field that is mapped to the Connection Alias field, the Connection user will be
converted to a non-LDAP-integrated user.

In the following configurations, you cannot edit fields such as Alias (User ID in Cisco Unified
Communications Manager Administration), First Name, Last Name, Extension (Primary Extension in
Cisco Unified CM Administration), and so on:

¢ In Cisco Unified Communications Manager Business Edition, when the Connection user is
integrated with the Cisco Unified Communications Manager Application User. You can only update
these fields in Cisco Unified CM Administration.

¢ In Connection or in Cisco Unified CMBE, when Connection user data is synchronized with data in
an LDAP directory. You can only update these fields in the LDAP directory.

[ oL-17018-01
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Step 1
Step 2

Step 3
Step 4

~

Note  If Connection is configured to authenticate Connection web application user names and
passwords against the LDAP directory, you cannot change the Connection web application
password.

¢ In Connection, if Digital Networking is configured, you cannot edit any fields for a user on servers
other than the home server of the user. You must edit user settings on the server on which the user
account was created.

For information on moving mailboxes from one mailbox store to another, see the “Managing Mailbox
Stores” chapter of the System Administration Guide for Cisco Unity Connection.

Do the following procedure to modify user account settings.

To Modify a User Account

In Cisco Unity Connection Administration, click Users.

On the Search Users page, click the alias of the user account that you want to modify.

~

Note If the user does not appear in the search results table, set the applicable parameters in the search
fields at the top of the page, and click Find.

On the Edit User Basics page, change the applicable settings. When you have finished, click Save.

On the Edit menu, click the applicable page to continue modifying settings for the user account. If you
change any of the settings on these pages, click Save before leaving the page.

For details on the features and functionality available on the Edit menu pages for a user account, see the
“Setting Up Features and Functionality That Are Controlled by User Account Settings” chapter.

Deleting Individual User Accounts

~

Note

Revised May 2009

In Cisco Unified Communications Manager Business Edition (CMBE), you delete Cisco Unity
Connection user accounts in Cisco Unified CM Administration. (Use the applicable User Management
page to find the user or application user, then delete.)

To learn more about deleting Connection accounts in Cisco Unified CM Administration, see the online
Help or the “End User Configuration” and “Application User Configuration” chapters of the applicable
Cisco Unified Communications Manager Administration Guide. The guide is available at
http://www.cisco.com/en/US/products/ps7273/prod_maintenance_guides_list.html.

When a user leaves the organization or otherwise no longer needs a Cisco Unity Connection account,
delete the account in Cisco Unity Connection Administration.
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Deleting Individual User Accounts 1
Note the following considerations for deleting an account:

e If a user account is referenced by other objects in Connection (for example, if the user is set to be a
recipient of messages left in an interview handler, or if a call handler is set to transfer incoming calls
to the user phone), you are not allowed to delete the user account until you have changed settings
on the other objects to remove references to the user account you want to delete. If you try to delete
a user account without first changing settings on objects that reference the user account, the delete
operation fails.

¢ An administrator is prohibited from deleting his or her own account.

e When you delete the account of a user with a voice mailbox, that user is automatically deleted from
the All Voice Mail Users distribution list.

e If the account for a user has a voice mailbox, and if the mailbox store for that voice mailbox is
disabled (for example, because the mailbox store is being backed up), the user account cannot be
deleted.

The behavior is different when Connection or Cisco Unified CMBE is integrated with an LDAP
directory:

e If Connection is integrated with an LDAP directory, you must delete the user both in the LDAP
directory and in Connection. If you delete the user only in Connection, the LDAP user is unaffected.
If you delete the user only in the LDAP directory, in Connection Administration, the Status area on
the Edit User Basics page for that user indicates that the Connection user is inactive. The status
cannot be changed manually, but after 48 hours, the user is automatically converted to a regular
Connection user, and the message in the Status area no longer appears.

Connection functionality is mostly unaffected by the deletion of an LDAP user. However, if you use
LDAP authentication for Connection web applications or for IMAP access to Connection voice
messages, the user cannot access Connection web applications for the 48 hours after the LDAP user
is deleted and before the Connection user is converted to a regular Connection user. After 48 hours,
you must enter a new web application password for the user in Connection Administration.

e If Cisco Unified CMBE is integrated with an LDAP directory, you must start by deleting the LDAP
user that corresponds with the Connection user. When Cisco Unified CM data is next synchronized
with the LDAP directory, the user is deleted from the Cisco Unified CM database. When the user no
longer appears in Cisco Unified CM Administration, you can use Connection Administration to
delete the user from the Connection database.

A
Note  If LDAP synchronization is not enabled and if you do not manually synchronize Cisco
Unified CM data with the LDAP directory, the deletion of an LDAP user is never replicated to
the Cisco Unified CM database, and the corresponding Connection user cannot be deleted.
To Delete an Individual User Account in Cisco Unity Connection Administration
Step1  In Cisco Unity Connection Administration, click Users.
Step2  On the Search Users page, click the alias of the user account that you want to delete.
>
Note  If the user does not appear in the search results table, set the applicable parameters in the search
fields at the top of the page, and click Find.
Step3  Click Delete Selected.
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x
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Step4  In the dialog box that opens, asking you to confirm the deletion, click OK.
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Using the Cisco Unity Connection Bulk
Administration Tool

The Cisco Unity Connection Bulk Administration Tool (BAT) allows you to create, update, and delete
multiple user accounts or system contacts by importing information contained in a comma separated
value (CSV) file. In addition, it allows you to export information about users or system contacts from
Cisco Unity Connection to a CSV file. When Cisco Unity Connection is running as part of Cisco Unified
Communications Manager Business Edition (CMBE), you cannot create, update, or delete users with
BAT. Modifications to users must be done in Cisco Unified Communications Manager Administration.

CSV is a common text file format for moving data from one data store to another. For example, importing
from a CSV file can be useful for transferring information from a corporate directory to Cisco Unity
Connection. Transferring the information allows users with voice mailboxes to add corporate directory
users who are not Connection users to their address books and to then create call-routing rules based on
calls from such contacts.

See the following sections for detailed information and instructions on using BAT:
e Creating User Accounts, page A-1
e Creating System Contacts, page A-2
e Updating User Accounts, page A-3
e Updating System Contacts, page A-3
e Deleting User Accounts, page A-4
e Deleting System Contacts, page A-5
e Exporting Users to a CSV File, page A-5
e Exporting System Contacts to a CSV File, page A-6
e Constructing the Input CSV Files, page A-6
e Correcting Errors by Using the Failed Objects File, page A-26

Creating User Accounts

~

Note

Revised February 23, 2011

The information in this section is not applicable to creating user accounts in Cisco Unified
Communications Manager Business Edition (CMBE). See the “Creating User Accounts in a Coresident
Configuration” section on page 8-1.
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I Creating System Contacts

BAT allows you to create Cisco Unity Connection user accounts (with or without voice mailboxes) from
a CSV file. See the “Constructing the Input CSV Files” section on page A-6 as you create the CSV file.

Note  Before you use BAT to add voice mail users to the system, confirm that the required Connection licenses
are available for the new user accounts. You can view the number of licenses purchased, and the number
that are used and unused on your system, from Cisco Unity Connection Administration. If you need
additional licenses, contact your reseller.

To Create User Accounts

Step 1 In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
Step 2 In the Select Operation section, click Create.
Step3  In the Select Object Type section, click the applicable option:

e Click Users to create users without voice mailboxes.

¢ Click Users With Mailbox to create accounts with mailboxes.
Step4  In the Override CSV Fields When Creating User Accounts section, click the applicable option.
Step 5 In the Select File section, in the CSV File field, enter the full path.

Step6  In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rrors.csv.

Step7  Click Submit.
BAT begins creating user accounts and displays the summary page when the operation has completed.

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.

Creating System Contacts

Revised February 23, 2011
BAT allows you to create Cisco Unity Connection system contacts from a CSV file. See the
“Constructing the Input CSV Files” section on page A-6 as you create the CSV file.

To Create System Contacts

Step 1 In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
Step 2 In the Select Operation section, click Create.

Step3  In the Select Object Type section, click System Contacts.

Step 4 In the Select File section, in the CSV File field, enter the full path to the CSV input file.

Step5 In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rTors.csv.

Step6  Click Submit.

BAT begins creating contacts and displays the summary page when the operation has completed.
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Updating User Accounts Il

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.

Updating User Accounts

~

Note

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Revised February 23, 2011

The information in this section is not applicable to updating user accounts in Cisco Unified
Communications Manager Business Edition (CMBE). See the “Creating User Accounts in a Coresident
Configuration” section on page 8-1.

BAT allows you to update Cisco Unity Connection user accounts (with or without voice mailboxes) with
information from a CSV file. See the “Constructing the Input CSV Files” section on page A-6 as you
create the CSV file.

To Update User Accounts

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
In the Select Operation section, click Update.
In the Select Object Type section, click the applicable option:
¢ Click Users to update users without voice mailboxes.
¢ Click Users With Mailbox to update accounts with mailboxes.
In the Select File section, in the CSV File field, enter the full path to the CSV input file.

In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rTOors.CSV.

Click Submit.
BAT begins updating user accounts and displays the summary page when the operation has completed.

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.

Updating System Contacts

Step 1

Revised February 23, 2011
BAT allows you to update Cisco Unity Connection system contacts with information from a CSV file.
See the “Constructing the Input CSV Files” section on page A-6 as you create the CSV file.

To Update System Contacts

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
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I Deleting User Accounts

Step 2
Step 3
Step 4
Step 5

Step 6

In the Select Operation section, click Update.
Click System Contacts.
In the Select File section, in the CSV File field, enter the full path to the CSV input file.

In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rTors.csv.

Click Submit.
BAT begins updating contacts and displays the summary page when the operation has completed.

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.

Deleting User Accounts

N

Note

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Revised February 23, 2011

The information in this section is not applicable to deleting user accounts in Cisco Unified
Communications Manager Business Edition (CMBE). See the “Creating User Accounts in a Coresident
Configuration” section on page 8-1.

BAT allows you to delete Cisco Unity Connection user accounts (with or without voice mailboxes) that
are listed in a CSV file. See the “Constructing the Input CSV Files” section on page A-6 as you create
the CSV file.

To Delete User Accounts

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
In the Select Operation section, click Delete.
In the Select Object Type section, click the applicable option:
e Click Users to delete users without voice mailboxes.
e Click Users With Mailbox to delete accounts with mailboxes.
In the Select File section, in the CSV File field, enter the full path to the CSV input file.

In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rTors.csv.

Click Submit.
BAT begins deleting user accounts and displays the summary page when the operation has completed.

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.
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Deleting System Contacts

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Revised February 23, 2011
BAT allows you to delete Cisco Unity Connection system contacts listed in a CSV file. See the
“Constructing the Input CSV Files” section on page A-6 as you create the CSV file.

To Delete System Contacts

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
In the Select Operation section, click Delete.

In the Select Object Type section, click System Contacts.

In the Select File section, in the CSV File field, enter the full path to the CSV input file.

In the Failed Objects Filename field, enter the name of the failed objects report file. For example, enter
€rTOrSs.CSV.

Click Submit.
BAT begins deleting contacts and displays the summary page when the operation has completed.

If the operation results in any failures, you can immediately inspect the failed objects report file by
clicking Download the Failed Objects File. For information about correcting errors, see the “Correcting
Errors by Using the Failed Objects File” section on page A-26.

Exporting Users to a CSV File

Step 1
Step 2
Step 3

Step 4
Step 5

BAT allows you to export information about all users (with or without voice mailboxes) from
Cisco Unity Connection to a CSV file.

To Export Users to a CSV File

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
In the Select Operation section, click Export.
In the Select Object Type section, click the applicable option:
e Click Users to update users without voice mailboxes.
e Click Users With Mailbox to update accounts with mailboxes.
In the Select File section, in the CSV File field, enter the full path to the applicable file.
Click Submit.

The Summary page displays the results when the operation has completed. To view the export CSV file,
click View Export Objects File.

[ oL-17018-01
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Exporting System Contacts to a CSV File

Step 1
Step 2
Step 3
Step 4
Step 5

BAT allows you to export information about system contacts from Cisco Unity Connection to a CSV file.

To Export System Contacts to a CSV File

In Cisco Unity Connection Administration, expand Tools, then click Bulk Administration Tool.
In the Select Operation section, click Export.

In the Select Object Type section, click System Contacts.

In the Select File section, in the CSV File field, enter the full path to the applicable file.

Click Submit.

The Summary page displays the results when the operation has completed. To view the export CSV file,
click View Export Objects File.

Constructing the Input CSV Files

BAT supports only UTF-8 and UTF-16 character set encoding for the text in the CSV file.

To quickly construct an input CSV file, you can use BAT to export the applicable type of user or contact,
and use the resulting output CSV file as a template.

The following example shows a CSV file for creating voice mail users. To construct the file, voice mail
users were exported to a CSV file. Then, unwanted columns and data were removed from the file. Finally,
the TemplateAlias column and the applicable data were added. (Note that the data for DisplayName—an
optional field—is missing for several users.)

Example CVS Input File for Creating Voice Mail Users

Alias,DisplayName,FirstName,LastName, TemplateAlias,Extension,ListInDirectory
iwinkler,"Winkler, Ian",Ian, Winkler, VoiceMailUserTemplate,5321,1
jsmith,,John,Smith,VoiceMailUserTemplate,5126,1

cjones,"Jones, Cris",Cris,Jones, VoiceMailUserTemplate,5249,1
dalbert,,Dan,Albert, VoiceMailUserTemplate,5299, 1

jlee,"Lee, Jane",Jane,Lee,VoiceMailUserTemplate,5324,1
jthompson,"Thompson, Jim",Jim,Thompson, VoiceMailUserTemplate,5029,1
swong,"Wong, Sara",Sara,Wong,VoiceMailUserTemplate,5260,1
rhunter,"Hunter, Russ",Russ,Hunter, VoiceMailUserTemplate,5229, 1
cashmore,,Carol,Ashmore, VoiceMailUserTemplate,5403,1

lIcarson,"Carson, Lauren",Lauren,Carson, VoiceMailUserTemplate,5999, 1

Whether you modify an output CSV file or create a CSV file from scratch, use the following guidelines,
along with the tables in the “Required and Optional CSV Fields” section on page A-7 to construct a valid
input CSV file for use with the BAT:

e The first row in your CSV file must contain column headings that identify the type of data in each
column; information in the subsequent rows must contain the data that you want to import.

e Ensure that commas separate the data in each row in your CSV file, including the column headings
in the first row. Do not use a tab, spaces, or a semicolon to separate values in the file.
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e Although the data must be arranged in the same order as the column heading, the order in which you
arrange the columns is unimportant.

e If the CSV file includes a column that you want BAT to ignore, use the column heading “Junk.”
e If any data includes a space, quotes, or commas, contain it within quotes.

We recommend that your data not include double-quotes because it can cause problems with
interactions with external servers. If the data does include double-quotes, place an additional
double-quote next to each double-quote. For example, if the data is My “Spare Phone”, the entry

9999

must be My ““Spare Phone””.

e Column headings are not case sensitive, but they must be spelled as indicated in the tables in the
“Required and Optional CSV Fields” section on page A-7. Columns that are designated not
applicable (N/A) for an operation are ignored.

e (Standalone Configurations Only) For creating user accounts, most optional fields that are listed in
the CSV field tables correspond to settings defined in a user template. For example, for voice mail
users, the default template includes class of service (COS), call transfer, and message notification
settings. When data for a particular user setting is not included in the CSV file, BAT uses settings
in the user template that you specify in the required field TemplateAlias. For this reason, you should
review the settings in the user template that you use to create the accounts before adding any of the
optional column headers to your CSV file. If a value for an optional field is not included in the CSV
file, and if the template does not specify a default value, then the value for the field is not set.

e To explicitly set the value of a field to empty (or to null, if allowed), use the expression %null% for
the value in the CSV file.

¢ We recommend that you do not include more than 5,000 records in an input CSV file.

Required and Optional CSV Fields

Revised May 2009
The tables in this section list the required and optional fields, as applicable, to include in input CSV files.
The fields are listed in alphabetical order, except for the required fields, which are listed first.

Use the applicable table, depending on the type of object:
e Users Without Voice Mailboxes—Table A-1
e Users With Voice Mailboxes—Table A-2
e System Contacts—Table A-3

Table A-1 Required and Optional CSV Fields for Users Without Voice Mailboxes

Column Heading Creating |Updating |Deleting |Description

Alias Required |Required |Required |The unique text name for the user account.
Any combination of ASCII or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, ", &, -, _,", up to a maximum of 64 characters.

TemplateAlias Required |N/A N/A The unique text name for the user template to apply to the

account during creation.
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Table A-1 Required and Optional CSV Fields for Users Without Voice Mailboxes (continued)

Column Heading Creating |Updating |Deleting |Description

Address Optional |Optional |N/A The physical address such as a house number and street name
where the user is located, or with which the user is associated.
Any combination of ASCII or Unicode characters, up to a
maximum of 128 characters.

AltFirstName Optional |Optional |[N/A An alternate spelling of the user first name in an internationally
recognizable format (i.e., ASCII only characters). The value is
used by the telephone interface to search for users and to address
messages.

Any combination of ASCII alphanumeric characters, up to
maximum of 64 characters.

AltLastName Optional |Optional |N/A An alternate spelling of the user last name in an internationally
recognizable format (i.e., ASCII only characters). The value is
used by the telephone interface to search for users and to address
messages.

Any combination of ASCII alphanumeric characters, up to
maximum of 64 characters.

Billingld Optional |Optional |[N/A Organization-specific information about the user, such as
accounting information, department names, or project codes.
The information can be included in user reports.

Any combination of ASCII or Unicode characters, up to a
maximum of 32 digits.

Building Optional |Optional |N/A The name of the building where the user is based.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

City Optional |Optional |N/A The name of a locality, such as a city, county or other geographic
region where the user is located, or with which the user is
associated.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

Country Optional |Optional |[N/A The 2-letter ISO 3166-1 country code where the user is located,
or with which the user is associated.

Two ASCII lower or upper case alpha characters.

Department Optional |Optional |N/A The name or number for the department or subdivision of an
organization to which the user belongs.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

Directoryld Optional |Optional |[N/A The unique identifier for the user in the corporate or
organization directory (for example, in Active Directory, if
Active Directory is used).

Any combination of ASCII alphanumeric characters, up to a
maximum of 256 characters.
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Table A-1 Required and Optional CSV Fields for Users Without Voice Mailboxes (continued)

Column Heading Creating |Updating |Deleting |Description

DisplayName Optional |Optional |N/A The user name that appears on the administration and user
interfaces.

If no value is provided, the value is set to the Alias.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

EmailAddress Optional |Optional |N/A The email address of the user.

Note that the field is only for directory information purposes.
Cisco Unity Connection does not use the address to deliver
incoming messages.

Any combination of ASCII alphanumeric characters, and the
special characters hyphen, underscore, period and at sign (“@”),
up to a maximum of 320 characters.

Employeeld Optional |Optional |[N/A The numeric or alphanumeric identifier assigned to a user,
typically based on order of hire or association with an
organization.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

EnhancedSecurityAlias |Optional |Optional |N/A The unique text name used to identify and authenticate the user
with an RSA SecurID security system.

Any combination of ASCII or Unicode characters, up to a
maximum of 50 characters.

FirstName Optional |Optional |N/A The user first name.

Any combination of ANSI or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, " &, -, _,", up to a maximum of 64 characters.

Initials Optional |Optional |[N/A The initials of part or all of the user name.

Any combination of ANSI or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, " &, -, _,", up to a maximum of 6 characters.

Language Optional |Optional |N/A The preferred language of the user.

Use the Windows language code, such as 1033 for U.S. English.
For a list of supported languages and the corresponding
language codes, see the section “Numeric and Alphabetic Codes
for Supported Languages in Cisco Unity Connection” in the
System Requirements for Cisco Unity Connection 7.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/
7x/requirements/7xcucsysreqs.html.

LastName Optional |Optional |N/A The user last name.
Any combination of ANSI or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, " &, -, _,", up to a maximum of 64 characters.
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Table A-1 Required and Optional CSV Fields for Users Without Voice Mailboxes (continued)

Column Heading

Creating

Updating

Deleting

Description

Manager

Optional

Optional

N/A

The name of the person who is the manager or supervisor of the
user.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

PostalCode

Optional

Optional

N/A

For users located in the United States, the zip code where the
user is located, or with which the user is associated. For users
located in Canada, Mexico, and other countries, the postal code
where the user is located, or with which the user is associated.

Any combination of ASCII or Unicode characters, up to a
maximum of 40 characters.

State

Optional

Optional

N/A

The full name of the state or province where the user is located,
or with which the user is associated.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

TimeZone

Optional

Optional

N/A

The time zone with which the user account is associated.

Title

Optional

Optional

N/A

The position or function of the user within the organization, for
example “Vice President.”

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes

Column Heading

Creating

Updating

Deleting |Description

Alias

Required

Required

Required |The unique text name for the user account.

Any combination of ASCII or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, ", &, -, _, ', upto a
maximum of 64 characters.

Extension

Required

Optional

N/A The number that callers dial to reach the user.

The value must be unique among users in the partition.

Any combination of ASCII alphanumeric characters,
from 3 to 40 characters long.

TemplateAlias

Required

N/A

N/A The unique text name for the user template to apply to

the account during creation.

Active_HomePhone

Optional

Optional

N/A Whether the user home phone device is enabled:

e (—disabled

e ]—enabled

Active_MobilePhone

Optional

Optional

N/A Whether the user cell phone device is enabled:

e (—disabled
e ]—enabled
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)

Column Heading Creating |Updating |Deleting |Description

Active_Pager Optional |Optional |N/A Whether the user pager device is enabled:
¢ (—disabled

e ]—enabled

Active_TextPagerl Optional |Optional |N/A Whether the user text pager device is enabled:
e (O—disabled
e l—enabled

Active_WorkPhone Optional |Optional |N/A Whether the user work phone device is enabled:
e (O—disabled

e ]—enabled

Address Optional |Optional |N/A The physical address, such as a house number and street
name where the user is located, or with which the user is
associated.

Any combination of ASCII or Unicode characters, up to
a maximum of 128 characters.

AfterDialDigits_Pager Optional |Optional |N/A Digits to send to the pager. This is referred to in
Connection Administration as “Extra Digits.” For
numeric pagers, the field holds numeric text to send to
the pager; for text pagers, the field is blank.

The maximum length is 32 digits.

AltFirstName Optional |Optional |[N/A An alternate spelling of the user first name in an
internationally recognizable format (ASCII characters).
The value is used by the phone interface to search for
users and to address messages.

Any combination of ASCII alphanumeric characters, up
to maximum of 64 characters.

AltLastName Optional |Optional |N/A An alternate spelling of the user last name in an
internationally recognizable format (ASCII characters).
The value is used by the phone interface to search for
users and to address messages.

Any combination of ASCII alphanumeric characters, up
to maximum of 64 characters.

Billingld Optional |Optional |[N/A Organization-specific information about the user, such
as accounting information, department names, or project
codes. The information can be included in user reports.

Any combination of digits from O through 9, up to a
maximum of 32 digits.

Building Optional |Optional |N/A The name of the building where the user is based.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
Ccemld Optional |Optional |N/A The Cisco Unified Communications Manager user ID

that is associated with the user.

Any combination of characters except for non-printing
ASCII characters, up to a maximum of 128 characters.

City Optional |Optional |N/A The name of a locality, such as a city, county or other
geographic region where the user is located, or with
which the user is associated.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

ClientMatterCode Optional |Optional |N/A The required Client Matter Code (CMC) to transmit to
Cisco Unified Communications Manager (CM), if
applicable, when the user makes an outbound call.

CMCs are typically used to enable the system to track
calls for account or billing purposes.

The value is used only if the system is using Cisco
Unified CM and if the version of Cisco Unified CM is
4.1 and later.

Whether the CMC is transmitted depends on the setting
for outbound calls. The user CMC is used only if the
outbound call does not have its own CMC.

The code length can be from 1 through 40 characters.

CorporatePhoneNumber Optional |Optional |N/A The phone number of the user.

Note that the field is only for directory information
purposes. Cisco Unity Connection does not use the
phone number to route calls.

COSDisplayName Optional |Optional |N/A The unique text name that is displayed on the user
interfaces for the class of service (COS) with which the
user account is associated.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

Country Optional |Optional |N/A The 2-letter ISO 3166-1 country code where the user is
located, or with which the user is associated.

Two ASCII lower or upper case alpha characters.

DeliveryReceiptAction Optional |Optional |N/A Action to take for a voice message:
e (0—Reject the message

e 1—Accept the message

e 2—Relay the message

e 3—(Cisco Unity Connection 7.1 and later) Accept
the message and relay a copy
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
Department Optional |Optional |N/A The name or number for the department or subdivision

of an organization to which the user belongs.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

Directoryld Optional |Optional |[N/A The unique identifier for the user in the corporate or
organization directory (for example, in Active Directory,
if Active Directory is used).

Any combination of ASCII alphanumeric characters, up
to a maximum of 256 characters.

DisplayName Optional |Optional |N/A The user name that appears on the administration and
user interfaces.

If no value is provided, the value is set to the Alias.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

DisplayName_HomePhone Optional |Optional |[N/A The text name for the user home phone displayed on the
Cisco Unity Connection interfaces.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

DisplayName_MobilePhone Optional |Optional |N/A The text name for the user cell phone displayed on the
Cisco Unity Connection interfaces.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

DisplayName_Pager Optional |Optional |N/A The text name for the user pager displayed on the
Cisco Unity Connection interfaces.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

DisplayName_TextPagerl Optional |Optional |N/A The text name for the user text pager displayed on the
Cisco Unity Connection interfaces.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

DisplayName_WorkPhone Optional |Optional |N/A The text name for the user work phone displayed on the
Cisco Unity Connection interfaces.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

EmailAction Optional |Optional |N/A Action to take for a voice message:
e 0—Reject the message

e 1—Accept the message

e 2—Relay the message

e 3—(Cisco Unity Connection 7.1 and later) Accept
the message and relay a copy
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
EmailAddress Optional |Optional |N/A The primary email address of the user.

Note that the field is used only for directory information
purposes. Cisco Unity Connection does not use the
address to deliver incoming messages.

Any combination of ASCII alphanumeric characters,
and hyphens, underscores, periods and at signs (“@”),
up to a maximum of 320 characters.

Employeeld Optional |Optional |N/A The numeric or alphanumeric identifier assigned to a
user, typically based on order of hire or association with
an organization.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

EnhancedSecurityAlias Optional |Optional |N/A The unique text name used to identify and authenticate
the user with an RSA SecurID security system.

Any combination of ASCII or Unicode characters, up to
a maximum of 50 characters.

Extension_Altl Optional |Optional |[N/A The first alternate extension for the user.
The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Altl_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the first alternate extension
belongs.

Extension_Alt2 Optional |Optional |[N/A The second alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt2_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the second alternate extension
belongs.

Extension_Alt3 Optional |Optional |N/A The third alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt3_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the third alternate extension
belongs.

Extension_Alt4 Optional |Optional |N/A The fourth alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)

Column Heading Creating |Updating |Deleting |Description

Extension_Alt4_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the fourth alternate extension
belongs.

Extension_AltS Optional |Optional |[N/A The fifth alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt5_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the fifth alternate extension
belongs.

Extension_Alt6 Optional |Optional |N/A The sixth alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt6_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the sixth alternate extension
belongs.

Extension_Alt7 Optional |Optional |N/A The seventh alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt7_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the seventh alternate extension
belongs.

Extension_Alt8 Optional |Optional |N/A The eighth alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt8_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the eighth alternate extension
belongs.

Extension_Alt9 Optional |Optional |[N/A The ninth alternate extension for the user.

The value must be unique in the partition.

Any combination of ASCII alphanumeric characters,
from 1 to 40 characters long.

Extension_Alt9_Partition Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name of
the partition to which the ninth alternate extension
belongs.
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)

Column Heading

Creating

Updating

Deleting

Description

FaxAction

Optional

Optional

N/A

Action to take for a voice message:
e (0—Reject the message
e 1—Accept the message
e 2—Relay the message

e 3—(Cisco Unity Connection 7.1 and later) Accept
the message and relay a copy

FirstName

Optional

Optional

N/A

The user first name.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, ", &, -, _,',upto a
maximum of 64 characters.

ForcedAuthoizationCode

Optional

Optional

N/A

The required forced-authorization code (FACs) to
transmit to Cisco Unified Communications Manager
(CM), if applicable, when the user makes an outbound
call.

Your organization may use FACs to prevent toll fraud.
For example, users may have to provide FACs to place
long-distance calls.

The value is used only if the system is using Cisco
Unified CM and if the version of Cisco Unified CM is
4.1 and later.

The code length can be from 1 to 40 characters.

ImapService_AccountLogin

Optional

Optional

N/A

The Active Directory user logon name that is associated
with the Exchange mailbox that you want this

Cisco Unity Connection user to be able to access. (The
Active Directory logon name of the user should be in the
format LogonName.)

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, N, &, -, _, ', upto a
maximum of 256 characters.

To add the IMAP service for a user, include values for
both the ImapService_RemoteServerDisplayName and

ImapService_AccountLogin fields in the CSV input file.

To remove the IMAP service for a user, set at least one
of either the ImapService_RemoteServerDisplayName
or ImapService_AccountLogin fields to %null% in the
CSV input file.
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Constructing the Input CSV Files

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
ImapService_AccountPassword |Optional |Optional |N/A The user password that is associated with the Exchange

mailbox that you want this user to be able to access.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, N, &, -, _,,upto a
maximum of 256 characters.

To add the IMAP service for a user, include values for
the ImapService_RemoteServerDisplayName and
ImapService_AccountLogin fields in the CSV input file.

To remove the IMAP service for a user, set at least one
of either the ImapService_RemoteServerDisplayName
or ImapService_AccountLogin fields to %null% in the
CSV input file.

ImapService_RemoteServer Optional |Optional |N/A The Cisco Unity Connection IMAP service that
DisplayName corresponds with the Exchange server that contains the
Exchange mailbox for this Connection user.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, |, @, #, $, %, ", &, -, _, ', upto a
maximum of 64 characters.

To add the IMAP service for a user, include values for
both the ImapService_RemoteServerDisplayName and
ImapService_AccountLogin fields in the CSV input file.

To remove the IMAP service for a user, set at least one
of either the ImapService_RemoteServerDisplayName
or ImapService_AccountLogin fields to %null% in the
CSV input file.

Initials Optional |Optional |[N/A The initials of part or all of the user name.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, |, @, #, $, %, ", &, -, _, ', upto a
maximum of 6 characters.

Language Optional |Optional |N/A The preferred language of the user.

Use the Windows language code, such as 1033 for U.S.
English. For a list of supported languages and the
corresponding language codes, see the section “Numeric
and Alphabetic Codes for Supported Languages in
Cisco Unity Connection” in the System Requirements for
Cisco Unity Connection 7.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/
connection/7x/requirements/7xcucsysreqs.html.
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Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
LastName Optional |Optional |N/A The user last name.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, N, &, -, _, ', upto a
maximum of 64 characters.

ListInDirectory Optional |Optional |[N/A Determines whether the user is included in the phone
directory for outside callers:

e (0—Not included in the directory

e |—Included in the directory

Manager Optional |Optional |N/A The name of the manager or supervisor of the user.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

MailName Optional |[N/A N/A Name used to construct part of SMTP address before the
@ sign.

A name is needed for unicode aliases that cannot be
converted into a valid SMTP addresses.

MaxMsglen Optional |Optional |N/A The maximum duration (in seconds) for recording a
message from an outside (unidentified) caller.

The length specified can be from 1 through 1,200
seconds.

MediaSwitchDisplayName Optional |Optional |N/A The text name displayed on the system administration
interface of the phone system used for Telephone Record
and Playback (TRAP) sessions and to turn message
waiting indicators on and off.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

MWIExtension Optional |Optional |N/A The phone number (extension) of the default message
waiting indicator (MWI) to light when callers leave
messages for the user.

If no value is provided, Cisco Unity Connection uses the
number of the primary extension.

MWIMediaSwitchDisplay Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The text name
Name displayed on the system administration interface of the
phone system used to turn message waiting indicators on
and off for the phone number specified in the
MWIExtension column.

If no value is provided, Cisco Unity Connection uses the
phone system specified in the
MediaSwitchDisplayName column.

PhoneNumber_HomePhone Optional |Optional |N/A The user home phone number.

Any combination of the digits 0-9, T, t, commas, hashes
(#), and asterisks (*), up to a maximum of 38 characters.
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Constructing the Input CSV Files

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
PhoneNumber_MobilePhone Optional |Optional |N/A The user cell phone number.

Any combination of the digits 0-9, T, t, commas, hashes
(#), and asterisks (*), up to a maximum of 38 characters.

PhoneNumber_Pager Optional |Optional |N/A The user pager number.

Any combination of the digits 0-9, T, t, commas, hashes
(#), and asterisks (*), up to a maximum of 38 characters.

PhoneNumber_TextPagerl Optional |Optional |N/A The user text pager number.

Any combination of ASCII only alphanumeric
characters, hyphens, underscores, periods, at signs
(“@”), commas and hashes (#), up to a maximum of 40
characters.

PhoneNumber_WorkPhone Optional |Optional |N/A The user work phone number.

Any combination of the digits 0-9, T, t, commas, hashes
(#), and asterisks (*), up to a maximum of 38 characters.

PostalCode Optional |Optional |N/A For users located in the United States, the zip code where
the user is located, or with which a user is associated.
For users located in Canada, Mexico, and other
countries, the postal code where the user is located, or
with which a user is associated.

Any combination of ASCII or Unicode characters, up to
a maximum of 40 characters.

Relay Address Optional |Optional |N/A Specifies the address to relay incoming message when
one or more of the actions (EmailAction,
VoicemailAction, FaxAction, DeliveryReceiptAction) is
set to 2 (Relay the message).

RelayAddress is in the format of someone @ somewhere
or someone @somewhere.com.

RnaAction Optional |Optional |[N/A Determines whether Cisco Unity Connection transfers
the call to the applicable greeting or releases the call to
the phone system when a call is unanswered
(“ring-no-answer”):

e (—Release the call to the phone system.

e |—After the number of rings specified in the
TransferRings field, transfer the call to the
appropriate greeting.

SmtpAddress_TextPagerl Optional |Optional |N/A SMTP address for the user. This address identifies the
user in an SMTP-enabled client such as Outlook
Express. If you do not provide one, Cisco Unity
Connection uses the alias to form the address.

Note that the SMTP address cannot include non-ASCII
characters. Therefore, if the alias contains non-ASCII
characters, you must provide an acceptable SMTP
address.
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B Constructing the Input CSV Files

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)

Column Heading

Creating

Updating

Deleting

Description

SmtpProxyAddress

Optional

Optional

N/A

The full SMTP proxy addresses for users. To
create/update more than one address per user, surround
each address with double quotes and separate them by
commas. For example:

93 99

“someonel @somwhere.com”,’someone2 @ somewhere.

Lt}

com

State

Optional

Optional

N/A

The full name of the state or province where the user is
located, or with which a user is associated.

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

TimeZone

Optional

Optional

N/A

The time zone with which the user account is associated.

Title

Optional

Optional

N/A

The position or function of the user within the
organization, for example “Vice President.”

Any combination of ASCII or Unicode characters, up to
a maximum of 64 characters.

TransferAction

Optional

Optional

N/A

Determines whether Cisco Unity Connection transfers
the incoming calls for the user to the call handler
greeting or to the extension specified in
TransferExtension:

e (O—Transfer to the call handler greeting.

e |—Transfer to TransferExtension.

TransferExtension

Optional

Optional

N/A

The phone number that Cisco Unity Connection
transfers calls to if TransferAction is set to 1.

TransferRings

Optional

Optional

N/A

Determines the number of times the user extension rings
before Cisco Unity Connection considers the call
unanswered (“ring-no-answer”) and plays the applicable
greeting.

An integer value from 2 through 100.

TransferType

Optional

Optional

N/A

Determines the way in which Cisco Unity Connection
transfers calls from the automated attendant or a
directory handler to the user phone for the standard
(default) transfer rule:

e (O—supervised

e |—unsupervised (also called a “Release to Switch”
transfer)

VoiceMailAction

Optional

Optional

N/A

Action to take for a voice message:
e (0—Reject the message
e 1—Accept the message
e 2—Relay the message

e 3—(Cisco Unity Connection 7.1 and later) Accept
the message and relay a copy
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Constructing the Input CSV Files

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)
Column Heading Creating |Updating |Deleting |Description
WebDavService_AccountLogin |Optional |Optional |N/A To enable access to Exchange messages by using Text to

Speech, the Exchange alias (often the same as the Active
Directory user logon name) for the Exchange mailbox
that you want this Cisco Unity Connection user to be
able to access.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, N, &, -, _,,upto a
maximum of 256 characters.

To add the WebDav service for a user, include the values
for the WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, and
WebDavService_ServerUrlSuffix fields in the CSV
input file.

To remove the WebDav service for a user, set at least one
of the fields WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, or
WebDavService_ServerUrlSuffix to %null% in the CSV

input file.
WebDavService_Account Optional |Optional |N/A The user password that is associated with the Exchange
Password mailbox that you want this user to be able to access.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, |, @, #, $, %, ", &, -, _, ', upto a
maximum of 256 characters.

To add the WebDav service for a user, include the values
for the WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, and
WebDavService_ServerUrlSuffix fields in the CSV
input file.

To remove the WebDav service for a user, set at least one
of the fields WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, or
WebDavService_ServerUrlSuffix to %null% in the CSV
input file.
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B Constructing the Input CSV Files

Table A-2 Required and Optional CSV Fields for Users With Voice Mailboxes (continued)

Column Heading Creating |Updating |Deleting |Description

WebDavService_RemoteServer |Optional |Optional |N/A The Cisco Unity Connection WebDav service that
DisplayName corresponds with the Exchange server that contains the

Exchange mailbox for this Connection user.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, !, @, #, $, %, N, &, -, _,,upto a
maximum of 64 characters.

To add the WebDav service for a user, include the values
for the WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, and
WebDavService_ServerUrlSuffix fields in the CSV
input file.

To remove the WebDav service for a user, set at least one
of the fields WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, or
WebDavService_ServerUrlSuffix to %null% in the CSV

input file.
WebDavService_ServerUrl Optional |Optional |N/A The Exchange email alias for this user. Do not include
Suffix https://<Servername>/exchange in the field. Enter only

the alias for this user.

When you add a new Cisco Unity Connection external
service, you specify the base URL to the Exchange
server, https://<Exchange server>/Exchange/ where
<Exchange server> is the fully qualified domain name or
the IP address of the Exchange server. When Connection
accesses the Exchange mailbox for a Connection user, it
combines the base URL with the URL suffix. The
combination must produce the correct URL for
accessing the Exchange mailbox for this user.

Any combination of ANSI or Unicode alphanumeric
characters, periods, commas, spaces, and the special
characters *, ~, |, @, #, $, %, ", &, -, _, ', upto a
maximum of 256 characters.

To add the WebDav service for a user, include the values
for the WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, and
WebDavService_ServerUrlSuffix fields in the CSV
input file.

To remove the WebDav service for a user, set at least one
of the fields WebDavService_AccountLogin,
WebDavService_RemoteServerDisplayName, or
WebDavService_ServerUrlSuffix to %null% in the CSV
input file.
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Constructing the Input CSV Files

Table A-3 Required and Optional CSV Fields for System Contacts
Column Heading Creating |Updating |Deleting |Description
Alias Required |Required |Required |The unique text name for the contact.

Any combination of ASCII or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, ", &, -, _,", up to a maximum of 64 characters.

Extension Required |Optional |[N/A The number that callers dial to reach the contact.

The value must be unique among users and contacts in the
partition.

Any combination of ASCII alphanumeric characters, up to a
maximum of 40 characters.

AltFirstName Optional |Optional |N/A An alternate spelling of the contact first name in an
internationally recognizable format (ASCII characters). The
value is used by the phone interface to search for users and to
address messages.

Any combination of ASCII alphanumeric characters, up to
maximum of 64 characters.

AltLastName Optional |Optional |[N/A An alternate spelling of the contact last name in an
internationally recognizable format (ASCII characters). The
value is used by the phone interface to search for users and to
address messages.

Any combination of ASCII alphanumeric characters, up to
maximum of 64 characters.

DeliveryLocation Optional |Optional |N/A For VPIM contacts, the VPIM delivery location on which the

DisplayName contact mailbox resides. Use the display name of the VPIM
location as it is listed in Cisco Unity Connection
Administration.

Any combination of ASCII or Unicode characters (except
nonprinting ASCII characters), up to maximum of 64 characters.

DialableWorkPhone Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) A phone number that
voice recognition users can use to call the contact. Include any
additional numbers necessary to dial outside calls (for example,
9) and for long-distance dialing (for example, 1).

Any combination of numeric digits, commas, and the special
characters # and *, from 1 to 255 characters long.

DialableHomePhone Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) A phone number that
voice recognition users can use to call the contact. Include any
additional numbers necessary to dial outside calls (for example,
9) and for long-distance dialing (for example, 1).

Any combination of numeric digits, commas, and the special
characters #, and *, from 1 to 255 characters long.
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B Constructing the Input CSV Files

Table A-3 Required and Optional CSV Fields for System Contacts (continued)

Column Heading

Creating

Updating

Deleting

Description

DialableMobilePhone

Optional

Optional

N/A

(Cisco Unity Connection 7.1 and later) A phone number that
voice recognition users can use to call the contact. Include any
additional numbers necessary to dial outside calls (for example,
9) and for long-distance dialing (for example, 1).

Any combination of numeric digits, commas, and the special
characters #, and *, from 1 to 255 characters long.

Directoryld

Optional

Optional

N/A

The unique identifier for the contact in the corporate or
organization directory (for example, in Active Directory, if
Active Directory is used).

Any combination of ASCII alphanumeric characters, up to a
maximum of 256 characters.

DisplayName

Optional

Optional

N/A

The contact name that appears on the administration and user
interfaces.

If no value is provided, the value is set to the Alias.

Any combination of ASCII or Unicode characters, up to a
maximum of 64 characters.

Extension_Altl

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The first alternate extension
for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_Alt2

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The second alternate
extension for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_Alt3

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The third alternate extension
for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_Alt4

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The fourth alternate
extension for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_AltS

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The fifth alternate extension
for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_Alt6

Optional

Optional

N/A

(Cisco Unity Connection 7.0 only) The sixth alternate extension
for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.
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Constructing the Input CSV Files

Table A-3 Required and Optional CSV Fields for System Contacts (continued)
Column Heading Creating |Updating |Deleting |Description
Extension_Alt7 Optional |Optional |N/A (Cisco Unity Connection 7.0 only) The seventh alternate

extension for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_Alt8 Optional |Optional |N/A (Cisco Unity Connection 7.0 only) The eighth alternate
extension for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

Extension_AlIt9 Optional |Optional |N/A (Cisco Unity Connection 7.0 only) The ninth alternate extension
for the contact.

Any combination of ASCII alphanumeric characters, from 1 to
255 characters long.

FirstName Optional |Optional |[N/A The contact first name.

Any combination of ANSI or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, " &, -, _,", up to a maximum of 64 characters.

LastName Optional |Optional |N/A The contact last name.

Any combination of ANSI or Unicode alphanumeric characters,
periods, commas, spaces, and the special characters *, ~, |, @, #,
$, %, ", &, -, _,", up to a maximum of 64 characters.

ListInDirectory Optional |Optional |N/A Determines whether the contact is included in the phone
directory for outside callers:

¢ (0—Not included in the directory
e |—Included in the directory

RemoteMailAddress Optional |Optional |N/A For VPIM contacts, enter the mailbox number of the VPIM
contact on the remote voice messaging system.

The maximum length is 256 characters.

SmtpProxyAddress Optional |Optional |N/A The full SMTP proxy addresses for contacts. To create/update
more than one address per contact, surround each address with
double quotes and separate them by commas. For example:

99 39

“someonel @somwhere.com”,’someone2 @ somewhere.com”

TransferEnabled Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) Determines whether
Cisco Unity Connection transfers calls from the automated

attendant or a directory handler to the phone number that is
specified in the TransferExtension field.

e 0—Do not transfer calls. Connection takes a message and
sends it to the remote mailbox for the VPIM contact instead.

e |—Transfer incoming calls to TransferExtension.
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Table A-3 Required and Optional CSV Fields for System Contacts (continued)
Column Heading Creating |Updating |Deleting |Description
TransferExtension Optional |Optional |N/A (Cisco Unity Connection 7.1 and later) The extension or phone

number to which Cisco Unity Connection transfers calls when
TransferEnabled is set to 1.

When entering a phone number, include any additional numbers
necessary to dial outside calls (for example, 9) and for
long-distance dialing (for example, 1).

Any combination of numeric digits, commas, and the special
characters # and *, up to a maximum of 40 characters.

TransferRings Optional |Optional |N/A Determines the number of times the extension of the contact
rings before Cisco Unity Connection considers the call
unanswered (“ring-no-answer”) and plays the applicable
greeting.

An integer value from 2 through 100.

TransferType Optional |Optional |N/A Determines the way in which Cisco Unity Connection transfers
calls from the automated attendant or a directory handler to the
contact phone for the standard (default) transfer rule:

e (—supervised

e l—unsupervised (also called a “Release to Switch”
transfer)

Correcting Errors by Using the Failed Objects File

When you run BAT, it copies each record that it cannot process to a failed objects report file, along with
the reason that the record was not processed correctly. For example, in the following CSV file, the first
record includes an invalid entry for the Country field, and the second record specifies a template that is
not a voice mail user template:

Alias, City, PostalCode, State, Country, TemplateAlias
Jsmith, Beverly Hills, 90210, Ca., United States, VoiceMailUserTemplate
BRobertson, Seattle, 98121, WA, US, AdminUserTemplate

Using this file to create users with voice mailboxes produces the following failed objects file:

FailureReason, alias, city, postalcode, state, country, templatealias

United States is invalid for column Countryl, Jsmith, Beverly Hills, 90210, Ca., United States,
VoiceMailUserTemplate

Object not found or is not a template: Parameter = [ @ TemplateObjectld], Table =
[vw_SubscriberTemplate], Column = [Alias,Objectld]l, BRobertson, Seattle, 98121, WA, US,
AdminUserTemplate

The FailureReason column—which provides information about the invalid data—is added before the
first column.

To correct errors, do the following procedure to modify the failed objects file, rename it, and use it as
the input file when you re-run BAT.
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Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Note

Correcting Errors by Using the Failed Objects File

Note that depending on the type of problem with the data in the CSV file, for each problem record, BAT
may report multiple errors or only the first error encountered. Therefore, after you correct errors, BAT
may detect additional errors in the same record when the data is processed again. Thus, you may need
to repeat the correction process—running the tool and correcting an error—several times to find and
correct all errors.

To Correct Errors by Using the Failed Objects File

If the Bulk Administration Tool operation results in any failures, you can immediately inspect the failed
objects report file by clicking Download the Failed Objects File.

Open the file and correct all problems with the data, as indicated by the information in the FailureReason
column for each record.

Remove the FailureReason column or change the heading to “junk.”
When you have finished modifying the data, save the file as a CSV file with a new name.
Run BAT again with the CSV file that you saved in Step 4 as the input file.

Note that each time that you run BAT, the failed objects file is overwritten (unless you specify a new
name for the file each time you run the tool).

Repeat this procedure until all records are processed without error.

If you have navigated away from the Bulk Administration Tool page, you can go back and click the
Display Last Operation button to bring up a download link for the output file from the previous
operation. If you need a failed objects file from more than one previous operation, you can use the
Command Line Interface (CLI) command “file view activelog cuc/<filename>" to view failed object
files. For more information on using CLI commands, see the applicable Cisco Unified Communications
Operating System Administration Guide for Cisco Unity Connection. The guide is available at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.
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